


2

Ведение
Тема 15. КОМПОненТЫ

Make Component (Создать компонент)
Редактирование компонентов
Components (Браузер компонентов)
Моделируем компонентами (учебный проект)
Outliner (Структура групп и компонентов)

Тема 16. разМерЫ, ТеКсТЫ
Dimension (Размеры)
Text (Текст)
3D Text (3D-текст)

Тема 17. разрезЫ
Section Plane (Секущий план, плоскость) 
Display Section Planes (Показать секущую плоскость)
Display Section Cuts (Показать отсечения)

Тема 18. рельефЫ
From Contours (Из контуров) 
From Scratch (Из линий) 
Smoove (Присоска)
Stamp (Штамп)
Drape (Драпировка)
Add Detail (Добавить детали)
Flip Edge (Отразить ребро)

Тема 19. МОделирОВание ОТсеЧениЯМи
Intersect Faces (Отсечение поверхностей) 
Solid tools (Инструменты сплошных тел)

Тема 20. иМПОрТ/эКсПОрТ 2D-графиКи
Импорт растровых файлов
Экспорт растровых файлов
Распечатка на принтере
Импорт векторных файлов
Экспорт векторных файлов

 4

  5 

   9 

  13

 19

 24

 27

 32

  35 

  37 

  40

  40

  43

 45

 45

 47

 49

 50

 51

 52

 55

 61

 64

 66

 67

 70



Тема 21. сОВМещение с фОТО 
Выбор, подготовка фото
Загрузка фото, настройка камеры
Построение 3D-модели по фото
Проецирование фото (текстуры) на модель
Размещение модели на «фотосцене»

Тема 22. иМПОрТ/эКсПОрТ 3D-МОделей
Импорт 3D-моделей
Экспорт 3D-моделей

Тема 23. GooGle. геОлОКаЦиЯ
Инструменты Google
Геолокация
Авторские права

Тема 24. динаМиЧесКие КОМПОненТЫ
Управление DC  в сцене
Разработка DC

Тема 25. уПраВление ПрезенТаЦиЯМи
Анимация – настройки параметров
Walkthrough (инструменты Прогулки)
Fog (Туман)
Анимация – запись в фильм
Серия покадровых снимков
Google SketchUp Viewer

Тема 26. уПраВление ПрОеКТОМ
Главные меню
Preferences (Основные настройки)

Тема 27. задаЧи и решениЯ. ПлагинЫ. ПрОграММЫ-
ПарТнерЫ

 77

 78

 80

 81

 82

 84

 86

 93

 97

 100

 102

 103 

 105

 107

 108

 110

 113

 114

 116

 116

 117

 126

  133



4

введение
Освоив инструменты и опции, рассмотренные в первой части (книге) нашего курса, 

вы уже достаточно свободно можете моделировать в SketchUp, успешно решая подавляю-
щее число типичных практических задач. Однако «за кадром» у нас пока еще остался целый 
ряд возможностей программы, не менее интересных и нужных, чем уже знакомые, – в том 
числе некоторые из них предназначены для решения таких специфических задач, которые 
просто не могут быть реализованы без их применения. 

Кроме того, пройдем по ряду частично рассмотренных ранее инструментов и опций, 
полностью завершив их изучение. 

Особое внимание уделим также финальной стадии работы над проектом, его нагляд-
ной и эффектной презентации, «подаче» – ведь это не менее важная составляющая работы 
профессионала, чем собственно моделирование. 

не менее интересна тема, мимо которой никак не пройдет продвинутый «скетчапер», – 
многочисленные скрипты-плагины, расширяющие возможности программы настолько, что мож-
но говорить о совершенно другом SketchUp... 

ну и в завершение курса будут представлены некоторые подсказки и «хитрости» из 
опыта «экспертов» в программе, в том числе решающие отдельные «врожденные» пробле-
мы  и ограничения SketchUp... 
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Тема 15. КОМПОненТЫ
Начиная изучение инструментов в первой части курса, в группе Principal (Ос-

новные) мы уже упоминали опцию (и кнопку) Make Component (Создать компо-
нент). Тогда мы отложили эту очень важную для практически эффективной рабо-
ты тему – сейчас разберемся с ней подробно.

 Make CoMponent (сОздаТь КОМПОненТ)
выбираем абсолютно любой элемент построения (даже отдельную линию) и видим, 

что тут же кнопка опции показывает готовность к применению – выходит из «затененного» 
состояния и выделяется голубым контуром. включение Make Component доступно также и 
из меню Edit, и из контекстного меню выбранного – используем то, что привычней и удоб-
ней. А обратная опция – возвращение составляющих компонент элементов в исходное «раз-
розненное» состояние – та же, что и для группы – Explode (Разорвать). 

Посмотрим, как это работает, на простейшем тестовом примере – строим прямоуголь-
ник, выделяем его весь, включаем опцию Make Component – открывается диалоговое окно 
Create Component (Создать компонент), в котором назначаются его параметры (свойства).

Сразу отметим главное: по сути, Компонент – это «продвинутая» группа (то есть обла-
дает всеми ее возможностями), имеющая одно основное дополнительное уникальное свой-
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ство – способность существовать одновременно в двух состояниях – Definition (Оригина-
ла) и Instance (Вставки) в сцену, между которыми поддерживается постоянная интерактив-
ная связь. Это означает, что каждая вставка постоянно «считывает» все свойства оригина-
ла и, соответственно, редактирование самого оригинала тут же одновременно воздейству-
ет на  все его вставки в сцене.

General (Общее):
Name – назначенное программой автоматически индивидуальное имя оригинала ком-

понента с порядковым номером (может быть и так) в виде Component #, которое, естествен-
но, тут же можно изменить на свое (еще раз напомню – лучше сразу на латинице). 

Description (Описание) – здесь при желании можно вписать любую дополнительную 
(справочную) информацию, которая, конечно, на собственно моделирование никак не влияет.

aligment (Выравнивание): 
Здесь устанавливаются параметры ориентации и воздействия на другие элементы по-

строений, с которыми вставки компонента будут появляться в сцене:
Glue to (Приклеить к) – этот выпадающий список используется для назначения при-

нудительной ориентации «основания» вставки, которым она будет «садиться» на поверхно-
сти в сцене: None (Никакая), Any (Любая), Horisontal (Горизонтальная), Vertical (Верти-
кальная), Sloped (Наклонная). У такой вставки при создании компонента появляется серый 
прямоугольник, обозначающий план (основание) приклеивания на поверхности (кроме ва-
рианта None). например, если назначили вариант Horisontal, то уже не сможем поместить 
вставку основанием на вертикальную поверхность. не вдаваясь в дальнейшие подробно-
сти, можно сразу сказать, что опция отличается насколько путаной логикой, что польза от 
нее весьма сомнительна, потому на практике рациональней при создании любого компо-
нента обойтись назначением ориентации Any, а лучше None (что и предлагается по умолча-
нию). намного проще осевую ориентацию установки вставки поменять в любой момент по 
конкретным обстоятельствам опциями редактирования осей оригинала компонента (см. да-
лее). впрочем, ничто не мешает при желании разобраться с этим механизмом самостоятель-
но подробней и использовать в работе, если это покажется удобным...

Set Component Axes (Установить оси компонента) – опция позволяет назначить 
оригиналу компонента «индивидуальные» оси, независимые от общих осей сцены (по умол-
чанию они назначаются при создании автоматически по направлениям основных осей сце-
ны). надо подчеркнуть, что этим чрезвычайно полезным свойством обладают только Компо-
ненты из всех элементов построений SketchUp, что позволяет редактировать их геометрию, 
ориентированную любым образом в пространстве сцены, а также то, каким образом они 
появляются и работают в сцене. 

Порядок действий здесь аналогичен тому, что мы уже изучали в инструменте управле-
ния осями сцены Axes (см. тему 8 «Строим точно»), – после выбора опции курсор изменится 
на символ с осями, который нужно поместить и кликнуть в точке начала («нуля») координат 
компонента. выбор «нуля» зависит от характера объекта-компонента и планов по его даль-
нейшему использованию. например, для компонентов, которые должны «стоять на земле», 
имеет смысл назначить его на endpoint какого-либо ребра поверхности низа основания  (на-
пример, ножки стула) – тогда при помещении в сцену он будет автоматически «ставиться на 
землю» нужным образом. далее вращаем символ осей до нужной ориентации красной оси 
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(фиксируем вторым кликом) и завершаем опцию третьим кликом, показав направление зе-
леной оси (синяя ось устанавливается автоматически по положению красной и зеленой). За-
метим, что положение «нуля» и ориентацию осей оригинала компонента можно быстро по-
менять и впоследствии, на уже готовом объекте, его контекстной опцией Change Axes (Сме-
нить оси), которая работает аналогично.

Cut Opening (Поместить с вырезанием) – опция становится доступна при выборе 
любого варианта Glue to (Приклеить к), отличного от None. и хотя рекомендовал этой оп-
цией вообще не пользоваться, все же стоит знать, что Cut Opening используется для назна-
чения вставке компонента свойства «прорезания под себя» сквозного проема в поверхно-
сти, на которую она «приклеивается» своим основанием в соответствии с ориентацией, на-
значенной в Glue to. 

Здесь стоит задержаться и ответить на постоянно повторяющийся вопрос пользова-
телей по типичной ситуации: – как размещать компоненты-окна на стене и сразу прорезать 
под них проемы с помощью это опции? Кроме уже указанной проблемы сложности настрой-
ки этих параметров, есть и еще одна, весьма весомая – Cut Opening действует только на одну, 
одиночную поверхность, а поскольку стены в построениях обычно имеют некую толщину, бу-
дет прорезана только ее внешняя поверхность, а внутренняя – нет. есть разные приемы ре-
шения этой задачи, но в любом случае потребуются «многошаговые» манипуляции с допол-
нительными построениями, использованием механизмов «отсечения» объемов (о них далее), 
удалением лишнего и так далее. Отсюда еще раз напрашивается вывод: – практическая поль-
за опции сомнительна, особенно в сложных случаях, поэтому рациональней решать задачи 
такого рода другими способами. например, для той же вставки окна в стену быстрее и удоб-
нее просто заранее разметить и «выдавить» проемы в габариты окна, а затем «размножить» 
по ним окна-компоненты перемещением с копированием, как показано на рисунке ниже.

Always face camera (Всегда лицом к камере) – используется для назначения свой-
ства вставке компонента всегда быть «повернутой лицом» к камере. Что это значит, для чего 
используется и как правильно установить эту функцию? Очень просто: – «лицо» – это такое 
положение компонента в момент создания, при котором оно («лицо») находится в плоскос-
ти включенного вида Front (Спереди). или по-другому – в красно-синем плане осей. То есть, 
например, сначала включаем вид Front, затем выставляем в нем объект – будущий ориги-
нал компонента в нужной ориентации, и потом при создании компонента в диалоговом окне 
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включаем (ставим галочку) на пункте Always face camera, который и фиксирует эту ориента-
цию как «лицо» компонента. Заметим, что вращаться за камерой вставка компонента будет 
относительно своей вертикальной (синей) оси и точки «нуля» осей. и конечно, в любой мо-
мент можем скорректировать «лицевую ориентацию» на вставке компонента опцией Change 
Axes (удобней – через контекстное меню), о которой было сказано выше.

Всегда лицом к камере – необходимая функция для использования в подходящих за-
дачах 2D («плоских») объектов-компонентов в качестве альтернативы несоизмеримо  более 
«тяжелым» аналогичным 3D-объектам. Это достаточно типичный механизм (и прием) для мно-
гих редакторов и программ-рендеров с успехом используется для наполнения сцены «мас-
совкой» – деревьями, фигурами людей и т. п. в сочетании с грамотной постановкой камеры, 
эти объекты (общепринятый термин – billboard) в сцене практически визуально неотличимы от 
«настоящих» 3D-объектов. Подробнее создание billboard рассмотрено  в конце нашего курса. 

Shadows face sun (Тень от лица) – опция работает только при включенной пре-
дыдущей для отображения падающей тени от контурных очертаний 2D-вставок компонен-
тов таким образом, как будто «солнце» светит им точно «в лицо» при любом повороте каме-
ры (и самой вставки компонента). 

Как это работает, показано на примере ниже, где левый прямоугольник – обычный 
объект, средний – вставка компонента с включенной опцией Shadows face sun, правый – с 
выключенной. Как видим, не всегда при включение этой опции вставка компонента одно-
значно «правильней» выглядит – это зависит и от характера очертаний ее контура, повто-
ряемого тенью, и от места «нуля» его осей, и от текущего ракурса обзора сцены – пробуем, 
выбираем оптимальный, наиболее «естественный» в данном случае (компоненте) вариант... 
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Replace Selected (Заменить выбранное) 
Опция позволяет заменять текущие выбранные вставки компонента в области моде-

лирования компонентами, выбранными в Браузере компонентов (о нем позже). не вдаваясь 
пока в подробности использования этой очень полезной опции, отметим только, что трудно 
найти случай, когда это не нужно, так что оставляем ее постоянно включенной.

итак, нажав ОК, получили новый оригинал компонента, а в сцене новый объект – 
Instance (Вставку компонента). «Размножим» ее, например опцией перемещения с копиро-
ванием. и теперь посмотрим, какие возможности управления предоставляет контекстное 
меню вставки, прежде всего пункт Entity Info.

Здесь нам интересны два новых пункта; – начнем с Definition Name (Имя оригинала) – 
как видим, это то имя, которое дали объекту при создании из него компонента. А Name – это имя 
выбранной в данной момент вставки (по умолчанию отсутствует). Здесь важно понять, что такое 
двойное наименование отражает суть устройства механизма Компонентов – Оригинал один, а 
Вставок (его копий, которые можно назвать и клонами), может быть в сцене сколько угодно. и,  
выбирая по очереди каждую из вставок, можем назначить им разные имена (на примере выше – 
«1», затем, например, 2, 3 ...), при этом их Definition Name будет одно и то же. Что это нам дает? 
Как и в ситуации с группами, для простых проектов можно обойтись и без «личных имен», но с 
усложнением, увеличением их количества в сцене, «имена» могут значительно облегчить и уско-
рить работу в целом за счет наглядной организации иерархии объектов (об этом позже).

 

редаКТирОВание КОМПОненТОВ
Разберемся теперь с редактированием компонентов: – здесь главное – понять, что 

в соответствии с их «двухуровневым» устройством доступно и два уровня редактирования. 
«Верхний» уровень: – если в сцене размещены несколько вставок компонента, 

можно отдельно каждую из вставок модифицировать доступными опциями «снаружи» 
как любой другой объект – перемещать, вращать, масштабировать, зеркалить и т. п., 
что никак не отразится на других вставках (и оригинале!), то есть они останутся при 
этом без изменений. Что мы и проделаем, применив к каждой из вставок разные моди-
фикации, например, так:
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«Внутренний уровень»: – в контекстном меню любой из вставок выберем пункт Edit 
Component (Редактировать компонент) – фактически это означает, что переходим к редак-
тированию оригинала этой (и других, с тем же Definition Name) вставок. Сразу заметим, что 
к этой опции можно также получить доступ из меню Edit > Component > Edit Component 
или просто двойным кликом на вставке компонента (вспомним – аналогично редактирова-
нию содержимого группы). видим, что при этом появился габарит активной вставки, кото-
рый как бы отделил ее от всего остального в сцене, – теперь любые наши действия будут 
распространяться только на содержимое внутри габарита. При этом все, находящееся сна-
ружи, «затуманивается» для удобства текущего редактирования. 

Прежде чем пойти дальше, разберемся с этой опцией отображения – она настраи-
вается через уже знакомое диалоговое окно Model Info в пункте Components и тут же ото-
бражается на объектах сцены. для наглядности добавим в сцену обычную группу – кубик – 
и посмотрим, что происходит при изменении этих настроек отображения. 

Заметим, кстати, что эта опция одновременно работает и для групп (!) – по понят-
ной причине, изучая группы в первой части курса, мы ее не рассматривали.

Component/Group Editing – в этой панели слайдерами регулируются параметры:
– Hide similar components (Скрыть подобные вставки компонента) – движком 

Lighter-Derker (Светлее-темнее) назначаем степень частичного «затуманивания» других 
вставок компонента этого же оригинала;

Hide rest of model (Скрыть остальные объекты) – аналогичная опция, но уже 
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для всех остальных объектов сцены. Работает и для компонентов, и для групп.
Переключатель Hide в той и другой опции полностью скрывает указанные в них 

объекты – таким образом, включив Hide, будем видеть на экране только содержание 
редактируемой вставки компонента (или группы). Как правило, настройки по умолчанию 
вполне устраивают, однако могут быть отдельные ситуации и задачи, когда их изменение мо-
жет быть полезно;

Component Axes > Show component axes – опция позволяет включать/выклю-
чать показ «собственных» осей оригинала компонента на всех его вставках в сцене однов-
ременно. Заметим, что оси и так всегда отображаются при «внутреннем» редактировании, а 
при включенном Show component axes будем видеть их на всех вставках постоянно – иног-
да такая возможность также бывает нелишней. Опция также работает как для компонен-
тов, так и для групп.

итак, вернемся к редактированию – например, применим к активной вставке «внут-
реннее» масштабирование (фактически через нее – и к оригиналу). видим, что как только 
выбираем компонент и начинаем масштабирование (или любые другие модификации), это 
же одновременно повторяется на всех остальных вставках! То же будет происходить и при 
любых других «внутренних» модификациях – собственно, в этом и заключается главная осо-
бенность и преимущество механизма компонентов. впрочем, это далеко не все, что могут 
компоненты, с другими их возможностями продолжим знакомство далее...

выходим из режима редактирования оригинала через меню Edit > Close Group/
Component, или нажатием Esc, или просто кликом снаружи от габарита редактирования.

Теперь откроем еще раз контекстное меню какой-либо вставки и посмотрим, какие 
еще не рассмотренные специфические опции управления (в рамках нашей темы) доступны 
отсюда.

Make Unique (Сделать уникальным) – превращает выбранную вставку компонен-
та в новый оригинал компонента. Чтобы убедиться в этом, откроем Entuty Info – видим, что 
его Definition Name автоматически изменилось на новое – Rectangle #1 (если нужно, меня-
ем на свое). Кроме того, понятно, что теперь уже редактирование этой вставки будет вли-
ять только на вставки этого нового оригинала. 
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Такая возможность очень практична, когда удобней создать новый оригинал компо-
нента не «с нуля», а с небольшими индивидуальными отличиями от уже существующего (на 
его основе).

Unglue (Отклеить) – «отклеивает» вставку от поверхности, то есть отменяет для 
нее назначенное ранее свойство оригинала компонента Glue to. Опция бывает полез-
ной, когда в сцену загружается «чужая» модель и обнаруживается, что автором уста-
новлена эта, ненужная нам, опция. 

Reload (Перезагрузить) – при внешней простоте и очевидности любопытная 
опция, которую стоит рассмотреть подробней. итак, основное назначение – для отме-
ны, например, неудачного редактирования оригинала за счет перезагрузки его ранее 
сохраненного файла. Применяем опцию и видим информацию, что компонент редак-
тировался и требуется подтверждение, что действительно хотим заменить его на дру-
гой (исходный) файл. 

 После подтверждения открывается Проводник, в котором указываем на ранее 
сохраненный файл исходного оригинала компонента, и далее фактически происходит 
отмена всех последующих изменений и возврат в состояние до редактирования, в том 
числе на всех его вставках! 

вторая возможная ситуация – после выбора опции на вставке видим информа-
цию, что компонент не редактировался и требуется подтверждение, что действительно 
хотим заменить его на другой файл. 

Отсюда следует интересный вывод: – в любой момент можем заменить текущий ори-
гинал компонента (и сразу – все его вставки в сцене) на любой другой. Причем, что самое 
интересное, вовсе не обязательно, чтобы это был именно компонент – применима любая 
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модель в формате .skp, которая автоматически «оформляется» как новый оригинал компо-
нента! Мы еще вернемся к возможностям Reload позже на практическом примере, показы-
вающем эффектный прием использования при работе с «тяжелыми» проектами.

Save As... (Сохранить как) – используется для сохранения объекта-компонента, 
как и любого другого файла SketchUp с указанием места размещения и возможностью сме-
ны имени (например, для сохранения модификации исходного компонента). в принципе, 
именно такие файлы и загружаются предыдущей опцией Reload.

Reset Scale (Сброс масштабирования) – используется для отмены всех предыду-
щих опций масштабирования вставки.

Reset Skew (Сброс искажения) – используется для отмены всех опций предыду-
щих искажений вставки. Заметим, что опция практически всегда неактивна – дело в том, 
что «искажение» возможно при очень редком стечении обстоятельств масштабирования, 
которое в реальной практике вряд ли встретится.

Scale Definition (Масштабирование оригинала) – применяет опцию масштаби-
рования выбранной вставки к оригиналу этого компонента, то есть редактирует его мас-
штабированием. Эта возможность может быть полезна, если обнаружили, что при перво-
начальном создании компонента ошиблись с его масштабом.

CoMponents (браузер КОМПОненТОВ)
в предыдущей части этой темы мы научились создавать компоненты опцией Make 

Component из «обычных» объектов сцены и назначать их параметры через сопутствующие 
опции редактирования. Однако есть и другие возможности, о которых – далее в этом раз-
деле... А сейчас о главном механизме полноценного управления компонентами – диалого-
вом окне, которое открывается через меню Window > Components. 

в каждый момент можем видеть (открыть) одну из трех его закладок-разделов, каж-
дый – со своими функциями. Переход между закладками доступен по кнопкам (заголовкам 
разделов) в средней части окна – Select (Выбор), Edit (Редактирование), Statistics (Ста-
тистика). 

select (Выбор)
Эта закладка всегда открывается в Браузере компонентов по умолчанию первой. 
для тестирования откроем новый, «чистый» файл, и в нем – пустое пока окно 

Components (рис. ниже слева). Поскольку никаких компонентов пока нет и не выбрано, ви-
дим в левом верхнем углу черно-белое условное изображение «кубика» компонента. Пра-
вее находятся окошко для имени выбранного компонента, ниже – второе, для коммента-
рия (Description) по нему. 

Построим простой объект – кубик – и создадим из него компонент «kubik» – видим, 
что тут же в окне (рис. ниже справа) появились его имя с сопутствующей текстовой инфор-
мацией и его изображение-миниатюра. Теперь для помещения вставки компонента в сце-
ну нужно просто кликнуть мышкой на его миниатюре или на его строке в списке, а затем – 
в нужном месте окна моделирования.
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 – кнопка открывает/закрывает аналогичное «вторичное» окно перечня компонен-
тов. Это дает возможность одновременно видеть два разных ресурса, два места хранения – 
например, и компоненты, уже включенные в проект, и папку с моделями на жестком диске.

 – кнопка открывает/закрывает варианты показа перечня компонентов и разме-
ра их миниатюр: Small Thumbnails (Маленькая миниатуюра), Large Thumbnails (Большая 
миниатюра), Details (Детальный список), List (Простой список). 

Пункт Refresh (Обновить) – «ручное» обновление стиля показа. ниже находится само 
окно перечня, которое отображает доступные компоненты в назначенном варианте показа.

А теперь зададимся вопросом: – могут ли в SketchUp появляться компоненты други-
ми способами, кроме создания их в сцене опцией Make Component? 

не закрывая текущий, откроем еще один файл SketchUp с готовой моделью «не ком-
понентом» (в этом примере – модель-группа офисное кресло). Заметим и запомним, кстати, 
особенность работы программы при необходимости одновременного, «параллельного» от-
крытия двух (и более) файлов – это можно сделать только запуском нового, второго «сеан-
са» программы. 

Теперь скопируем кресло в буфер (Edit > Copy или Ctrl+C), переходим в наш тесто-
вый файл и помещаем кресло в сцену из буфера (Edit > Paste или Ctrl+V). видим, что кре-
сло появилось в сцене как готовый компонент, что тут же отобразилось его миниатюрой в 
диалоговом окне. 
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Попробуем еще два других доступных способа помещения «внешних» моделей в от-
крытый файл (из одного файла в другой) – импортом (File > Import...), или простым перетас-
киваем из окна Проводника файла кресла в окно моделирования. Убеждаемся, что резуль-
тат тот же – в любом случае модель извне помещается в текущий открытый сеанс програм-
мы как компонент! и одна деталь – модель-компонент, – созданная в стороннем файле, по-
мещается в текущий проект со своими атрибутами (настройками), назначенными в том, сто-
роннем файле. во всех других случаях новому компоненту из модели извне присваиваются 
«минимальные» атрибуты по умолчанию.

 

 In Model (В модели) – кнопка открывает перечень компонентов, созданных в те-
кущем проекте или помещенных в него извне. То есть это тот самый вид окна Браузера ком-
понентов, который пока мы и рассматривали.

 Эта кнопка справа от «домика», кроме раздела In Model, открывает внешние ресур-
сы нескольких типов, где могут быть найдены и помещены в проект в качестве компонентов 
сторонние модели. Здесь надо заметить, что изначально (в «старых» версиях) диалоговое 
окно Браузера компонентов, кроме опций управления, фактически было каталогом готовых 
к применению моделей, которые включались в состав программы в виде развернутых тема-
тических коллекций. Применение их было очевидно – пользователь находил, выбирал и по-
мещал в сцену вставку нужной модели, быстро дополняя таким образом свои построения 
необходимыми объектами. После включения SketchUp в проекты Google (с 7-й версии) меха-
низм доступа к готовым моделям-компонентам принципиально изменился. в состав програм-
мы больше не включаются их объемные коллекции (за исключением нескольких примеров – о 
них далее), а поиск, выбор и загрузка в сцену предусматриваются в основном в online режиме 
с ресурсов Google 3D- Warehouse (Склада 3D-моделей Google). Поскольку отдельная боль-
шая тема работы с инструментами Google у нас еще впереди, здесь коснемся их только бегло. 

Components – открывает доступ к двум коллекциям с примерами компонентов, вклю-
ченным в программу:

Предлагаю самостоятельно просмотреть содержимое этих папок, только сразу поя-
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сню – новый термин Dynamic Components (Динамические компоненты) – предмет рассмо-
трения в отдельной теме, к которой вернемся позже.

Favorites: – тематический список ссылок-закладок, через который получаем доступ и 
к локальным (на жестком диске), и к сетевым через интернет (на Google 3D- Warehouse) ре-
сурсам моделей. 

Recent: – список последних использованных ресурсов в текущем сеансе программы.
Правее кнопки открытия рассмотренных списков находится окошко с логотипом Google 

для контекстного поиска через интернет моделей на Google 3D- Warehouse.

 Details – кнопка открывает меню дополнительных опций организации хранения 
моделей. в зависимости от того, какой ресурс (список) открыт, может быть доступен раз-
ный набор пунктов:

– Open or create a local collection... (Открыть или создать локальную коллекцию) – 
открывает окно Проводника для доступа к существующим папкам коллекций или созданию 
новых на жестком диске;

– Save as a local collection... (Сохранить как локальную коллекцию) – открывает 
окно Проводника для сохранения на жестком диске файлов компонентов текущего проек-
та (In Model);

– 3D- Warehouse terms of service – онлайн-информация по сервису 3D- Warehouse; 
– Add to Favorites... (Добавить в свои закладки-ссылки) – открывает окно доступа 

к этому списку (см. выше); 
– Remove From Favorites... (Удалить из списка) – удаляет открытые закладки-ссыл-

ки из этого списка;
– Expand (Расширить) – показывает все компоненты, использованные в проекте, в 

том числе те, которые являются деталями (частями) компонентов. 
– Purge Unused (Очистить от неиспользуемого) – удаляет ранее созданные или за-

груженные компоненты (см. список In Model), которые на данный момент не используются, 
то есть отсутствуют в окне моделирования (в сцене). дело в том, что даже после удаления 
компонентов из сцены они продолжают храниться в текущем файле (что мы и видим в спи-
ске In Model), утяжеляя его при сохранении. А как уже не раз подчеркивалось в других те-
мах, один из принципов грамотного моделирования – «все, что не используется, тут же уда-
ляем»! и о чем уже упоминалось неоднократно (и еще будет упоминаться) – аналогичная оп-
ция доступна и из окна Window > Model Info > Statistics. 

Разберемся с пунктом Statistics подробно здесь, чтобы больше к нему не возвра-
щаться... 

Панель показывает информацию о типе и количестве элементов модели и позволяет 
исправлять ошибки построений:

Entire Model (Всех элементов модели) или Only components (Только компонентов) – рас-
крывающиеся списки в верхней части окна дают возможность выбрать вариант показа.

Show Nested Components (Показать вложенные компоненты) – переключатель по-
каза в том числе и компонентов, «вложенных внутрь» других групп и компонентов.

Purge Unused (Очистить ненужное) – чрезвычайно полезная опция для разгрузки фай-
ла от «строительного мусора», который неизбежно накапливается в процессе работы. еще 
раз напомню, что окончательно удалить из файла такой бесполезный «груз» можно только 
принудительно этой опцией. 

Fix Problems (Исправление проблем) – кнопка поиска и исправления возможных проб-



17 Тема 15. КОМПОненТЫ

лем и ошибок в построениях. Эта опция проверяет следующие параметры: поверхности пра-
вильно стыкуются ребрами, все ребра одной поверхности находятся в одной плоскости, ре-
бра связанных поверхностей находятся в одном компоненте, поверхности не имеют нулевую 
площадь, начальные и конечные точки одного ребра не совпадают. 

возвращаясь к нашей теме – для управления Компонентами доступны также контек-
стные меню, которые вызываются кликом на их миниатюрах (списках). набор опций разли-
чается в закладках In Model и Components:

– Properties (Свойства) – для компонентов из коллекций, еще не задействованных 
в проекте, открывает окошко с общей информацией – место размещения файла, имя, вре-
мя его последнего открытия и число вставок в проект; для компонентов, использованных в 
проекте (In Model), – переключает на вторую закладку диалогового окна – Edit (о ней далее) 
для редактирования свойств компонента;

– Delete (Удалить) – для компонентов из коллекций, еще не задействованных в про-
екте, удаляет сам файл компонента; для компонентов, использованных в проекте (In Model),  
– все вставки компонента в проекте;

– Replace Selected (Заменить выбранное) – заменяет текущий выбранный компонент 
(или несколько) в окне моделирования на компонент в Менеджере компонентов, для которых 
применяется данная опция. Мы уже видели этот пункт при создании компонента из объекта 
сцены опцией Make Component в ее диалоговом окне и говорили о том, что стоит практиче-
ски всегда держать ее включенной. вообще, это одна из самых мощных функций компонен-
тов, поскольку позволяет мгновенно заменить многочисленные однотипные вставки, напри-
мер один тип дверей или окон, на другие. не менее эффективен прием помещения времен-
ных упрощенных вставок каких-либо типовых деталей-компонентов на этапе текущего мо-
делирования и замены их на аналогичные, но детально проработанные, на финальном эта-
пе – понятно, для снижения нагрузки на компьютер и удобства работы при текущем модели-
ровании (позже рассмотрим конкретные примеры);

– Reload (Обновить) – для компонентов, использованных в проекте (In Model), обнов-
ляет вставки компонентов из их оригиналов на случай, если вставка была нежелательно из-
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менена в ходе работы;
– Save As... (Сохранить как…) – для компонентов, использованных в проекте (In Model),  

сохраняет компонент как отдельный файл SketchUp с возможностью указания нового име-
ни и места размещения (например, для сохранения модификации исходного компонента); 

– Reset Insertion Point (Сброс точки вставки) – для компонентов, использованных в 
проекте (In Model) отменяет любые изменения, сделанные в точке вставки.

– Select Instances (Выбрать вставки) – для компонентов, использованных в проекте 
(In Model), выбирает все копии-вставки данного компонента в модели. 

Завершая рассмотрение опций закладки Select по загрузке компонентов в сцену и со-
хранению в системе коллекций, можно отметить, что устроено все это довольно сложно и 
громоздко, не так ли? впрочем, вы, наверное, уже поняли, что для SketchUp характерно дуб-
лирование одних и тех же действий разными вариантами, что дает возможность выбрать и 
пользоваться наиболее для себя удобным и привычным способом – то же относится и к боль-
шинству опций Select. Так, мы уже рассматривали простую и наглядную возможность импор-
та или копирования моделей через буфер из своих коллекций на жестком диске (и сохране-
ния там же), да и из любых других источиков – результат совершенно аналогичен! Что каса-
ется загрузки компонентов с сетевых ресурсов 3D- Warehouse – пожалуй, эта не настолько 
оперативная задача, чтобы постоянно находиться в онлайн-режиме и загружать их «изнут-
ри» SketchUp. на самом деле аналогичные возможности доступны в любое нужное время 
и через другие опции (инструменты Google – о них позже), да и просто через веб-браузер.

Таким образом, еще раз заметим, поскольку это достаточно типичное заблуждение 
начинающих пользователей: – для создания, загрузки и хранения коллекций компонентов 
совершенно необязательно пользоваться функциями Браузера компонентов... Главное – по-
нять, что по сути компоненты – это совершенно обычные объекты SketchUp, которым тем 
или иным способом и на любом этапе работы присваивается единственный дополнительный 
атрибут – принадлежности к типу компонентов!

edit (редактирование)

Эта вторая закладка окна Components предназначена для редактирования выбранно-
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го компонента (из списка или на миниатюре), но только уже использованного в проекте (In 
Model). А для компонентов из коллекции доступна только информация о месте размещения 
их файлов. Одновременно с выбором и открытием закладки Edit происходит и помещение 
его вставки в сцену – видим это, выведя курсор из зоны окна, – остается только для указания 
места «посадки» сделать там клик мышкой. если же мы хотим просто отредактировать ори-
гинал (Definition), отменяем «посадку» кликом на клавише Space (Пробел).

нетрудно заметить, что это окно практически повторяет диалоговое окно Make 
Component, которое подробно рассматривали ранее.

Aligment (Выравнивание) – здесь можно изменить установленные при создании ком-
понента параметры ориентации и воздействия на другие элементы построений, с которыми 
вставки компонента появляются в сцене.

Loaded from (Загрузить из): – Здесь указан путь загрузки файла компонента из кол-
лекции. изменив эти данные (выбрав другой компонент), получаем результат, в принципе 
аналогичный опции Replace Selected (Заменить выбранное), – и в списке использованных в 
проекте (In Model), и в окне моделирования он будет заменен на новый.

statistics (статистика)

Эта третья закладка показывает информацию о типе и количестве элементов моде-
ли, при этом можно выбрать варианты показа детализации этого списка: All geometry – все 
элементы, Components – только компоненты, Expand – показывает в том числе вложенные 
в другие, составные компоненты.

 

МОделируеМ КОМПОненТаМи (уЧебнЫй ПрОеКТ)
для закрепления знаний по достаточно сложному для понимания механизму компо-

нентов выполним учебный проект «Кресло для зрительного зала», задавшись целью – мак-
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симально использовать все возможности компонентов SketchUp. 
Прежде всего – ответ на типичный вопрос: – когда, в каких проектах и для каких объ-

ектов целесообразно вместо «обычных» объектов применять компоненты? Можно ответить 
вполне определенно и однозначно – всегда, везде и для любых объектов (или их частей), ко-
торые должны повторяться в проекте в двух и более экземплярах (два и более раза)! 

Поэтому из кресла как цельного объекта однозначно имеет смысл в итоге создать ком-
понент – очевидно, что в интерьере зрительного зала оно будет повторяться многократно. 
Однако этим возможности моделирования компонентами далеко не исчерпываются – раз-
беремся с оптимальными шагами выполнения проекта. 

итак, предположим, имеем такой готовый образец (например, чертеж или фото). 

1  начнем с анализа задачи, прежде всего – с особенностей конструкции. Как ви-
дим, фактически надо будет построить три его части (детали) – боковины, сиденье и спинку. 
и второй вывод – объект симметричный, то есть можно представить его состоящим из двух 
одинаковых «зеркальных» половин, рассеченных воображаемой вертикальной плоскостью 
симметрии. Заметим, кстати, что почти весь предметный мир (созданный руками человека, 
технологиями), в отличие от природного окружения, представляет собой симметричные объ-
екты (или «собран» из их симметричных частей)! Удивительное открытие, не правда ли?.. Это 
дает возможность использовать типичную для 3D-моделирования методику – строим толь-
ко одну половину, а затем, создав ее «зеркальную» симметричную копию, собираем объект 
полностью. Такой подход наиболее рационален и эффективен по очевидным соображени-
ям: во-первых, экономим на «весе» файла, а во-вторых – в нашем случае сборки из деталей-
компонентов, – получаем возможность редактировать их на любой стадии моделирования 
– от исходных общих форм до назначения материалов поверхностей.
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2  Строим обобщенные объемы основных частей – боковину и «половинки» спин-
ки и сиденья, создаем из них компоненты (рис. слева). Копируем их с перемещением по зе-
леной оси, затем опцией Flip along «отзеркаливаем» и стыкуем обе половины (рис. справа). 

3  Получили вроде бы уже нужный результат – целое кресло, но вид портит «шов», 
разделяющий обе симметричные половины. Проблема решается просто – входим в режим 
редактирования (и спинки, и сиденья), выбираем и скрываем опцией Hide только «торцы» 
половинок – соответственно, скрываются и их ребра – «шов» (рис. ниже слева). А чтобы по-
лучить удобный доступ к «торцам» для выполнения этой опции, можно использовать вре-
менное скрытие частей объекта, которые мешают обзору. Можно также применить эффект-
ный прием (запомним его!): – копируем в буфер и вставляем компоненты «половинок крес-
ла» где-нибудь в стороне от основной модели, и производим на них описанные манипуля-
ции. вот здесь и проявляются «во всей красе» уникальные свойства компонентов – то же са-
мое редактирование произойдет одновременно и на самой модели! ну а затем эту «вспомо-
гательную» копию удаляем. 
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4  Теперь можно приступать к деталировке, поскольку пока модель смотрится 
слишком угловато. Решаем, что нужно закруглить, сделать «мягкими» торцы частей кресла. 
Аналогично предыдущему этапу, опциями выбора получаем удобный доступ к внутренне-
му редактированию компонентов – этих частей кресла. Учитываем только, что редактируем 
«половинки», то есть торцы на стыках должны остаться плоскими. При необходимости ма-
нипулируем опциями скрытия/показа элементов и, используя инструмент Follow Me, скругля-
ем нужные ребра профилем нужного очертания. в итоге, вернувшись к общему виду кре-
сла, получаем искомый результат: 

но это не все. Мы можем не только модифицировать формы уже существующих ком-
понентов «внутренним» редактированием, но и добавлять к ним новые элементы, в том чи-
сле в виде компонентов, – и это тут же будет отображаться в «цельном» объекте. например, 
добавим в «спинку» новый компонент – пуговицы:
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и итог – заполняем «зрительный зал» вставками компонента «кресло» опцией пере-
мещения с копированием. 

еще раз отметим, что и на этом этапе работы над проектом можем как угодно редак-
тировать каждый из использованных компонентов, независимо от уровня их «вложенности» 
в другие, – и тут же получим общий законченный результат в сцене. например, повернем си-
денья в поднятое положение, а также назначим материалы для частей кресла:

но и это еще не все – опробуем еще одну эффектную функцию компонентов: 
– создадим новый условный компонент – «цилиндр»;
– выберем некоторые (или все, если требуется) вставки компонента кресла в сцене;
– откроем окно Components > In Model, найдем в нем компонент «цилиндр» и вклю-

чим в его контекстном меню опцию Replace Selected (Заменить выбранное):
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из этой условной демонстрации следует очень важный вывод: – можем в любой мо-
мент, буквально «в один клик мышкой» полностью перестроить сцену заменой одних ком-
понентов на другие!

outliner (сТруКТура груПП и КОМПОненТОВ)
Завершая рассмотрение групп и компоненто, как специфических элементов построе-

ний, рассмотрим эту опцию, которая используется для просмотра, выбора и организации их 
структуры в проекте в виде «иерархического дерева». 

Опция представлена диалоговым окном, которое открывается из меню Window > 
Outliner. Здесь все группы и компоненты в проекте (и только они!) отображены в виде спис-
ка имен и «дерева» порядка и уровней вложений (иерархической структуры) – типичное ре-
шение в большинстве 3D-редакторов. Понятно, что основное назначение опции – выбор 
объектов (как альтернатива основному – непосредственно в сцене) через этот список и при-
менение к ним (отсюда же) любых доступных опций. 

Разберемся с устройством окна подробно.
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Кнопка со знаком (+) показывает, что внутри этой группы (компонента) находятся другие 
группы (компоненты) – клик на кнопке открывает нижний уровень вложенности. Такая струк-
тура позволяет выбирать объекты в проекте для «внутреннего» редактирования групп (ком-
понентов) – для этого кликаем на их имени (соответственно, одинарный или двойной клик).

в Outliner используется также комбинация кнопок и текстов для идентификации ста-
туса групп и компонентов в структуре модели: 

– Component (Компонент) – четыре черных квадратика (открытый для редактирова-
ния – квадратики пустые);

– Group (Группа) – один черный квадратик (открытый для редактирования – квадра-
тик пустой);

– Locked Component (Фиксированный компонент) – четыре серых квадратика с «за-
мочком» в углу;

– Locked Group (Фиксированная группа) – один серый квадратик с «замочком» в углу;
– Hidden (Скрытый компонент или группа) – имя с написанием шрифтом серого цвета.
Стрелка в правом верхнем углу окна открывает дополнительное меню – в нем пункт 

Expand All (Расширить все) раскрывает все дерево структуры. Соответственно, Collapse All 
(Свернуть все) закрывает все ветки дерева структуры (иерархии элементов). Здесь же оп-
ция Sort by Name сортирует структуру по именам в алфавитном порядке. 

используя Outliner, можно перемещать группы (компоненты) по структуре – напри-
мер, переместить группу, которую неудобно редактировать, на верхний уровень структуры. 
для этого кликаем нужное имя в структуре и, удерживая клавишу мыши, перетаскиваем на 
новый уровень. 

Через список в Outliner, так же как и непосредственно на объектах в сцене, вызыва-
ются все их доступные контекстные меню. например, для назначения имен (переименова-
ния) групп (компонентов) вызовом контекстного меню правым кликом на их имени в структу-
ре используем или опцию Rename (Переименовать), или вызываем окно Entity Info (Инфо 
по элементу) и делаем это в его соответствующих окошках. естественно, аналогичные оп-
ции переименования групп (компонентов) при их выборе в рабочем окне программы тут же 
автоматически дублируются в Outliner. 

Заметим, что имена вставок компонентов автоматически строятся по определенному 
шаблону: Имя копии-вставки <Definition (Имя оригинала) # (номер вставки)>. Посмотри-
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те, как это выглядит в приведенном примере (рис. выше). 
Outliner также имеет Filter (Фильтр) для выделения и показа только тех групп (ком-

понентов), которые имеют определенный признак (буквы, цифры, текст) в имени. Эта оп-
ция помогает выбирать только нужные элементы структуры: вводим текст в окно фильтра 
– отобранные по этому признаку элементы будут подсвечены красным цветом, а не соот-
ветствующие этому признаку – скрыты. Чтобы вернуть показ всех элементов, просто уда-
ляем текст из окна фильтра.

использование возможностей этого диалогового окна, естественно, эффективно 
только при методичном и осмысленном назначении значимых имен Группам и Компонентам 
по ходу моделирования. Главное достоинство такого «структурированного» подхода – воз-
можность их быстрого нахождения и выбора даже в очень сложных проектах, где выпол-
нить то же непосредственно в сцене затруднительно. Так что решать вам, – какой способ 
выбора объектов более рационален в вашей практике, да и просто привычней и удобней 
– визуально, непосредственно в сцене, или через Outliner.



27

Тема 16. РАЗМеРЫ, ТеКСТЫ
Как было отмечено в общем обзоре программы в самом начале нашего кур-

са, одно из главных достоинств SketchUp – широкий набор функций и высокая точ-
ность построений уровня профессиональных CAD-редакторов (систем компьютер-
ного проектирования). Не имей он всего этого, вряд ли бы получил такое распро-
странение и признание у профессионалов – архитекторов, дизайнеров, проекти-
ровщиков... И в ряду этих функций одну из главных ролей играют необходимые 
в техническом моделировании механизмы измерений и простановки размеров, а 
также внесения в проектную документацию текстовой информации. 

вернемся в блок Constrution (Конструкционных) инструментов – знакомство с ними 
мы начали в первой книге. инструменты, расположенные по умолчанию в правой колонке 
этого блока кнопок, как раз и будут темой нашего рассмотрения. Плюс связанные с ними по 
назначению другие элементы интерфейса.

 DiMension (разМерЫ)
Этот инструмент используется для установки размерных элементов («образмерива-

ния») объектов сцены, что характерно для проектных материалов. Прежде чем изучать, как 
работает простановка размеров в окне моделирования, заметим, что:

1. в SketchUp считываются и показываются фактические размеры объектов в сцене в 
назначенных единицах измерений, поэтому имеет смысл все построения делать в реальных 
размерах (без масштабирования). Это тем более логично, что программа поддерживает вир-
туальную модель теоретически неограниченного рабочего пространства.

2. используются текущие единицы измерения и настройки их отображения, установ-
ленные в диалоговом окне Window > Model Info > Units (подробно рассмотрено в первой 
книге – «Тема 7. Measurements (Панель измерений»).
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3. Размерные элементы в SketchUp ориентируются и строятся в 3D-пространстве сце-
ны. Фактически это такие же объекты, что и геометрические построения (с определенными 
особенностями), а потому их можно выбирать, перемещать, вращать, масштабировать, уда-
лять, скрывать, назначать разным слоям. и еще – поскольку в числовых значениях исполь-
зуется обычный текст, он в любой момент может быть отредактирован, как в обычном тек-
стовом редакторе.

4. Размерные элементы «привязаны» к объекту измерения и при любых манипуляци-
ях будут «следовать» за замеряемым элементом.

5. Размерные элементы – не просто инструмент «рисования» соответствующей гра-
фики, а полноценный измеритель, который автоматически «снимает», а затем «выводит» эти 
числовые данные в интерактивном режиме связи «объект><размер». Это означает, что ин-
струмент обладает замечательной функцией – при любом изменении объекта измерения ав-
томатически меняется и числовое значение размера!

Прежде всего разберемся с настройками по умолчанию для текущего проекта, кото-
рые назначаются через диалоговое окно Window > Model Info > Dimension. 

Text (Текст) – кнопка Fonts... открывает дополнительное окно выбора шрифта – лю-
бого из установленных в системе. думаю, особых пояснений тут не требуется, поскольку это 
практически стандартная картина настроек такого рода в любых текстовых редакторах – на-
звание фонта, стиль начертания, размер, цвет. и, об этом уже было сказано, SketchUp без 
проблем работает с кириллицей, так что спокойно используем русские шрифты...

Leader Line – варианты оформления размерных линий и «засечек»:

None  Slash  
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Dot  Closed Arrow 

Open Arrow

Dimention – варианты положения размерного числа:
Align to screen – выравнивание в плоскости экрана, то есть при вращении камеры 

число будет также вращаться, оставаясь все время «лицом к камере» (этот вариант видим 
на рисунке выше); 

Align to dimension line – здесь доступны три варианта положения размерного числа: 
Above (Над размерной линией), Centered (По центру размерной линии), Outside (под раз-
мерной линией):

Centered  Outside 

Эти установки оформления действуют на новые (последующие) простановки разме-
ров в сцене, однако легко можно заменить на них и уже существующие – для этого выбира-
ем другие нужные настройки и используем по очереди две кнопки ниже:

Select all dimension – выбрать все размеры в сцене;
Update selected dimension – изменить все размеры в сцене.
внизу окна видим еще одну кнопку – Expert dimension seeting, которая открывает 

окошко дополнительных «тонких» настроек этого механизма:
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Show radius/diam prefix – показ/скрытие префикса радиуса/диаметра. Префикс – бук-
венные условные обозначения числового параметра, которые ставятся перед ним: в случае 
этих размерных – DIA или R.

Hide when foreshortened – скрывать в ракурсе;
Hide when too small – скрывать очень мелкие.
«Сила» эти двух параметров регулируется слайдерами. Смысл, думаю, понятен: – при 

определенном ракурсе камеры и величине зуммирования, в сочетании с другими настройка-
ми, размерные элементы становятся просто «нечитаемы», поэтому таким образом есть воз-
можность их временно скрывать;

Hightlight non-associated dimensions – «подсвечивать» размеры, не связанные с объ-
ектами. дело в том, что размерные элементы остаются в сцене, если даже сам объект измере-
ний уже удален, – опция помогает выделять такие уже «бесполезные» объекты цветом (после 
включения появляется цветной квадратик выбора цвета). После чего, конечно, их стоит уда-
лить. впрочем, стоит заметить, что вполне можно обойтись и без этих «экспертных» настроек...

Почти все опции редактирования размерных элементов доступны также и в сцене че-
рез пункты их контекстных меню, в том числе большинство – через диалоговое окно Entity 
Info (Инфо по элементу). например, таким образом удобно вручную редактировать (изме-
нять) текстовую часть, что иногда может потребоваться. и в тот же режим редактирования 
можно войти непосредственно на тексте в сцене, сделав на нем двойной клик. 

Посмотрим теперь, как работает размерный механизм SketchUp в сцене на тестовом 
объекте:
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Основой определения размеров являются Edges (Ребра), точнее их контрольные точ-
ки: end points (конечные точки), midpoints (средние точки), on edge points (точки на ребре), 
intersections (пересечения линий), а также, на дугах и окружностях – их centers (центры). 

для установки размеров: кликаем кнопку Dimension > кликаем в стартовой точке > 
перемещаем курсор вдоль измеряемого элемента > кликаем в конечной точке > переме-
щаем курсор по плоскости, в которой хотим видеть размер > кликаем для завершения оп-
ции. Можно строить линейные размерные элементы на нескольких планах осей – red-green 
(красно-зеленом), red-blue (красно-синем) или на планах, выравненных по ребру, которое 
мы измеряем. 

Заметим, что при этом в панели статуса выводятся пошаговые подсказки: при помещении 
курсора на кнопку в панели инструментов появляется подсказка по назначению: «Dimension» – 
создание размерных элементов, а после выбора инструмента – подсказка, которая предлагает: 
«Select an edge, curve ot two point to dimension, or drag one to move» – для построения раз-
меров выбрать ребро, кривую или две точки, или точку, от которой протянуть размер. После 
выбора стартовой точки: «Select second point for linear dimension» – выбрать вторую точку для 
линейного размера, а после ее назначения: «Place the dimension» – разместить размеры. При 
этом размерные элементы, лежащие в одной плоскости, легко (за счет механизма «привязки»)  
выравниваются в одну линию – «цепочку» размеров, как это принято в чертежах.

есть некоторые отличия при простановке размеров линейных элементов от дуговых 
элементов и окружностей – прежде всего, размеры радиуса и диаметра могут быть помеще-
ны только в плоскости соответствующих дуг и окружностей. Чтобы проставить величину ра-
диуса дуги: кликаем курсором на любой точке дуги > перемещаем курсор в ее плоскости 
(внутрь или наружу) > вторым кликом завершаем опцию: появляется размерный элемент 
вида: R100. Чтобы проставить величину диаметра окружности: кликаем курсором на лю-
бой точке окружности > перемещаем курсор в ее плоскости (внутрь или наружу) > вторым 
кликом завершаем опцию: появляется размерный элемент вида: DIA100.

Можно поменять размерное представление уже замеренных величин – диаметр в ра-
диус, а радиус в диаметр. для этого делаем контекстный клик на размерном элементе, на-
пример, радиуса и выбираем пункт контекстного меню Type (Тип) > Diameter (Диаметр) – 
его величина и обозначение изменятся на диаметр. Аналогично выполняется обратная за-
мена – диаметр в радиус.
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 text (ТеКсТ)
Этот инструмент используется для вставки текстовой информации в сцену – любых 

поясняющих и прочих надписей. 
Текст создается с использованием настроек, которые назначаются в диалоговом окне 

Window > Model Info > Text. Как видим, это окно очень похоже на предыдущее (Dimensions) 
и по устройству, и по аналогичным функциям, поэтому нередко пользователь путается, где 
что настраивать, – будем внимательны...

Свойства Текста как объекта аналогичны текстовой части рассмотренных выше раз-
мерных элементов (в том числе по Fonts... – их выбору и редактированию), поэтому на этом 
останавливаться не будем. 

в SketchUp Текст представлен двумя типами: Screen Text (Экранный) и Leader Text 
(Выносной), настройки которых и видим на соответствующих панелях диалогового окна.
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screen text (экранный) – отличается от Выносного текста отсутствием вынос-
ных линий (привязок к элементам построений), и главное – он совершенно независим от 
объектов сцены, но «привязывается» к определенному месту на экране. для создания тако-
го текста: кликаем кнопку инструмента (курсор меняется на его изображение с текстовым 
полем) > кликаем курсором в любом месте экрана, обозначая место его размещения, – в 
«затененном» текстовом поле автоматически появляется слово Text, готовое к редактиро-
ванию («переписываем» нужный текст) > кликаем третий раз в стороне для завершения оп-
ции. Остальные опции аналогичны выносному типу.

leader text (Выносной) – содержит надпись (текст) и выносные линии, кото-
рые прикрепляют его к выбранным элементам. По своему «поведению» этот вариант –  
почти полный аналог Размеров.

для создания такого текста: кликаем кнопку инструмента (курсор меняется на его 
изображение с текстовым полем) > кликаем курсором на выбранном элементе объекта 
(поверхности или ребре), обозначая конечную точку выносной линии > перемещаем кур-
сор в нужное положение на экране, кликаем второй раз для фиксации положения вынос-
ки > кликаем третий раз в стороне для завершения опции. если хотим сразу ввести нужный 
текст, набираем его на клавиатуре на предпоследнем шаге – текст «переписывает» содержи-
мое в «затененном» текстовом поле. если ничего не вводим, в тестовом поле автоматически 
по умолчанию выводится некая информация (в зависимости от характера элемента, от кото-
рого делается выноска): от поверхностей – их площадь, от одиночных линий – длина, от ко-
нечных точек линий и ребер – координаты, от групп и компонентов – имя.

Отредактировать текстовое содержание выноски можно и позже в любой момент – 
делаем в текстовом поле двойной клик (или из контекстного меню выбираем опцию Edit 
Text) > выделяем весь текст > набираем свой текст > кликаем еще раз в стороне для за-
вершения опции. 

leader lines (Выносные линии) – кроме шрифтовых настроек, доступны  
дополнительные для Leader Text:

End point (Конечная точка) – четыре варианта вида начальной точки выносной линии: 
None (Нет), Dot (Точка), Closed Arrow (Закрытая стрелка), Open Arrow (Открытая стрел-
ка). Как видим, используется та же графика, что и в размерных линиях; 

Leader (Выноска) – два варианта: View Based (Базовый вид), установленный по умол-
чанию, при котором текстовые элементы всегда остаются в плоскости экрана, или Pushpin 
(Вращающийся), который находится в 3D-пространстве сцены и вращается вместе с вра-
щением камеры. 
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Как и для размеров, почти все опции редактирования текстов доступны также и в 
сцене через пункты контекстного меню, в том числе большинство – через диалоговое окно 
Entity Info (Инфо по элементу). 

ну и в завершение описания инструментов Dimensions и Text приходится, при всех 
их достоинствах, отметить наличие нескольких общих проблем и затруднений в приме-
нении:

1. Отсутствие возможности простановки угловых размеров. 
2. Опции зуммирования камерой не действуют на размеры шрифта – он остается 

постоянным, то есть независим от текущего увеличения/уменьшения вида объекта. По 
этой причине довольно затруднительно сразу выбрать подходящий размер шрифта – за-
частую он выглядит слишком мелким или слишком большим относительно размеров объ-
екта, и приходится его несколько раз корректировать под текущий «взгляд» в сцену. Что 
тем более неудобно – такие изменения настройки действую «глобально», на весь проект, 
то есть его невозможно делать разным, например в каждой сцене или слое. 

3. если выносные тексты достаточно управляемы, то экранные явно непрактичны. 
дело в том, что они не только абсолютно не связаны с объектами, манипуляциями каме-
рой и механизмом Сцен, но и к тому же всегда остаются в плоскости экрана и фактиче-
ски постоянно «привязаны» к тому месту на экране, где были созданы.

в то же время все эти проблемы нельзя считать только результатом недоработок 
SketchUp, поскольку такие типичные для 2D-«чертежных» редакторов механизмы помеще-
ны, как уже было сказано, в 3D-пространство. А в таком «бесконечном» во всех измерени-
ях рабочем пространстве в принципе не может быть «границ» в виде размеров формата, 
листа чертежа. и не будем все-таки забывать, что SketchUp – не чертежная программа...

Резюмируя описание инструментов Dimensions и Text, можно дать такую рекомен-
дацию: – стоит оценить ситуацию с ними и принять наиболее подходящее под свои зада-
чи решение – где, когда и какими программными средствами рационально пользоваться 
для оформления чертежей размерами и поясняющими текстами. например, если вы вла-
деете каким-либо векторным редактором (а тем более CAD), может быть вполне оправ-
дана такая доработка проектов именно в них, а не в SketchUp, если его возможности в 
этой части не устраивают. 

ну и конечно, прежде всего можно настоятельно рекомендовать идеального «парт-
нера» SketchUp под эти задачи – программу LayOut 3.0, входящую в комплект SketchUp 
8 Pro... и хотя эта тема – вне рамок нашего курса, несколько слов о LayOut стоит здесь 
сказать.

Это приложение для дизайна и представления проектных документов разных ти-
пов, размеров и форматов как в печатном виде, так и для экранного просмотра, которое 
включает в себя функции векторных, CAD и презентационных программ. Что самое важ-
ное, LayOut, будучи 2D-редактором, полностью интегрирован с самим SketchUp – в про-
цессе работы поддерживается непосредственная интерактивная связь с 3D-моделями 
SketchUp. документы LayOut, кроме изображений собственно 3D-моделей, могут вклю-
чать в себя заново вычерченные векторные изображения, текстовые блоки, размерную 
информацию, типичные чертежные выноски, символы и т. п. и таким образом идеально 
дополняют отсутствующие в SketchUp «чертежные» возможности.
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 3D text (3D-ТеКсТ)
Этот инструмент разработчики включили в блок с конструкционными инструментами, 

пожалуй, только из соображений, что он, как и Dimensions и Text, использует установленные 
в системе шрифты. Принцип его работы прост – он позволяет создавать из набранного тек-
ста 3D-объект. Понятно, что потребность в нем возникает значительно реже, чем в осталь-
ных конструкционных инструментах, но для некоторых проектов (скажем, для дизайна на-
ружной рекламы) такая возможность очень практична. Заметим, что на самом деле эту оп-
цию можно рассматривать как частный случай задачи импорта в SketchUp векторной графи-
ки (эта тема будет рассмотрена подробно далее), поскольку шрифты по сути именно тако-
вой и являются. Разница в том, что здесь мы сразу получаем «готовый к употреблению» ре-
зультат – объемный и сглаженный 3D-текст.

Тут все достаточно просто: нажимаем кнопку 3DText – открывается диалоговое окно 
опции. набираемый текст отображается в текстовом поле, ниже в окошках параметров на-
страиваем вид шрифта (фонт, начертание, выключку, размер) – они будут сохранены и откро-
ются при следующем применении инструмента. 

Form/Filled – переключатель между двумя возможными вариантами: создание 3D-объ-
екта или 2D-плоской фигуры – контура текста.

Extruded – переключатель выдавливания текста заданной величины в линейных едини-
цах измерений проекта. выключение предыдущего переключателя Form/Filled делает невоз-
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можным применение этой опции, что понятно.
Place – закрывает диалоговое окно, после чего требуется указать место в сцене и 

кликнуть в нем курсором – сюда и будет помещен этот новый объект. С этого момента ре-
дактирование текста как шрифта становится невозможным, так как он превращается в  
обычный объект SketchUp, точнее группу, с которой возможны все опции, доступные для 
любых других 3D-объектов.
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Это еще один типичный (чертежный) механизм CAD-редакторов, который 

применяется в техническом (архитектурном, конструкторском, дизайнерском) мо-
делировании. По прямому назначению он используется для показа, представле-
ния внутренней геометрии объекта за счет отсечения его части секущей плоско-
стью. Кроме того, в SketchUp разрезы/сечения могут быть и средством создания 
эффектных презентаций, в том числе анимированных.

инструменты этой группы представлены отдельным блоком кнопок – если не видим 
его в интерфейсе – устанавливаем через меню View > Toolbars > Sections.

Прежде всего уточним, что по принятой чертежной терминологии Разрезом называ-
ют вид, который «отсекает» и скрывает одну из частей объекта так, что становится ясно вну-
треннее строение его оставшейся части, а Сечением – вид, на котором показывается толь-
ко то, что находится непосредственно в секущей плоскости. в английском языке (и, понят-
но, в SketchUp) для этих опций используется только одно понятие – Section, перевод кото-
рого имеет и то, и другое значение, что создает некоторую путаницу. Однако, как увидим 
дальше, фактически это инструмент создания именно Разрезов, поэтому по-русски так и бу-
дем их называть. 

 
– section plane (секущий план, плоскость) – собственно, инстру-

мент отсечения, создания секущей плоскости. 
Прежде всего уточним несколько общих принципов устройства и работы инструмента.
1. Активная Секущая плоскость бесконечна по размерам, действует по всей сцене и 

на все объекты, которые она пересекает в окне моделирования.
2. исходно, в прямом действии, инструмент никак не влияет на собственно геомет-

рию построений, поскольку является только средством визуализации (показа), а потому се-
кущая плоскость (плоскости) может быть в любой момент удален без последствий для объ-
ектов сцены.

3. настройка графики элементов разрезов (цветовое кодирование, ширина линий и 
т. п.) назначается в диалоговом окне управления Стилями Window > Styles > Edit > Modeling 
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Setting (см. первую книгу, тема 14 «Стили»).

итак, включаем инструмент кнопкой Section Plane и помещаем курсор в сцену – ви-
дим, что появляется изображение секущей плоскости (прямоугольник со сторонами и стрел-
ками по углам зеленого цвета). 

не нажимая кнопку мышки, понаблюдаем за поведением курсора-плоскости при пе-
ремещении по экрану – нетрудно заметить, что секущая плоскость стремится «лечь» либо 
на один из планов осей сцены, либо на поверхность находящегося под ней объекта. Чтобы 
сразу все стало ясно с ориентацией – она ведет себя совершенно аналогично курсору ин-
струмента Rotate. вспомним: – инструмент «понимает, что от него хотят», когда нужный план 
осей преобладает «в кадре» текущего ракурса камеры. например, для того чтобы выста-
вить секущую плоскость вертикально, просто направляем камеру выше линии горизонта, и в 
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определенный момент плоскость развернется как надо. А если под ней оказывается ориен-
тированная любым образом поверхность объекта, секущая плоскость «ляжет» на нее. Кро-
ме того, здесь также работает фиксация ориентации нажатием клавиши Shift – то есть можем 
таким образом сначала выставить нужную ориентацию на одном месте экрана (или повер-
хности объекта), а затем перенести ее в том же положении на другое место (другой объект).

итак, выставив секущую плоскость нужным образом, кликаем первый раз кнопкой 
мышки, завершая создание первого разреза, – прямоугольник курсора «перекрашивается» 
в оранжевый цвет, а стрелки по углам показывают направление действия (все «за спиной» 
стрелок отсекается и скрыто). Таким же образом в любой момент можем создать сколько 
угодно других разрезов разной ориентации. Кликом на уже установленном в сцене разрезе 
выбираем его, то есть делаем текущим (активным), о чем сигнализирует еще одна перекра-
ска – в синий цвет. Можно также использовать другой вариант активации – кликаем на разре-
зе правой кнопкой мышки, вызывая контекстное меню, а в нем – пункт с «галочкой» Activate 
Cut (Активировать отсечение).

Разрез активен (то есть действует в сцене) до выбора другого элемента построения, 
например другого разреза (неактивный разрез из цветного становится серым). Удаляется 
разрез точно так же, как и любой другой объект сцены.

Отметим еще несколько принципиальных моментов устройства этого механизма:
1. Разрез можно перемещать и вращать точно так же, как и любой другой объект сце-

ны инструментами Move и Rotate. 
2. в сцене могут одновременно находиться несколько разрезов, однако в каждый мо-

мент времени активным (то есть действующим) может быть только один. в то же время раз-
резы, созданные в режиме внутреннего редактирования групп (компонентов), независимы 
от остального содержимого сцены – то есть при такой ситуации могут быть активными не-
сколько разрезов одновременно, поскольку они находятся в разных контекстах, отдельно 
друг от друга (рис. ниже слева). 

3. Можно «развернуть» направление действия разреза в обратную сторону, вызвав 
через контекстное меню опцию Reverse, что отобразится разворотом направления стрелок 
по углам плоскости разреза (рис. ниже справа). 
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Посмотрим теперь, как работают две дополнительные кнопки:

– Display section planes (Показать секущую плоскость) – вклю-
чение/выключение показа секущих плоскостей в сцене. То есть можно показывать дейст-
вие разрезов без показа самих секущих плоскостей – собственно, это и есть конечный вид 
показа разрезов в проекте.

– Display section Cuts (Показать отсечения) – включение/выклю-
чение показа действия механизма Разрезов. Таким образом фактически можем до нужного 
момента полностью выключить отображение Разрезов в сцене и продолжать текущую ра-
боту без помех... 

Пока мы рассмотрели действие механизма Разрезов только в качестве средства визуа-
лизации, но на самом деле есть и продолжение их возможностей. Прежде всего Разрез мож-
но превратить в новое построение – объект-группу, применив из контекстного меню опцию 
Create Group from Slice (Создать Группу из Разреза). Эта опция создаст новые ребра в со-
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ставе группы в месте их пересечения с поверхностями, а значит, как и любая другая группа, 
создаст независимый объект, отделенный от остальных элементов построения. 

на самом деле это первый шаг решения одной проблемы – по логике мы должны 
были бы увидеть в разрезе поверхности-«торцы» рассеченных объемов, однако опция со-
здает только ребра, так как SketchUp «не умеет» автоматически «затягивать» их поверхно-
стями (рассматривать как сплошные тела)... на правом рисунке выше такая группа ребер 
для наглядности вынесена наружу, но если оставить ее после создания на месте и приме-
нить Еxplode (Разорвать), ее элементы станут частью исходного построения. То есть факти-
чески получаем результат, аналогичный действию опций Intersections (Отсечений)... но это 
наша будущая отдельная тема. После чего остается удалить ненужную отсеченную часть и 
вручную, применяя инструмент Line, «подсказать» программе, на каких замкнутых ребрами 
частях объекта создать поверхности. 

Конечно, такое решение трудно назвать удовлетворительным... есть и еще одно за-
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труднение – невозможно создать так называемые «угловые» разрезы (типичный чертежный 
прием), то есть чтобы одна секущая плоскость «ломалась» под определенным углом. Поче-
му невозможно, понятно из самого принципа работы – как бесконечной плоскости. 

итак, мы создали нужные разрезы – остается разобраться, каким образом сохранить 
результат... 

начнем со Сцен (тема 13 первой книги) – видим в параметрах, которые возможно со-
хранять в сцене пункт – Active Section Planes (Активные сечения):

думаю, особых пояснений здесь не требуется – распределяя нужным образом показ 
проекта по Сценам, включаем/выключаем видимость разрезов и их «внутренних» вариантов 
показа инструментами Display Section Planes и Display Section Cuts.

Кроме того, для скрытия/показа действия Разрезов можно использовать и Слои – выз-
вав на любом из разрезов диалоговое окно Entity Info, видим, что, как и другим объектам, 
Разрезам можно назначить принадлежность любому из существующих в проекте Слоев. А 
это, в свою очередь, – один из параметров, который может быть включен/исключен из учи-
тываемых в Сцене...

и в завершение темы – несколько слов о дополнительных возможностях представ-
ления Разрезов, которые будут подробно рассмотрены позже в отдельных темах Экспорта и 
Анимации. во-первых, SketchUp позволяет экспортировать результаты работы с разрезами 
в двух вариантах: как 2D-«картинку» сцены с разрезами – растровую или векторную, – или 
только собственно Разрезы в ортогональных 2D-проекциях и векторных форматах. и во-вто-
рых, манипуляции с разрезами могут быть очень эффектно использованы в анимированных 
презентациях – об этом подробней позже...
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Буквальный перевод названия этой группы инструментов Sandbox – «пе-

сочница», – хотя и шутливо, но достаточно точно определяет их назначение. 
Очевидно, что разработчики прежде всего имели в виду механизмы создания и 
редактирования трехмерных рельефов местности – задача, типичная и актуаль-
ная прежде всего для архитектурного проектирования и ландшафтного дизай-
на. Однако на самом деле правильней рассматривать Sandbox шире, как группу 
инструментов, принцип действия которых основан на создании и манипулирова-
нии поверхностями сложной кривизны (рельефами) в виде Meshes (Сеток) – по-
верхностей с плоскими треугольными ячейками. 

Этот самостоятельный программный модуль по умолчанию отсутствует в интерфейсе, в 
том числе и в меню, и поэтому в первый раз пользователи, как правило, находят его с трудом. 

Прежде всего открываем диалоговое окно общих настроек программы Window > 
Preferences. Здесь в строке Extensions (Расширения) ставим галочку на пункте Sandbox Tools 
– видим соответствующие пункты в разных меню: Draw > Sandbox, Tools >Sandbox и View > 
Toolbars > Sandbox. Конечно, удобней работать именно с кнопками панели инструментов – вы-
зываем ее этим последним вариантом доступа. 

From Contours (из контуров) 
инструмент используется для создания Сеток рельефа, формируемого замкнутыми и 

незамкнутыми линиями (ребрами, кривыми), расположенными на разной высоте. 
Типичный пример – построение рельефа на основе топографической съемки мест-

ности – линий так называемых «горизонталей», каждая из которых имеет определенное из-
меренное превышение относительно принятого «нулевого» уровня. или по-другому: пред-
ставьте, что рельеф «режется» горизонтальными плоскостями-уровнями через определен-
ный высотный интервал – получаем «слоеный пирог», в котором очертания границ каждой из 
плоскостей и называются «горизонталями». Отрисуем, например, эти линии по подоснове – 
импортированной в виде растрового имиджа топосъемке, или импортируем их в векторной 
графике (одна из будущих тем), заранее нарисовав в векторном редакторе.

Пусть это будет рельеф, на который надо «посадить» нашу тестовую модель домика.
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 Сразу заметим принципиальное ограничение – исходные контуры могут быть построе-
ны на одном из планов осей или на любой поверхности, однако надо учитывать, что дейст-
вие инструмента всегда направлено только строго по вертикали – то есть синей оси (!), – и 
работает без искажений лишь при строго горизонтальной ориентации плоскостей контуров. 

Поднимаем вверх (по синей оси) каждую из горизонталей (выбрав все ее сегменты 
вместе) на указанный уровень превышения – естественно, соблюдая масштабность по вы-
сотным размерам. Затем выбираем все контуры и включаем инструмент – появляется новое 
построение – автоматически сглаженный рельеф в виде группы – Сетки, после чего исходные 
контуры можно переместить в сторону или удалить, если уверены, что они больше не нужны. 

Работа инструментами рельефов нагляднее всего проявляется в режиме показа скры-
тых построений (View > Hidden geometry) или временного отключения визуального сглажива-
ния опцией Soften/Smooth edges из контекстного меню (см. темы 5 и 9 первой книги).

еще раз подчеркну, что и на этот, и на остальные инструменты рельефов стоит смот-
реть в более широком плане... например этот, From Countours – единственный, умеющий 
придавать набору обычных линий (кривых) новое качество – превращать их в цельные по-
верхности сложной кривизны с возможностью дальнейшего редактирования «сеточными» 
инструментами. То есть в общем случае его можно использовать для любых построений со 
сложными криволинейными поверхностями за счет «обтяжки» сглаженной поверхностью на-
бора неких «опорных» профилей типа шпангоутов корабельного корпуса.
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 From scratch (из линий) 
Это еще один инструмент создания исходной сетки – всегда регулярной (с одинако-

выми ячейками), плоской и прямоугольной в плане. 
После выбора кнопки инструмента курсор изменяется на «карандаш» с символом сет-

ки, а в панели Measurements появляется величина в виде, например, Lenght: 3000. Это уста-
новленный по умолчанию шаг сетки (величины ее ячеек), и если он нас не устраивает, тут 
же вводим свое значение. 

вторым шагом протягиваем с нажатой клавишей мышки первую сторону сетки, фик-
сируя двумя кликами ее начало, направление и конечную точку, – в Measurements отобража-
ется текущая и может быть введена любая необходимая величина первого измерения сет-
ки. Построение сетки может быть начато на одном из планов осей, в любом направлении 
или на любой поверхности. 

Третьим шагом протягиваем вторую сторону сетки в перпендикулярном (возможно 
только так!) к первому направлении и фиксируем третьим кликом – в Measurements появляет-
ся величина второго измерения сетки. Этим завершается построение, и в сцене появляется 
новая группа, в которой сетка выглядит как состоящая из прямоугольных (или квадратных) 
ячеек, однако если войти в режим редактирования группы (или View > Hidden Geometry), ви-
дим, что на самом деле ячейки также треугольные (диагонали скрыты).

 Чаще всего сетки, созданные инструментами From Counturs и From Stratch, исполь-
зуются как исходные для модификаций описанными ниже другими «сеточными» инструмента-
ми. в то же время они являются обычными объектами SketchUp, а следовательно, к ним мо-
гут быть применены все инструменты и опции модификаций как к группе, так и к отдельным 
их элементам – ребрам и поверхностям при редактировании внутри группы. 

 smoove (Присоска)
Это первый из специальных инструментов манипуляций (редактирования) характера 

сеточных поверхностей. Он используется для «лепки» участка уже существующей сетки пе-
ремещением смежных ребер и поверхностей с одновременным «плавным» изменением их 
геометрии. в этом и состоит принципиальное отличие от других, «общих» инструментов мо-
дификаций – «сеточные» учитывают постепенное «затухание» усилия деформации от точ-
ки приложения к «периферии», что и дает возможность создания поверхностей сложной и 
плавной двоякой кривизны. 

После нажатия кнопки инструмента и помещения курсора на сетку видим его символ с 
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красной окружностью, показывающей зону действия инструмента, а в Measurements – величину 
радиуса этой окружности по умолчанию, которую, конечно, тут же можно изменить на свою. 

вторым шагом кликаем в нужном месте на сетке – вершины ячеек, граничащие в пре-
делах радиуса действия инструмента, подсвечиваются желтыми квадратиками разной вели-
чины, что отображает силу воздействия (деформации). Как видим, она максимальная в цент-
ре и уменьшается к его круговой границе, что и обеспечивает плавную кривизну деформа-
ции. При этом у Measurements наименование значения Radius меняется на Offset – предла-
гая следующим действием ввести точную величину смещения (максимальную силу действия 
инструмента). 

Третьим шагом вводим значение Offset или просто «вприглядку», отпустив кнопку 
мышки, тянем курсор вверх или вниз по синей оси (возможно только так!) – при этом ве-
личина деформации динамически отображается в Measurements. Кроме того, на этом этапе 
можно изменить и радиус или диаметр зоны действия инструмента, вводя в Measurements 
величины в виде «1500r» или «3000d». Получив нужный результат, кликаем еще раз, завер-
шая построение. и конечно, можно сколько угодно раз повторять те же самое, добиваясь 
нужного результата. 

еще одна возможность усложнить способ лепки – с нажатой клавишей Shift будет про-
исходить вытягивание рельефа не в вертикальном (по синей оси) направлении, что предус-
мотрено по умолчанию, а по другому принципу – перпендикулярно (точнее, нормально) пло-
скости любого выбранного полигона или другого элемента сетки, на который в данный мо-
мент помещен центр инструмента. 

и еще одна полезная возможность, о которой стоит помнить, – двойной клик курсо-
ром инструмента в другом месте сетки повторяет предыдущую опцию с теми же параметрами!
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ну и в итоге можно также изменить степень сглаживания всей сетки на нужную, ис-
пользуя опцию Soften/Smooth edges из контекстного меню.

любопытно, что на самом деле Smoove «узнает» любую «сеткоподобную» структуру 
построений, в том числе созданную и без участия специальных инструментов этой группы, – 
то есть этот инструмент будет работать на любых поверхностях, построенных любым спосо-
бом и разделенных ребрами на участки-ячейки! в то же время приходится отметить сущест-
венные ограничения возможностей инструмента, суть которых – исходно «сквозное» дейст-
вие, и только по вертикали (синей оси)! вот что мы увидим, попытавшись применить Smoove 
на одной из поверхностей объемного построения (не важно – верхней или нижней): 

 stamp (штамп)
назначение этого инструмента «узкоспециализировано» на задаче создания гори-

зонтального (плоского) основания для установки объекта на рельефе. Типичный пример – 
«врезка» основания фундамента дома в участок местности. или по-другому: создается дуб-
ликат плана основания (причем только внешних габаритов!) объекта в рельефе, с одновре-
менным слиянием его с сеткой рельефа и подъемом/спуском на определенный уровень от-
носительно рельефа. в качестве очертаний основания может быть использована любая от-
дельная поверхность, несколько выбранных вместе поверхностей, группы или компоненты.

Посмотрим, как это работает, на примере нашего домика и рельефа, созданного в на-
чале этой темы из горизонталей инструментом From Countours. 

 Первый шаг – выбираем инструмент и помещаем его курсор на объект (в этом слу-
чае – группу домика). При этом происходит его выбор, а курсор меняется на символ дейст-
вия – миниатюру изображения кнопки. 

второй шаг – кликаем курсором – по периметру основания домика появляется крас-
ная контурная линия, обозначающая зону действия инструмента, а в Measurements – вели-
чина Offset (расширение зоны проекции основания на сетку) по умолчанию, которую мож-
но изменить на свою.
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Третий шаг – кликаем курсором на сетке – на ней появится горизонтальная поверх-
ность – копия (проекция) основания домика с примыкающими частями сетки, которые пе-
ремещаем мышкой вверх-вниз до нужного положения. Получив нужный результат, третьим 
кликом завершаем опцию. 

ну и остается завершить то, ради чего применяли опцию, – опускаем домик на подго-
товленное горизонтальное основание на рельефе. Можем также, используя ту же методику, 
дополнить организацию ландшафта дорожкой – думаю, теперь очевидно, как это сделать, 
построив сначала ее плоскость-очертание и аналогично «опустив» на рельеф. 
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 Drape (драпировка)
инструмент работает вроде бы аналогично предыдущему, но есть принципиальное 

отличие – результатом проекции объекта, помещенного над рельефом, является лишь «про-
резание» поверхности рельефа. Причем (важная деталь!) если в Stamp используются толь-
ко внешние общие габариты объекта, здесь фактически проецируются все ребра объекта 
(как при виде «сверху» в стиле рендеринга Wireframe). При этом образуются новые ребра 
и поверхности, «внедренные» в рельеф. После чего появляется возможность редактирова-
ния «отсеченной» части рельефа независимо от его остальной части – например, можно раз-
дельно назначать материалы или применять инструменты модификаций. 

Здесь, конечно, показаны упрощенные схемы работы этих двух интересных инстру-
ментов, а на самом деле можно, используя их механизмы, решать и другие задачи проеци-
рования и врезки одних объектов в другие... например, вдумавшись в суть происходящего, 
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можно понять, что это те же опции Отсечений (будущая отдельна тема), только как бы «ди-
станционные»! Однако помним, что и здесь работает то же принципиальное ограничение – 
действие только в вертикальном (по синей оси) направлении...

 add Detail (добавить детали)
Понятно, что чем мельче ячейки сетки рельефа, тем более плавными, «нюансными» 

будут деформации сеточной поверхности, но для экономии ресурсов компьютера это име-
ет смысл делать только там, где необходимо. именно такую возможность и предоставляет 
данный инструмент за счет выборочной детализации рельефа дроблением существующих 
ячеек сетки на более мелкие треугольные ячейки.

Первый шаг – выбираем инструмент и помещаем его над рельефом – у курсора появ-
ляется символ из трех пунктирных «лучей».

второй шаг – кликаем в нужном месте на любом ребре или поверхности сетки – каж-
дый треугольник сетки делится на два, то есть появляются новые ребра и поверхности бо-
лее мелких, «вложенных» треугольников. Тут же, отпустив кнопку мышки, можем движени-
ем курсора вверх или вниз изменить уровень высоты вершины и прилегающих треугольни-
ков – величина смещения Offset динамически отображается в Measurements, и можно уста-
новить ее точное значение. Можно, кстати, заметить, что здесь инструмент работает не как 
Smoove (Присоска), а более грубо – как обычный Move (Перемещение), и с ограничением – 
только по вертикали (синей оси).

Третий шаг – кликаем еще раз для завершения опции.

несколько возможных вариантов применения опции:
– если кликнуть курсором инструмента не на поверхности или ребре, а на вершине 

треугольника, новые ребра (и треугольники) не образуются и можно только сместить вер-
шину по высоте. 

– если кликнуть на ребре или поверхности ячейки с нажатой кливишей Ctrl, происхо-
дит только образование новых треугольников и опция в этом месте сразу завершается без 
возможности смещения новой вершины.

– нажатый Shift (аналогично опции Smoove) позволяет смещать новую вершину тре-
угольника не только в вертикальном направлении (что предусмотрено по умолчанию), но и 
нормально плоскости использованного элемента сетки. 

– Можно предварительно выбрать весь рельеф или ячейки его части, а затем клик-
нуть на иконке инструмента – вся выбранная зона разобьется на удвоенное число треуголь-
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ников. Этот прием удобно использовать для подготовки нужной части рельефа для детали-
зации, а затем дорабатывать другими инструментами.

ну и последнее, что можно сказать про детализацию: – конечно, пользуемся ей раз-
умно, поскольку результатом неизбежно становится усложнение геометрии «в разы», что не-
избежно увеличивает нагрузку на компьютер со всеми вытекающими последствиями...

 Flip edge (Отразить ребро)
Этот последний инструмент группы Sandbox предназначен прежде всего для исправ-

ления нежелательных, слишком резких «переломов» рельефа. Это происходит из-за ячеек-
треугольников, в которых ребро, создающее уклон, направлено в сторону, противополож-
ную соседним. ну и конечно, инструмент может использоваться на любых доступных для этой 
опции ребрах для «нюансной» доработки уклонов. 

выбираем инструмент и начинаем перемещать его курсор над сеткой рельефа. Ре-
бра, ориентация которых может быть изменена без «разрушения» геометрии, подсветятся в 
синий цвет – кликая на них, меняем ориентацию на противоположную прежней. 

итак, резюмируем возможности, достоинства и недостатки этой группы инструментов. 
Как уже было сказано, инструменты Песочницы очевидно изначально были оптими-

зированы разработчиками на работу с рельефами местности, что выражается в ряде огра-
ничений по их применению, о которых было сказано выше. Эти «неудобства», в принципе, 
можно обойти моделированием объектов «по частям», с временными разворотами поверх-
ностей этих частей нужным образом и т.п. Однако (видимо, по причине всех этих сложно-
стей и неудобств), пользователи, которые в своих проектах не сталкиваются с такого рода 
задачами, как правило, редко пользуются инструментами этой группы, а потому и плохо зна-
ют их возможности. 

в то же время один из типичных вопросов пользователей (и типичная претензия к 
программе) – можно ли и каким образом строить в SketchUp поверхности объектов сложной 
кривизны, то есть то, что принято обозначать в 3D-моделировании термином «органика» или 
«скульптинг»? Здесь можно ответить однозначно – в силу специфики SketchUp его нельзя счи-
тать полноценным инструментом моделирования такого рода объектов. Правда, существует 
множество скриптов-плагинов, значительно расширяющих базовые функции Sandbox, и при 
умелом применении всех этих возможностей (в связке с другими инструментами и опциями) 
можно добиваться замечательных результатов. Однако все-таки рассчитывать, что SketchUp 
может заменить специализированные программы такого назначения, не приходится... 

Темы таких программ «скульптинга» (то есть скульптурной «лепки» 3D-форм) мы под-
робнее коснемся позже, в отдельном обзоре «программ-партнеров» – а с необходимостью 
их освоения продвинутый моделер, вполне вероятно, может столкнуться...
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Механизм, который будет здесь рассмотрен, в том или ином виде присутст-

вует в большинстве 3D-редакторов. Этой задачи мы уже касались в первой, ввод-
ной теме нашего курса в обзоре алгоритма твердотельного моделирования, осно-
ванного на том, что 3D-объекты рассматриваются как твердые (сплошные) тела – 
Solids. А отсюда следует, что при пересечении их объемов «общие» части внутри 
зоны пересечения можно отсечь от исходных (или объединить объекты) и полу-
чить новый объем, новую форму. 

interseCt FaCes (ОТсеЧение ПОВерхнОсТей) 
начнем с того, что в SketchUp всегда присутствовал подобный механизм... точнее с ого-

воркой, что в своеобразном решении – Intersect, которое можно, пожалуй, назвать «псев-
до» Solids. и хотя опции Intersect считаются разновидностью опций модификаций, все-таки 
имеет смысл рассмотреть их в этой отдельной теме, тем более в связи с появлением в 8-й 
версии новой «родственной» группы инструментов Solids.

Intersect создает сложные объекты за счет появления новых (дополнительных) ре-
бер и поверхностей, образующихся в местах пересечения отдельных, независимых до это-
го поверхностей. Таким образом, что особенно ценно, можно создать очень сложные фор-
мы, в том числе с криволинейными поверхностями, а это для низкополигонного SketchUp, в 
принципе, непростая задача. 

Опция включается после выбора исходных объектов из меню Edit > Intersect Faces 
(Отсечь поверхности) или, что удобней – из контекстного меню выбранного. Посмотрим,  
как это работает на простом примере (рис. ниже), взяв для тестирования два объекта – ку-
бик и граненый шарик – и «задвинув» шарик в объем кубика.

видим, что при этом оба объекта остаются независимыми друг от друга, в чем нетруд-
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но убедиться, выбрав (тройным кликом, например) один из них. Причем для этого необяза-
тельно создавать из них группы. Суть заключается в том, что у них отсутствуют общие, «погра-
ничные» ребра на пересечениях их поверхностей, точнее – такого пересечения нет вообще.

итак, для начала выбираем один (любой) из объектов, открываем контекстное 
меню и видим два доступных варианта применения опции:

Intersect With Model (Отсечение в модели) – опция работает одновременно со 
всеми поверхностями всех выбранных объектов;

Intersect Selected Only (Отсечение только выбранного) – опция работает только 
с выбранными в объектах поверхностями.

начнем со второго варианта – видим, что в этом случае опция не работает, посколь-
ку «не видит» выбранных поверхностей другого объекта... о чем и появляется информация 
в окошке:

но если выберем не один, а оба объекта вместе, то есть фактически покажем, что 
должны быть задействованы все их поверхности – и первый, и второй варианты Intersect 
сработают с таким одинаковым результатом:

Что изменилось? на пересеченных поверхностях появились новые «пограничные», 
точнее теперь – общие ребра этих двух объектов, то есть они при этом стали единым це-
лым. Чтобы убедиться в этом, сделаем тройной клик на любом из элементов – будет выбра-
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на вся смежная геометрия. При этом фактически произошла «врезка» объема шара в объем 
кубика с образованием новых ребер и поверхностей в местах их пересечений (рис. вверху). 

Попробуем теперь предварительно из объектов создать группы (или компоненты) 
и повторим опцию – видим, что новое «пограничное» ребро появилось, однако оно ока-
залось «вне» групп как новый самостоятельный набор ребер, а внутри самих групп ничего 
не изменилось. в этом легко убедиться, раздвинув объекты-группы (рис. внизу). Поэтому, 
чтобы получить полностью аналогичный результат тому, с которого начали, для завершения 
действия Intersect необходимо тут же выполнить Explode (Разрыв) групп исходных объектов. 

А что будет, если выполнять Intersect в режиме «внутреннего» редактирования одно-
го из объектов-группы? Опция подействует только на поверхности редактируемой группы, 
а второй объект-группа останется без изменений:

есть и третий вариант действия опции – Intersect With Context (Отсечение содер-
жимого), который становится доступным в режиме «внутреннего» редактирования одно-
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го из объектов-группы. Здесь можно сказать одно – вариант настолько неоднозначен и не-
внятен по смыслу и принципу применения, что можно спокойно про него забыть... тем бо-
лее что он явно «избыточный».

итак, тем или иным способом в итоге получаем новый объект с «врезкой» объема ша-
рика в объем кубика (можно сказать и наоборот). и теперь остается удалить ненужные ча-
сти (ребра и поверхности), оставив только то, ради чего и производились эти манипуляции. 
Можем в нашем примере получить три разных результата в зависимости от того, что удаляем 
(и оставляем) – из первого объекта вырезается часть второго, из второго вырезается часть 
первого, оставляем только «общую часть» первого и второго объектов:

Проверим теперь, работает ли Intersect не с двумя, а с большим количеством объ-
ектов разных типов. добавим к исходным кубику и шарику еще и цилиндр. Как видим, в 
итоге можно получить практически любые новые объекты – варианты результата ограни-
чены только нашим воображением и степенью развития пространственного мышления. 

и, резюмируя тему механизма Intersect Faces в SketchUp, отметим самое главное – во-
первых, он работает с любыми наборами любых объектов и отдельных поверхностей, а во-
вторых, – на практике вполне можно обойтись одним, основным вариантом – Intersect With 
Model. Плюс, конечно, потребуется несколько дополнительных шагов по работе с редакти-
рованием групп (компонентов) и удалению «строительного мусора».

soliD tools (инсТруМенТЫ сПлОшнЫх Тел)
Прежде всего отметим, что хотя опции Intersect Faces и Solid Tools «родственны» 

по целям и результатам, это все-таки совершенно разные механизмы по принципу дейст-
вия, условиям и порядку применения. если Intersect Faces по сути работает с любыми пе-
ресекающимися поверхностями любых объектов, то Solid Tools – с объектами в целом, 
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причем требуются объекты определенного типа – сплошные (твердотельные). 
Какие объекты в SketchUp попадают в эту категорию? Сплошным для него является 

любой 3D-объект (модель), обязательно – компонент или группа (!), который имеет еди-
ный замкнутый объем, то есть он не может иметь открытых внутрь частей (проще говоря – 
«дыр») или внутренних поверхностей и ребер под внешней оболочкой. Чтобы проверить, 
является ли выбранная группа (компонент) сплошным объектом, вызываем ее Entuty Info:

 
видим, во-первых, что обозначение Solid добавляется к указанию типа объекта, и 

во-вторых – появляется окошко Volume, в этом контексте – объем твердого тела в куби-
ческих единицах измерения, установленных в проекте. в SketchUp этот параметр доступен 
только для сплошного тела (объекта).

По умолчанию панель этих инструментов (блок кнопок) в интерфейсе отсутствует 
(выключена) – вызываем ее через меню View > Toolbars > Solid Tools. 

Поскольку инструменты работают только со сплошными объектами, при попытке 
применения к другим объектам появится запрещающее окошко с предупреждением, что 
это не твердое тело.

Прежде всего отметим, что некоторые опции работают с любым (два и более) ко-
личеством Solid-объектов, другие – только с двумя. исходя из этого, целесообразно при-
менять инструменты двумя различными способами: 

– для опций, работающих со множеством объектов (последовательность выбора 
неважна): выбираем все объекты любым способом > выбираем опцию (кликаем ее кноп-
ку) > опция срабатывает и завершается;

– для опций, работающих только с двумя объектами (важна последовательность вы-
бора): выбираем опцию (кликаем ее кнопку) > появляется курсор с номером 1, которым 
надо указать первый по очереди объект > появляется курсор с номером 2, которым надо 
указать второй по очереди объект > опция срабатывает и завершается. 

впрочем, второй способ работает и для опций, работающих со множеством объектов.

outer shell (Внешняя оболочка) – работает на двух и более вы-
бранных объектах, в результате происходит «слияние» исходных объектов в один. При этом 
перекрывающиеся части удаляются, как бы «поглощаются» общей внешней оболочкой но-
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вого объекта. Особенно наглядно происходящее при включенном режиме визуализации X-
Ray (Рентген):

 intersect (Отсечение) – работает на двух и более выбранных объектах, 
в результате получаем новый объект, созданный из перекрывающиеся частей исходных. ис-
ходные объекты удаляются. 
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union (Объединение) – в общем аналогичен Outer Shell, поскольку в 
результате также происходит «слияние» двух исходных объектов в один новый. но отличие 
все-таки есть – оно проявляется при определенной геометрии исходных объектов. Посколь-
ку наш тестовый пример тут не подходит (на нем как раз разницы и не увидим), поэтому ис-
пользуем другой:

видим, что применением Union может быть создана внутренняя «полость», а Outer 
Shell ничего, кроме общей внешней оболочки, не допускает. 

 subtract (Вычитание) – работает по принципу: из второго объекта вы-
резается перекрывающаяся часть от первого, «неиспользованная» часть которого удаля-
ется. Здесь важна последовательность выбора – что будет первым, что вторым объектом. 
Так, если первым выберем шарик, получим тот же результат, что и на показанном выше 
примере применения Intersect. если наоборот, первым выберем кубик – получим резуль-
тат, показанный ниже. 
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trim (Обрезка) – работает по принципу: из второго объекта вырезается 
(изымается) перекрывающаяся часть и присоединяется к первой, при этом оба измененных 
объекта остаются в сцене. Здесь также важна последовательность выбора – что будет пер-
вым, что вторым объектом. Так, если первым выберем шарик, получим результат, показан-
ный далее. если наоборот, первым выберем кубик – получим результат, показанный выше 
в опции Subtract. 
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split (разделение) – работает только с двумя объектами, последователь-
ность выбора не важна. в результате получаем разделение на три новые solid-группы (ком-
понента) – часть от первого объекта + часть от второго + перекрывающаяся часть пересе-
чения объектов.

Резюмируя тему механизма Solid Tools в SketchUp, можно отметить его главное отли-
чие и преимущество перед механизмом Intersect – опции «отсечения» объемов не требуют 
для получения конечного результата никаких последующих манипуляций «очистки» вручную 
от лишних, уже ненужных элементов. Кроме того, использование solid-групп (solid-компонен-
тов) наиболее точно отвечает принципу «физической достоверности» моделируемых объек-
тов. Очевидно также, что в SketchUp все, что скрыто под внешней оболочкой объектов, то 
есть не визуализируется, – на самом деле бесполезный «груз». и еще – вспомним все то, что 
уже было сказано о преимуществах максимально возможного использования групп и ком-
понентов: – если они к тому же являются solid-объектами, получаем еще больший выигрыш 
в удобстве и скорости работы.

в то же время помним и о главном ограничении Solid Tools – они работают только с 
определенным «сплошным» типом объектов, а значит, неприменимы в некоторых ситуаци-
ях, где Intersect работает без проблем. Хотя на самом деле это уже вопрос методики моде-
лирования – ничто не мешает изначально «настроиться» на работу с объемами именно как  
с твердотельными объектами...
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Один из главных критериев оценки функциональности любой программы – 
насколько свободно она умеет «общаться с внешним миром», точнее обменивать-
ся данными со сторонними программами (форматами файлов). Начнем знакомст-
во с такого рода возможностями SketchUp по одному из «каналов общения» – ис-
пользованию 2D-растровых имиджей и 2D-векторной графики в разных форма-
тах для разных целей. Здесь же рассмотрим и тему распечатки проекта SketchUp 
на принтере. 

Подробное описание свойств и особенностей 2D-форматов графических файлов не 
входит в тематику книги, отметим только принципиальную разницу этих двух типов графики 
(и, соответственно, их форматов) – векторных и растровых, в том числе по назначению, воз-
можностям и применению. 

для импорта в SketchUp используем команды меню File > Import... При этом открыва-
ется окно Проводника, в котором выбираем импортируемый файл. для векторных форма-
тов в окне Options доступны параметры импорта, для растровых – выбираем вариант при-
менения растра в модели.

для экспорта из SketchUp в эти форматы используем команды меню File > Export > 
2D-Graphic... При этом открывается окно Проводника, в котором выбираем место сохране-
ния файла, назначаем его имя и Export Type – один из поддерживаемых программой графи-
ческих форматов. в зависимости от выбора формата файла в окне настроек Options доступ-
ны различные параметры экспорта.

иМПОрТ расТрОВЫх файлОВ
SketchUp поддерживает импорт шести форматов растровых файлов, предоставляя 

более чем достаточный выбор для любых задач: .jpg, .png, .psd, .tif, .tga, .bmp. 
Коротко о критериях, по которым имеет смысл их использовать в проектах SketchUp. 

во-первых, вряд ли (кроме каких-то особых соображений) стоит применять «тяжелые» фор-
маты .psd, .tif, .tga, .bmp. во-вторых, на практике чаще всего можно вполне обойтись наибо-
лее универсальным и распространенным форматом – .jpg. Это стандартный формат записи 
цифровых фотоаппаратов (а фото будете использовать постоянно), поддерживается практи-
чески любыми программами, работающими с графикой (в том числе интернет-браузерами), 
«легкий» (что очень важно для SketchUp), с хорошо регулируемой степенью сжатия /качества 
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данных. и второй формат, на который стоит обратить внимание, – .png. «легкий», с высоким 
качеством «картинки», а самое главное – поддерживающий так называемый альфа-канал в 
изображениях. Проще говоря, имиджи в этом формате, импортированные в SketchUp, могут 
иметь прозрачные зоны изображения – позже подробней остановимся на практическом при-
менении этой уникальной возможности. ну и еще раз замечу – практическая работа с 3D не-
реальна без владения хотя бы основными опциями 2D-растровых и векторных редакторов...

 итак, меню File > Import... Открываем список «Тип файлов» и выбираем или один из 
доступных растровых форматов, или просто вариант All Supported Image Types (Все под-
держиваемые форматы имиджей). Теперь в открытой папке места хранения имиджей ви-
дим и можем выбрать нужный для импорта в сцену. Однако не торопимся, а обратим вни-
мание на правую часть окна – здесь, кроме очевидного окошка Preview (Предпросмотр), 
видим три пункта-переключателя выбора использования импортируемого файла. в зависи-
мости от выбранного варианта имидж будет по-разному помещаться в сцену и будет иметь 
различные свойства.

Use As Image (Использовать как имидж) – после нажатия кнопки Open (Открыть) 
имидж помещается в сцену без изменения размеров и пропорций в месте двойного клика 
курсором. вспомним, кстати, что обзорно с этим вариантом мы уже знакомы (тема 11 «Тек-
стурирование объектов»). 

Можно также сразу, одновременно с помещением в сцену, изменить размеры имиджа, 
показав первым кликом один угол, затем растянуть на нужную величину (пропорционально 
отмасштабировать) и завершить опцию вторым кликом в месте расположения диагонально 
противолежащего угла. если же при этом удерживать клавишу Shift, то второй клик можно 
сделать с искажением исходных пропорций.

нетрудно заметить, что в этом варианте помещение имиджа в сцену совершенно ана-
логично рисованию прямоугольника – например, точно так же может быть помещен на лю-
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бом из планов осей или «ляжет» на любую поверхность под ним. и что же мы в итоге полу-
чили в сцене? Как видим, это своеобразный объект – имидж-группа, изолированная от сце-
ны и имеющая специфические особенности. например, для такой группы недоступна воз-
можность «внутреннего» редактирования», и она не воспринимается полноценной группой 
в окне Outliner. Посмотрим в Entity Info, как понимает SketchUp такой имидж – видим инфо по 
его типу «Image», имени, габаритам в пискселах и габаритам получившегося объекта в сцене 
(то есть их можно изменить и здесь – пропорционально или произвольно):

Практическое применение в таком состоянии имидж-группы очень редко имеет смысл, 
поэтому Explode этот объект – получаем прямоугольную поверхность с как бы уже назначен-
ным текстурным материалом, полученным из этого имиджа. При этом текстура тут же появ-
ляется в списке материалов проекта, так что такой путь часто используется и просто для  
быстрой загрузки текстуры в проект, после чего из сцены его можно и удалить. 

Здесь обратим внимание на одну особенность, которую приходится иметь в виду, – 
нет никакой размерной зависимости между этими двумя состояниями – исходного имиджа и 
имиджа, помещенного в сцену. Скорее, это даже можно назвать весьма ощутимым неудоб-
ством, поскольку невозможно прогнозировать и заранее рассчитать, какие размеры (и раз-
решение) имиджа требуются, чтобы текстурный материал на его основе смотрелся в сцене 



64 Тема 20.  иМПОРТ/ЭКСПОРТ 2D-ГРАФиКи / РАСПеЧАТКА

достаточно качественно при минимальном «весе». А это было бы весьма кстати – помним 
о соображениях минимальной достаточности... Чтобы убедиться в наличии этой проблемы, 
предлагаю любознательным поэкспериментировать с каким-либо тестовым имиджем, меняя 
его исходные параметры – разрешение и габариты, и наблюдая, что происходит с ним при 
этом в сцене. еще более странно, что результат будет различен и при разной степени зум-
мирования камеры в момент импорта! и к тому же вовсе не факт, что более качественный 
(больший по разрешению и размерам) имидж будет выглядеть более качественно и в сце-
не... Остается одно – оставить решение этих проблем на последующее редактирование тек-
стуры, созданной на основе помещенного в сцену таким вариантом имиджа.

Результат, аналогичный опции File > Import, получаем и простым перетаскиванием  
имиджа из Проводника в сцену... вряд ли возможно найти какое-то другое рациональное 
применение такой группы-имиджа, поскольку возможности ее редактирования сразу после 
помещения в сцену ограничены только его перемещением, вращением и масштабированием.

Use As Texture (Использовать как текстуру) – второй вариант загрузки имиджа, 
который отличается от первого тем, что может быть помещен только (!) на уже существую-
щую любую плоскую поверхность. То есть вне поверхности, «в чистом поле» сцены имидж 
поместить нельзя. если поверхность «открыта», это можно сделать сразу, указав двумя кли-
ками диагональные углы и растягивая между ними имидж по поверхности «от ребра до ре-
бра». Можно также предварительно выбрать нужную поверхность (например, внутри груп-
пы) и далее – аналогично. и, как и в первом варианте, имидж превращается в текстурный 
материал этой поверхности и тут же появляется в списке материалов проекта. Этот вариант 
удобно использовать, когда имеем поверхность с определенными размерами и пропорция-
ми и подготовленную под нее соответствующую текстуру (имидж), которая в этом случае по-
мещается точно в границы поверхности.

вспомним, кстати (по теме текстурирования объектов), что практически тот же резуль-
тат, что и этими двумя рассмотренными способами, но часто более удобно и логично, можно 
получить при создании и редактировании материала включением в его состав текстуры че-
рез основное диалоговое окно управления материалами Materials > Edit > Use texture image 
(Использовать текстурный имидж).

Use As New Matched Photo (Использовать как новое фото для совмещения) – 
открывает новый сеанс специальной опции совмещения 3D-модели с фотоимиджем. Посколь-
ку это большая сложная тема, рассмотрим ее отдельно далее.

эКсПОрТ расТрОВЫх файлОВ
начнем с того факта, что такой 2D-имидж – «снимок, картинка» текущего состояния 

сцены, по сути – самый простой и надежный, а потому и самый типичный способ показа, пре-
зентации результатов работы с трехмерным моделированием в 3D-редакторе. и скорее все-
го, именно им прежде всего и воспользуетесь, чтобы представить свои первые проекты... По-
нятно почему – просмотреть такой имидж можно будет с гарантией на любом компьютере и 
в любой программе, которая имеет функции просмотра графики – растровые форматы уни-
версальны, поскольку «не привязаны» к конкретным программам... Этот метод связан еще с 
несколькими общими вопросами рационального решения задач степени детализации модели 
и финальной презентации 3D-проекта, но это также отдельная тема, которая будет рассмот-
рена позже, а пока разберемся с чисто техническими возможностями SketchUр в этом плане. 
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Открываем текстовое меню File > Export > 2D Graphic... SketchUр поддерживает эк-
спорт в четыре формата растровых файлов: JPG, BMP, TIFF, PNG. Параметры экспорта назна-
чаются в окне Options, например – для JPG:

Image Size (Размер имиджа)
Use View Size (Использовать размер вида) – используются размеры имиджа в окне 

моделирования по принципу «как видим в SketchUp». Фактически зависят от параметров ва-
шего монитора.

Width/Height (Ширина/Высота) – окошки ввода назначаемых вручную размеров имид-
жа в пискселах (доступны при выключенной опции Use View Size).

Rendering (Рендеринг)
Anti-Alias – переключатель включения/выключения опции сглаживания «ступенек» 

граничных пикселей разных цветов (об этой проблеме отображения ребер-линий в растре 
уже говорили ранее). 

JPEG Compressin (Степень компрессии JPEG) – специфический параметр этого фор-
мата для назначения зависимости (соотношения) размера файла (Smaller file) и его качест-
ва (Better guality).

для остальных форматов – BMP, TIFF, PNG – окно опций аналогично, только, по по-
нятной причине, отсутствует параметр JPEG Compressin.

Остается вопрос: – так какой формат «лучше» для экспорта имиджа? Здесь надо учи-
тывать следующее:

1. Фактически в любом случае экспорт происходит со стандартным «экранным» раз-
решением 72 dpi, и при этом регулируются только габаритные размеры имиджа. 

2. При прочих равных условиях файлы форматов BMP и TIF «тяжелее» JPG и PNG бо-
лее чем в 10 раз, поэтому их выбор может быть оправдан только какими-то специфически-
ми условиями. 

3. Оценивая в целом функцию экспорта в имидж, к сожалению, приходится признать, 
что качество полученной «напрямую» экспортом из SketchUр «картинки» зачастую оставляет 
желать лучшего. во-первых, настройки параметра Anti-alias графического «движка» (Window 
> Preferences > OpenGL) влияют только на представление графики в окне моделирования, 
но никак не сказываются на качестве полученной экспортом графики. во-вторых, измене-
ние этих же настроек в опциях экспорта практически не работает, то есть не влияет на каче-
ство результата... А потому окончательную «доводку» экспортированного имиджа все-таки 
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лучше перенести в графический редактор. например, можно посоветовать такой прием, ис-
пользуемый многими «скетчаперами» на практике при необходимости получения высокока-
чественного имиджа: при экспорте назначаем размер имиджа в несколько раз больше, чем 
в итоге необходимо, и при этом выключаем (!) опцию Anti-alias. Затем открываем получен-
ный имидж в графическом редакторе и уменьшаем до нужного размера с пропорциональ-
ным увеличением разрешения, при теперь уже включенном эффекте Anti-alias – получаем на-
много более качественный результат с четкими, красивыми линиями ребер.

расПеЧаТКа на ПринТере
Поскольку распечатка – также один из самых простых и доступных вариантов пред-

ставления проекта, который фактически является одним из частных случаев экспорта «кар-
тинки» из рабочего окна (понятно, в основном на бумажный носитель), рассмотрим рабо-
ту с принтером здесь. 

За распечатку отвечают три пункта меню: File > Print Setup (Настройка принтера) или,  
Print Preview... или > Print... на самом деле можно использовать любой из этих пунктов – раз-
ными шагами, но все равно будут открываться одни и те же окна и настроечные параметры.

Printer (Принтер) – выбираем нужный принтер из выпадающего списка (если в си-
стеме установлено несколько). При необходимости изменяем его «внутренние» настройки 
(через кнопку Properties). ниже видим информацию по выбранному принтеру – тип, готов-
ность к печати, порт подключения. Причем обратим внимание: – если принтер не «физиче-
ски реальный», а виртуальный (например, Adobe PDF), увидим инфо по месту сохранения 
«распечатки в файл» соответствующего формата. вот и иллюстрация «родственности» оп-
ций экспорта и распечатки...
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Tabbed Scene Print Range (Порядок печати сцен) – назначаем, какие сцены пе-
чатать: Сarrent view (Текущий вид); Scene from ... to .... (Сцены с ... по ...). 

Copies (Копии) назначаем: Number of copies (Количество экземпляров); Сollate 
(Порядок раскладки) листов при печати нескольких экземплярах.

Print Size (Размер печати) – назначаем: Fit to Page (Вписать в страницу) – размер 
экрана проекта вписывается (растягивается или сужается) в границы формата листа принте-
ра; Page Size (Размер бумаги): – ручное назначение габаритов страницы печати в окошках 
ширины и высоты; Use Model Extents (Использовать расширенный вид модели) – назначе-
ние печати сцены, как при использовании инструмента Zoom Extents (Показать все). 

Scale (Масштаб) – через числовые окошки масштабируем «на лету» – непосред-
ственно в процессе распечатки: In the printout – измерения построений на печати, In the 
SketchUp – фактические измерения построений в реальном масштабе. Меняя в этом втором 
поле значения (например, для печати в масштабе 1/10 вводим 10), видим, что в окошках Page 
Size также автоматически меняются значения, показывая, какие необходимы размеры листа 
(формат принтера) для распечатки в этом масштабе. 

 Эта опция не работает в перспективных проекциях – доступна только в параллельных 
(Camera > Parallel Projection) и для всех стандартных ортогональных видов (то есть кроме Iso).

Tiled Sheet Print Range (Раскладка на листы) – назначаем опции распечатки в 
размерах, превышающих формат листа принтера, за счет его раскладки и печати по частям 
на отдельных листах: All (Все страницы); Pages from ... to .... (Страницы с ... по ...). 

если в настройки печати вошли через File > Print Preview..., после нажатия кнопки ОК 
открывается еще одно типичное окно, в котором можно предварительно увидеть, как будет 
выглядеть распечатка (и раскладка листов). если все устраивает – запускаем печать (Print...) 
или отменяем (Cancel), возвращаясь в окно настроек.

если в настройки печати мы вошли через File > Print..., то эта возможность будет не-
доступна, и нажатие кнопки ОК сразу запустит печать на принтере.

Print Quality (Качество печати) – в этом списке доступны варианты, расположен-
ные по возрастанию качества: Draft (Эскизный), Standard (Стандартный), High Definition 
(Высокое качество), Ultrahigh Definition (Супервысокое качество), Large Format (Боль-
шой формат). Этат последний вариант оптимизирован под распечатку на широкоформат-
ных плоттерах под большой выходной формат (или печать раскладки листов опцией Tiled 
Sheet Print Range).

2D- Section Slice Only (Только 2D-разрезы) – эта опция используется для печати толь-
ко секущих линий разрезов в проекте (если они есть). 

Use High Accuracy HLR – эта опция использует технологию передачи задания принте-
ру в векторном виде. При этом максимально качественно печатается векторная информа-
ция, но не будут печататься тени, текстуры, прозрачности.

иМПОрТ ВеКТОрнЫх файлОВ
Прежде всего заметим, что эта функция доступна только в версиях SketchUp Pro (в бес-

платной SketchUp – отсутствует). второе – для этой функции доступен только один формат, 
фактически являющийся общепринятым стандартом проектной векторной графики – CAD-
редактора Autodesk AutoCAD – DWG или DXF. да, хотя это вроде бы два разных формата, на 
самом деле для SketchUp они практически равнозначны, а потому можно выбирать любой 
из них. итак, меню File > Import.... Открываем список «Тип файлов» и выбираем DWG/DXF. 

Подчеркну еще раз, что это единственная возможность переноса в SketchUp черте-
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жей из CAD-программ или, например, предварительно подготовленного исходника для 3D-
моделирования из любого векторного редактора. Поэтому при выборе «своего» векторно-
го редактора в качестве «партнера» SketchUp стоит убедиться, поддерживает ли он сохра-
нение (экспорт) в тот формат, и насколько корректно.

 
AutoCAD DWG и DXF
в окне Options видим следующие параметры настроек:

Geometry (Построения):
Merge Coplanar Faces (Объединять Coplanar-поверхности) – с понятием Coplanar мы 

уже знакомились, и понятно, что эту опцию имеет смысл держать включенной в любом слу-
чае, поскольку она предназначена для автоматического удаления лишних элементов такого 
типа. впрочем, с решением этой проблемы не все так просто, и на эту опцию рассчитывать 
полностью вряд ли стоит... 

Orient Faces Consistently (Правильно ориентировать поверхности) – опция упорядо-
чивания ориентации поверхностей (по параметру – лицевые/оборотные). естественно, так-
же имеет смысл включить и ее.

Scale (Масштаб):
Units (Единицы измерения) – этот выпадающий список используется для импорта по-

строений в корректном масштабе. если мы точно знаем, какие единицы измерений исполь-
зовались в импортируемом файле, и назначим такие же в этом окошке, то получим построе-
ние в SketchUp в том же масштабе, то есть 1:1. 

Preserve Drawing Origin (Использование начала координат рисунка) – при включен-
ной опции импортированное построение будет помещено в SketchUp с учетом точки начала 
координат в исходном файле DWG/DXF, при выключенной – левым нижним углом габарита 
построения в точку начала координат (пересечения осей) SketchUp. включать этот пункт или 
нет – ваше решение в зависимости от конкретных обстоятельств и задачи. 

вроде бы все просто... однако на самом деле это далеко не так – если импортируете 
«чужой», «незнакомый» файл DWG/DXF, то гарантировать абсолютно предсказуемый резуль-
тат не представляется возможным. дело в том, что фактически в опциях импорта/экспорта 
всегда происходит некая «конвертация» данных одной программы в другую – замена, имита-
ция отсутствующих в одной из «сторон обмена» механизмов на «родные», а то и «отсечение» 
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совершенно несовместимых, что не всегда дает корректные результаты. Эта проблема как 
раз и характерна при импорте файлов DWG/DXF, поэтому может потребоваться их предва-
рительная подготовка в самом AutoCAD перед сохранением/импортом в SketchUp. Конечно, 
если вы работаете в нем (точнее, в «связке» AutoCAD - SketchUp). Описание всех возможных 
проблем не входит в тематику этой книги, поэтому здесь приведу только несколько общих 
рекомендаций по подготовке файлов DWG/DXF для импорта:

1. для исключения проблемы совместимости версий лучше использовать файлы 
AutoCAD «не младше» версии R13.

2. надо иметь в виду, что SketchUp «отсекает» все данные по поверхностям, размер-
ным и текстовым элементам.

3. не гарантирован успешный импорт при наличии объектов, находящихся слишком да-
леко (в километрах) от центра осей сцены, а также при размере файла DWG/DXF более 15 Mб.

4. не импортируются специальные «многоразовые» объекты AutoCAD, аналогичные 
по принципу действия компонентам SketchUp, – для передачи потребуется их предваритель-
но «взорвать».

5. Очень большие проекты лучше разделять на несколько отдельных частей, посколь-
ку их импорт «целиком» может создать непомерную нагрузку на SketchUp или как минимум 
будет очень долгим и с непредсказуемым итогом. 

все остальное – уже вопросы вашей конкретной практики, конкретных программ, 
которыми пользуетесь, – собственно AutoCAD или другой, поддерживающей экспорт в этот 
формат... 

и еще пара моментов, которые надо иметь в виду. во-первых – импортированная век-
торная графика всегда «ложится» на «землю» – в план красно-зеленой осей. и во-вторых – 
формат DWG/DXF поддерживает и 2D, и 3D-данные, так что после импорта получаем резуль-
тат в том исходном виде, в котором он был создан и сохранен. дело в том, что пункт меню 
Import не разделен по принципу «для 2D-графики»/«для 3D-моделей», Таким образом, при 
импорте «чужого, незнакомого» файла можем получить или «плоский» чертеж, или трехмер-
ную модель (подробно о импорте/экспорте 3D-моделей – в следующей теме). 

в заключение задержимся на двух возможных источниках типичных затруднений поль-
зователей в работе с импортированной векторной графикой, причем независимо от конкрет-
ной программы – «экспортера».

1. Зачастую бывает рациональней предварительно подготовить 2D-исходник для 3D-
моделирования именно в векторном редакторе, особенно для контуров сложной перемен-
ной кривизны. да, SketchUp имеет достаточные «внутренние» средства 2D-рисования, одна-
ко они все-таки несоизмеримы по удобству и набору функций со специализированными под 
эти задачи векторными редакторами. или, кстати, с этими же функциями в LayOut (фактиче-
ски полноценном векторном редакторе) – поработав в нем, сразу почувствуете разницу... 

но здесь возникает та самая проблема «конвертации»... дело в том, что программные 
алгоритмы векторных редакторов построены на т.н. «кривых Безье». в них линии, кривые 
(контуры) строятся на основе опорных, контрольных точек и расположенные на них «ры-
чажках» регулировки характера плавной кривизны между этими точками. и вообще гово-
ря, такая графика – чистая математическая абстракция, а SketchUp работает с линиями (сег-
ментами псевдокривых) как «реальными» объектами. А поскольку в нем есть только прямые 
линии, импортированная плавная кривая Безье превращается в непрерывную ломаную ли-
нию (набор прямых отрезков между контрольными точками). Причем этот процесс непред-
сказуем – SketchUp может и «сам» добавить контрольные точки, в том числе ненужные про-
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межуточные на прямых участках, и проигнорировать добавление точек на криволинейных... 
Способ решения этой проблемы один – для получения в SketchUp плавной (конеч-

но, чисто зрительно) кривой в векторном редакторе перед экспортом в DWG/DXF добавля-
ем на кривую в «критичных» местах промежуточные опорные точки (они-то будут «считаны» 
с гарантией). Конечно, надо учитывать, что решение по количеству и местам добавляемых 
точек связано не только с качеством результата, но и с вопросом разумной достаточности. 
Понятно, что ненужные ребра и поверхности – это лишняя нагрузка на компьютер и, соот-
ветственно, – источник «тормозов» в работе. из этих же соображений удаляем лишние про-
межуточные точки на прямых участках контуров (и в векторном редакторе перед экспор-
том, и в SketchUp после импорта).

2. После импорта векторной графики в SketchUp возникает вторая проблема – есть 
замкнутый контур, но Поверхности, автоматически образуемой в этом случае в SketchUp, по-
чему-то нет! дело в том, что такая «внешняя» графика сразу после импорта не воспринима-
ется SketchUp как «родная». Поэтому это приходится «подсказывать» – двумя кликами ин-
струмента Line в любом месте контура проводим короткий отрезок – тут же происходит сра-
батывание механизма «узнавания» и появляется Поверхность. вроде бы все просто... одна-
ко так – только для простых случаев. А вот если имеем «кружево» вложенных друг в дру-
га сложных контуров, «общелкивание» каждого из них может превратиться в весьма трудо-
емкое занятие. и еще – если же все-таки образование поверхности не произошло, значит, 
что-то неладно в контуре – скорее всего, есть разрывы. «Штатных» опций для решения этих 
проблем в SketchUp, к сожалению, нет, но можно с успехом использовать специальные пла-
гины, о которых – позже... 

эКсПОрТ ВеКТОрнЫх файлОВ
Как и для импорта, эта функция доступна только в версиях SketchUp Pro. Поддержи-

вается экспорт векторной графики в форматы PDF, EPS, DWG/DXF. А поскольку эти форма-
ты используются, как правило, в программах проектной, иллюстративной графики и верстки 
для полиграфии, они «привязаны» к форматам страниц, листов с учетом удобства распечат-
ки – традиционного способа представления разработки на бумажных носителях.

экспорт в pDF и eps
Сразу заметим некоторые особенности и ограничения SketchUp при экспорте в эти 

форматы:
1. используется текущий взгляд на модель – вид сцены на экране в момент экспорта. 

Поэтому части модели, закрытые в текущем ракурсе камеры полностью или частично други-
ми построениями, а также скрытые (Hidden) не будут экспортироваться. 

2. не экспортируются растровые текстуры, тени, эффект сглаживания поверхностей, 
стилевые настройки и прозрачности – то есть переносятся только линии (ребра) и «сплош-
ные» цвета материалов поверхностей, в том числе растровые текстуры заменяются сплош-
ным цветом их усредненного цветового тона. 

3. некоторые шрифты в текстовых и размерных элементах модели могут экспортиро-
ваться некорректно. Понятно, это актуально прежде всего для текстов, написанных по-русски. 

Окна Options для этих двух «родственных» форматов совершенно одинаковы и со-
держат пять панелей со следующими параметрами настроек:
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Drawing Size (Размер модели)
Full Scale (1:1)(Полный масштаб 1:1) – устанавливает выходной масштаб в реаль-

ных размерах модели в SketchUp. При этом может появиться предупреждение, что для это-
го формата установлено ограничение размера в 100 дюймов (~ 254 см), а размеры модели 
превышают его. 

далее, если все равно подтвердить выполнение опции экспорта, получим файл PDF с 
максимальным размером страницы 2540 мм по большей стороне и вторым измерением – в за-
висимости от пропорций рабочего окна программы (а фактически экрана вашего монитора). 

Зададимся вопросом: – а каким будет в PDF размер страницы, если не будем уста-
навливать никакие свои настройки, а просто нажмем ОК, подтверждая экспорт в виде «как 
есть»? если ответить коротко – непредсказуемым! Причем он будет меняться по неопреде-
ленной логике в зависимости от степени зуммирования вида сцены на экране... 

Size (Размеры) – окошки ввода назначаемых вручную размеров страницы Width/Height 
(Ширина/Высота) в выбранных единицах измерения. То есть именно эта опция позволяет по-
лучить нужный, предсказуемый размер страницы. При этом, например, если назначаем фор-
мат А4 (горизонтальный) – ширину 297мм, автоматически, с сохранением пропорций «окна» 
сцены, установится и размер листа по высоте – опять же в зависимости от пропорций рабо-
чего окна программы (экрана монитора). 

Scale (Масштаб) – назначает масштабирование при экспорте с двумя окошками вво-
да данных. Обратим внимание: – эта опция не работает (неактивна) в перспективных проек-
циях, а доступна только в параллельных (при включенном Camera > Parallel Projection) и для 
любого (кроме Iso) из стандартных видов – Front, Back, Left, Right, Bottom.
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In Hidden-Line Output (Вывод в линиях) – размеры после масштабирования.
In SketchUp (в SketchUp) – фактические размеры модели. 
Разберемся, как это практически работает. Поставив, например, в In Hidden-Line  

Output – «1», а в In SketchUp – «100», фактически получаем коэффициент масштабирования 
1:100. При этом видим, что меняются и значения в окошках Size, показывая, какие размеры 
листа в PDF потребуются для распечатки в таком масштабе. и наоборот, изменения в Size 
меняют и значения в In SketchUp.

Здесь, пожалуй, можно остановиться и резюмировать: – опции создания «управляе-
мого» PDF непосредственно из SketchUp весьма громоздки и невразумительны... А потому 
лучше просто сохранять PDF по принципу «как есть», а все связанные с масштабировани-
ем, размерами листа и т.п. опции перенести в сторонние редакторы, которые справляются 
с этим успешней. например, – в LayOut, для которого, кстати, PDF – основной «выходной» 
формат и в котором все эти задачи решаются несоизмеримо удобней и качественней. При-
чем опасаться потери качества не стоит, поскольку для векторной графики такой пробле-
мы просто не существует...

Profile Lines (Профильные линии)
Show Profiles (Показать профили) – экспортируется этот стиль линий шириной, за-

данной в диалоговом окне Styles (Стили), если они есть в модели. При выключенной опции 
все линии экспортируются как стандартные, одинаковой толщиной (независимо от того, как 
они видны на экране). 

Match Screen Display (Auto Width) (Сопоставление экранному показу (автотошири-
на)) – автоматически устанавливается ширина профильных линий по принципу «как видно в 
SketchUp». Правее находятся окошки ввода назначаемых вручную ширины профильных ли-
ний и единиц измерения. 

Опция доступна только при включенной опции Show profiles и выключенной опции 
Match Screen Display (Auto Width). 

Section Lines (Линии разреза)
настройки, аналогичные предыдущей опции, только для линий разрезов. 
Specify Section Line Width (Назначенная ширина линий разрезов) – экспортируется та-

кой стиль линий шириной, заданной в диалоговом окне Styles (Стили), если они есть в модели.
Match Screen Display (Auto Width) (Сопоставление экранному показу (автотолщи-

на)) – автоматически устанавливается ширина линий разрезов по принципу «как видно в 
SketchUp». Правее находятся окошки ввода назначаемых вручную ширины этих линий и еди-
ниц измерения. 

Опция доступна только при включенной опции Specify Section Line Width и выклю-
ченной опции Match Screen Display (Auto Width). 

Extension Lines (Удлинения линий)
Extend Edges (Расширения ребер) – экспортируется такой стиль линий шириной, за-

данной в диалоговом окне Styles (Стили), если они есть в модели.
Match Screen Display (Auto Width) (Сопоставление экранному показу (автошири-

на)) – автоматически устанавливается ширина удлиненных линий по принципу «как видно в 
SketchUp». Правее находятся окошки ввода назначаемых вручную ширины этих линий и еди-
ниц измерения. Опция доступна только при включенной опции Extend Edges и выключен-
ной опции Match Screen Display (Auto Width). 

Always Prompt for Hidden Line Options (Всегда открывать окно опций) – вкл./
выкл. опции автоматического открытия окна настроек при экспорте PDF или EPS. 
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Map Windows fonts to PDF base fonts (Конвертация фонтов Windows в базо-
вые PDF-фонты) – вкл./выкл. автоматического применения опции соответствия использо-
ванных Windows-шрифтов базовым фонтам PDF. естественно, включение опции имеет смысл, 
если в модели использованы текстовые элементы.

Defaults (По умолчанию) – возвращает все настройки опций экспорта к состоя-
нию по умолчанию.

экспорт в autoCaD DWG и DxF
Особенности и ограничения SketchUp при экспорте в эти форматы аналогичны рас-

смотренным до этого PDF и EPS (см. выше), но они еще более «жесткие» – исключается и пе-
ренос поверхностей (а значит, и их материалов), то есть экспортируются только линии (ре-
бра) построений. Об этом говорит и заголовок самого диалогового окна – DWG/DXF Hidden 
Line Ortions, то есть опция работает с линиями (ребрами), которые все видим в таком ре-
жиме отображения. То есть со всеми ребрами построений без учета «внутренней» опции их 
скрытия при визуальном сглаживании криволинейных поверхностей.

в окне Options видим пять панелей со следующими параметрами настроек:
Drawing Scale & Size (Масштаб и Размер модели)
Full Scale (1:1)(Полный масштаб) – по умолчанию устанавливает выходной масштаб 

в реальных размерах модели в SketchUp. 
ниже доступно масштабирование при экспорте с двумя окошками ввода данных. Оп-

ция не работает (неактивна) в перспективных проекциях, а доступна только в параллель-
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ных (при включенном Camera > Parallel Projection) и для любого (кроме Iso) из стандартных  
видов – Front, Back, Left, Right, Bottom.

In Drawing (В чертеже) – размеры после масштабирования.
In Model (В модели) – фактические размеры модели в реальном масштабе. Меняя в 

In Drawing значения (например, для масштаба 1/10 вводим 10), видим, что в первом окошке 
также автоматически меняются значения, показывая, какие будут получены размеры моде-
ли в этом масштабе в экспортируемом файле.

Width/Height (Ширина/Высота) – окошки ввода назначаемых вручную размера стра-
ницы и единиц измерения для экспортируемого файла. Опция доступна для всех проекций, 
в том числе перспективных. Здесь также эти два измерения связаны между собой пропор-
циями окна моделирования (экрана монитора).

Поставив, например, в In Drawing – «1», а в In Model – «100», фактически получаем ко-
эффициент масштабирования 1:100. При этом видим, что меняются и значения в окошках 
Width/Height, показывая, какие размеры листа потребуются для распечатки в таком масшта-
бе. и наоборот, изменения в Width/Height меняют и значения в In SketchUp и In Model.

AutoCAD Version (Версия AutoCAD)
Здесь производится назначение версии программы, в которой будет сохранен эк-

спортируемый файл. если не работаете именно с AutoCAD (известной версии), а с каким-ли-
бо векторным редактором, имеет смысл проверить, какую версию наиболее корректно он 
поддерживает. А в общем случае можно просто рекомендовать экспортировать в одну из 
самых «ранних» версий или из середины списка... 

Profile Lines (Профильные линии)
None (Нет) – экспортируется этот стиль линий шириной, заданной в диалоговом окне 

Styles (Стили), если они есть в модели. При выключенной опции все линии экспортируют-
ся как стандартные, одинаковой толщиной (независимо от того, как они видны на экране). 

Polylines with width (Полилинии с толщиной) – профильные линии экспортируются 
как специфический вид линий AutoCAD – Polylines.

Wide line entities (Широкие линии) – профильные линии экспортируются как специ-
фический вид линий AutoCAD 2000 или более поздних версий – Wide line.

Separate on a layer (Раздельно по слоям) – профильные линии экспортируются раз-
дельно в их собственных слоях для возможности последующего изменения в CAD-редакто-
рах или векторных графических редакторах.

Width (Ширина) – окошко ввода вручную ширины профильных линий (доступна при 
выключенной следующей опции – Automatic). 

Automatic (Автоматически) – автоматически устанавливается ширина профильных 
линий по принципу «как видно в SketchUp». 

Section Lines (Линии разреза)
настройки, аналогичные предыдущей опции, только для линий разрезов. 

Extension Lines (Удлинения линий)
Show Extensions (Показывать удлинения) – экспортируется такой стиль линий шири-

ной, заданной в диалоговом окне Styles (Стили), если они есть в модели.
Length (Длина) – окошко ввода вручную величины удлинений за точки пересечения 
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ребер (доступна при выключенной следующей опции – Automatic). 
Automatic (Автоматически) – автоматически устанавливается величина удлинений по 

принципу «как видно в SketchUp». 

Always Prompt for Hidden Line Options (Всегда открывать окно опций) 
Переключатель автоматического открытия окна настроек при экспорте DWG и DXF.
 
экспорт sections (разрезов) в DWG и DxF
Экспорт разрезов Sections в векторный формат выделен в программе особо, посколь-

ку имеет свою специфику. в то же время здесь действуют все ранее рассмотренные особен-
ности и ограничения SketchUp в части форматов DWG/DXF. 

итак, используем отдельный пункт меню File > Export > Section Slice.... Открывается 
окно Проводника, в котором выбираем место сохранения файла, назначаем ему имя и вы-
бираем один из форматов (практически не важно, какой – DWG или DXF). далее в окне на-
строек Options назначаем параметры экспорта.

Можно видеть, что здесь повторяются параметры предыдущего варианта экспорта 
в DWG или DXF (см. выше), но при этом отсутствуют панели Profile Lines (Профильные ли-
нии) и Extension Lines (Удлинения линий) и добавляются параметры управления проекци-
ями разрезов:

True Section Orthographic (Истинный ортогональный разрез) 
Опция экспорта разреза в ортогональной проекции с истинными размерами.
Screen Projection WYSIWG (Экранная проекция «как видим»)
Опция экспорта разреза по принципу «как видно на экране», включая перспектив-

ные искажения.

piranesi epix
Это формат файлов программы рендеринга в стиле «ручной» архитектурной и иллюст-

ративной графики – Informatix Piranesi (http://www.piranesi.co.uk/). Программа очень интере-
сная, можно смело сказать – единственная в своем роде, поскольку имеет уникальные меха-
низмы так называемого «нефотореалистичного рендеринга» на основе совместного исполь-
зования возможностей 3D-графики и 2D-графических редакторов... весьма сложная для ос-
воения, а потому представляющая интерес только для специфических задач. Тем не менее 
разработчики SketchUp сочли нужным включить EPIX в состав поддерживаемых форматов, 
поэтому хотя бы запомним, что справочная информация по экспорту в EPIX находится здесь.

в окне Options видим две панели со следующими параметрами настроек:
Image Size (Размер имиджа)
Use View Size (Использовать размер вида) – автоматически используются размеры 

имиджа в окне моделирования по принципу «как видно в SketchUp». 
Width/Height (Ширина/Высота) – окошки ввода назначаемых вручную размера ими-

джа в пискселях (доступно при выключенной опции Use View Size).
ниже видим прогнозируемый размер выходного файла в килобайтах.

EPIX
в этой панели назначаются специфические параметры экспорта для формата Epix.
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Export Edges (Экспортировать ребра) – передача установленного стиля рендерин-
га ребер SketchUр в сцене. 

Export Textures (Экспортировать текстуры) – передача материалов-текстур поверх-
ностей. При этом должен быть включен стиль рендеринга Shaded with Textures (Затенен-
ный с текстурами).

Export Ground Plane (Экспортировать «землю») – передача данных о положении плос-
кости «земли» в сцене, даже если в SketchUр она явно не обозначена. 

Один из типичных примеров «подачи» проекта в Piranesi:
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Тема 21. СОвМещение С ФОТО 
В этой теме рассмотрим группу опций и инструментов, которые решают две 

задачи: первую – на основе фотографий реального объекта строится его трехмер-
ная модель, и вторую – готовая 3D-модель SketchUp достоверно «устанавливает-
ся» в фотографию реального окружения, ландшафта и т. п.

Отметим сразу, что такой механизм SketchUp не является чем-то уникальным – мно-
гие  3D-редакторы (особенно архитектурной направленности) имеют подобные функции, а 
также есть специализированные, именно под эти задачи программы. все они работают при-
мерно по одному принципу: с фото «считывается» характер перспективы изображения, фак-
тически как бы устанавливается та же камера, которой был сделан снимок. или по-другому 
– «считываются» данные по координатным осям в фото, как если бы это была трехмерная 
сцена. А далее трехмерный объект (модель) помещается в такую сцену по установленным 
«правилам игры» – в этом, собственно, и состоит Matching (Согласование, совмещение...) 
этих двух составляющих «из разных миров». 

ВЫбОр, ПОдгОТОВКа фОТО
Рассмотрим работу с Match Photo на практическом примере, однако начнем с техни-

ческих требований к фото – это и является первым этапом работы, поскольку для успешного 
применения опций требуется обязательное соблюдение перечисленных ниже ограничений 
и требований к исходной цифровой фотографии:

1. используем только качественные фото – с хорошим разрешением (достаточных 
размеров), с четким, ясным изображением. 

2. используем фото, на которых легко «читается» характер перспективы. идеальный 
вариант – фото с объектами простой геометрии, в которых преобладают плоские поверхно-
сти (например, «коробчатые» фасады зданий), повернутые углом к объективу (взгляду) при-
мерно под 45 градусов. и практически неприменимы сюжеты, в которых точка схода «ухо-
дит в бесконечность»...

3. над фото, после получения его с цифровой камеры, нельзя производить никаких 
операций редактирования, связанных с искажением пропорций (обрезку, кадрирование, де-
формации) и т. п. По этим же соображениям неприменимы фото, полученные специализиро-
ванными камерами и из такого рода программ обработки, – например, панорамные снимки. 

4. Фото, как правило, имеют неизбежные дефекты – искажения, при которых вместо 
прямых вертикальных линий «в натуре» видим «дугообразные». Это неприятное явление в 
фотографии называют «бочковатость», и связано оно с особенностями оптики камер, что 
особенно часто проявляется в так называемых «широкоугольных» объективах. допускает-
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ся исправление «бочковатости» специальными опциями графических редакторов (в разум-
ных, конечно, пределах).

загрузКа фОТО, насТрОйКа КаМерЫ
Начало работы – собственно включение опции  и загрузка фото воз-

можны двумя способами:
1. Через меню File > Import указываем нужный фотоимидж, в варианте применения 

включаем пункт Use as New Matched Photo (Использовать как новое фото для совмеще-
ния). вспомним, что мы ранее упоминали этот вариант в теме импорта/экспорта 2D-графики. 

2. Через меню Camera > Match New Photo....
Открывается (создается) новая сцена с именем использованного фото и «заголов-

ком» в левом верхнем углу сцены – Match Photo, а также появляется диалоговое окно опции. 

видим также элементы управления – по умолчанию они появляются примерно в  
центре фото:

1 – нулевая точка (желтый квадратик) начала координат (Axis Origin) синей, красной 
и зеленой осей; 

2 – линия горизонта желтого цвета; 
3 – точки схода перспективы на пересечении линии горизонта с красной (красный  

квадратик) и зеленой осями (зеленый квадратик); 
4, 5 – перспективные направляющие для красных и зеленых осей. 
видим также красную и синюю «сетки» (в этом примере) – это вспомогательная раз-
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метка, варианты отображения которой настраиваются в разделе Grid (Сетка) диалогового 
окна. Можете попробовать разные сочетания этих настроек, однако надо сказать, что ника-
кой особой пользы от этой разметки нет, так что можно просто включить пункт Auto вмес-
то On – показ сетки будет отключен. Заметим только, что пунктом Spacing можно менять раз-
мер ячеек сетки. 

Следующий шаг – установка осей в соответствии с фото. 
начинаем с точки начала осей (1) – перетягиваем ее в какую-либо ближнюю харак-

терную точку объекта. Здесь за исходную точку принят ближний нижний угол фасада – по-
чему, будет ясно дальше.

далее выставляем две перспективные направляющие для зеленой оси (4) и две – для 
красной (5). для этого просто перетягиваем их (за любую точку на пунктирной линии) в нуж-
ное место и выравниваем точно за конечные «захваты» – квадратики соответствующих цве-
тов. Здесь использованы характерные горизонтальные линии «левого» и «правого» фасадов. 
Заметим, что при перемещении направляющих перемещается по высоте и линия горизон-
та (2), а также может отклоняться от вертикали и синяя ось. в итоге, если все сделано пра-
вильно (и на «правильном» фото), получаем корректный результат: соответствие положения 
осей, линии горизонта (и точек схода на ней) и строго вертикальное положение синей оси... 
и завершаем опцию (сохраняем настроенную сцену) кликом за пределами фото. Завершить 
опцию можно также пунктом Done в диалоговом окне. на этом этапе очень важны точность 
и аккуратность – не торопимся, добиваясь оптимального результата. 

Обращаем внимание, что в этом режиме доступны только некоторые инструменты ка-
меры: на панели инструментов – кнопки Zoom Exentns и Previous, Next, а также зуммирова-
ния и панорамирования средней кнопкой мышки. и это понятно, ведь на самом деле в сеан-
се Match Photo мы работаем только с камерой и в 2D-пространстве фотографии. если сразу 
после завершения настроек попробовать повернуть камеру (Orbit), – все исчезнет! Это тоже 
объяснимо – мы вышли в стандарное трехмерное пространство моделирования SketchUp, 
в котором пока пусто (ничего не построено). ну а для возврата в сеанс Match Photo, факти-
чески в его сохраненную сцену – просто кликаем на панели-заголовке. После этого оси ра-
бочего пространства сами плавно переместятся в настроенное (сохраненное) предыдущи-
ми опциями Match Photo положение.
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ПОсТрОение 3D-МОдели ПО фОТО
После завершения предыдущего этапа в сцене Match Photo снова становятся доступ-

ны все инструменты, однако здесь для начального рисования можем использовать только 
Line (помним, что фактически работаем в 2D-!), придерживаясь следующих правил: 

– для точности начинаем рисование от точки начала координат Axis Origin; 
– построив первую поверхность (на переднем плане), вторую строим, начиная от нее, 

то есть используя одно из уже нарисованных ребер, и далее – последовательно, пошагово 
от построенных – к следующим поверхностям, постепенно «наращивая» геометрию объекта. 

видим, что поверхности создаются как полупрозрачные прямоугольники – если хотим 
отрегулировать настройки отображения модель/фото, открываем диалоговое окно Styles > 
Edit и делаем это в нижней панели Match Photo движками слайдеров Foreground Photo и 
Background Photo. 

А полностью отключив оба этих пункта, увидим только построенные поверхности. То 
же произойдет, если повернуть (Orbit) камеру – вышли в стандартное трехмерное простран-
ство моделирования SketchUp, в котором теперь появились новые построения. Можно так-
же для удобства работы временно включать/выключать видимость построений (модели) пе-
реключателем Model в диалоговом окне.

Такими же шагами продолжаем работу – все, что возможно, строим линиями в сеан-
се Match Photo или, выходя в «обычное» рабочее пространство, – другими инструментами, 
возвращаемся в Match Photo и так далее... 

Заметим, что и на этом этапе можем «подправить» настройку осей уже известными оп-
циями и что при этом будет меняться и характер уже готовых построений.

в этом примере остановимся на двух фасадах («левом» и «правом»), но, предполо-
жим, построили все, что возможно, с этой фотоподосновы (в этом сеансе, сцене) – и что же 
дальше? А дальше, если есть фото этого же здания с другого ракурса, другой стороны (луч-
ше со второго, противоположного угла), создаем (New Matched Photo) и настраиваем теми 
же шагами на его основе вторую сцену и «достраиваем» недоступные в первой сцене эле-
менты модели. 

При этом может потребоваться применение еще нескольких вспомогательных опций – 
они становятся доступны через контекстное меню после включения в диалоговом окне кноп-
ки (символ «шестеренки») – Edit Matched Photo (уже знакомые опции не упомянуты):

Start Over – перезапуск (возврат к начальному состоянию редактирования); 
Cancel Match – отмена произведенных действий, выход из редактирования;
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Zoom Matched Photo – зуммирование фото на все окно рисования;
Zoom Vanishing Points – зуммирование до показа точек схода в окне рисования;
Rotate 90 Left/Rotate 90 Right – разворот красной и зеленой осей на 90 градусов вле-

во/вправо. Применяется, как правило, при совмещении уже построенной части модели с од-
ного фото (сцены), с построением на основе другого фото (сцены). 

Кроме того, предусмотрена возможность пропорционального масштабирования по-
строения – помещаем курсор на любую из основных осей (красную, зеленую или синюю) – 
появляется двунаправленная черная стрелка, перемещением которой вдоль оси получаем 
нужный результат (в большую или меньшую сторону). 

ПрОеЦирОВание фОТО (ТеКсТурЫ) на МОдель
Опцией контекстного меню в сцене Project Photo (то же – из диалогового окна Project 

Textures from Photo, то же – из контекстного меню панели-заголовка сцены) текстура про-
ецируется на поверхности построенной модели, и получаем результат, аналогичный другим, 
ранее рассмотренным способам назначения текстурирования поверхностей. 

Собственно, в основном ради этого эффектного итога и предусмотрен Match Photo в 
части построения модели по фото... однако приходится завершить рассмотрение критиче-
скими выводами. Безусловно, опция интересная, ее стоит обязательно опробовать, но... есть 
несколько проблем, которые не позволяют считать Match Photo в этом качестве серьезным 
инструментом построения и текстурирования. Первая проблема – практически нереально 
получить «идеальное» фото без неизбежных геометрических искажений объективом, а зна-
чит – и построить по ним «идеальную» модель. Причем если по одному фото (одной сцене 
Match Photo) какую-то часть построений (а значит, и текстур) еще можно получить, то кор-
ректно «состыковаться» со вторым фото этого же объекта практически нереально. вторая 
проблема – обойтись только «карандашом» в построениях так же практически невозмож-
но, а значит, придется переходить от Match Photo к проекциям SketchUp, достраивать что-то 
полным набором инструментов, опять возвращаться в Match Photo, что-то корректировать... 
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и так неоднократно. Очевидно, что такую методику текстурирования трудно назвать рацио-
нальной – получаем очень трудоемкий и к тому же почти наверняка «половинчатый» резуль-
тат, который все равно придется дорабатывать другими способами. 

разМещение МОдели на «фОТОсЦене»
А вот этот, второй вариант применения опций совмещения с фото имеет безусловную 

практическую ценность. Типичный пример – размещение модели проектируемого здания на 
реально существующем ландшафте (в окружении). 

Здесь начало работы совершенно аналогично первому варианту – в новый файл за-
гружаем фото и производим уже рассмотренные настройки камеры (осей сцены). Заметим, 
кстати, что здесь жесткие требования к фото, обязательные для первого варианта приме-
нения, практически снимаются (не имеют особого значения) – в этом одно из объяснений 
удобной, быстрой и качественной работы механизма совмещения почти во всех случаях. 

далее в подготовленную сцену требуется загрузить готовую модель (файл SketchUp), 
которая при установке автоматически развернется по осям сцены Match Photo. Это можно 
сделать несколькими способами:

1. Открыть еще один файл с моделью и через буфер обмена (Edit > Copy/Edit > Paste)  
поместить ее (указав место) в сцене Match Photo.

2. импортировать модель: File > Import – и поместить ее (указав место) в сцене Match 
Photo (подробно импорт 3D-моделей будет рассмотрен далее в отдельной теме). или, что ана-
логично, – просто «перетащить» файл модели из Проводника в сцену. 

и еще – можно получить тот же итог, не создавая предварительно новый, отдельный 
файл со сценой Match Photo, – загружаем и настраиваем опции фото непосредственно в са-
мом файле модели теми же, что и рассмотрены выше, шагам. Можно также для удобства ра-
боты с настройками осей временно включать/выключать видимость модели переключате-
лем Model в диалоговом окне.

Как видим, помещенная модель (здесь для наглядности «поставлено» несколько эк-
земпляров одной и той же) вполне достоверно «вписывается в пейзаж», точнее в «простран-
ство» на фото. При этом по умолчанию модель отображается в том же виде, что и в первом 
варианте, – нам как бы предлагают продолжить работу опцией текстурирования (рис. выше 
слева)... А поскольку здесь этого не требуется, открываем окно Styles > Edit и выключаем 
показ такого отображения, «сняв галочку» у пункта Foreground Photo (рис. выше справа).

Кроме того, скорее всего, придется проделать еще несколько настроечных манипуляций:
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1. визуально достоверно отмасштабировать модель соразмерно изображению на 
фото, поскольку между этими двумя составляющими сцены не существует (и не может быть) 
никакой размерной зависимости. Это можно сделать и обычным масштабированием объек-
тов (Scale), и через опции масштабирования Match Photo (вспомним черные двунаправлен-
ные стрелки на осях).

2. наверняка «режет глаз» несоответствие реалистичности фото и условного графич-
ного рендеринга SketchUp – «сглаживаем» его, назначив стиль визуализации Shaded With 
Textures и отключив Edges и Profiles. 

3. если использовали настройки камеры из первого варианта, обнаруживаем, что от-
сутствуют падающие тени на «земле». Чем это объяснить? дело в том, что там «земля» ока-
залась (по положению нулевой точки осей) выше линии горизонта, а падающие тени всегда 
«ложатся» на план красно-зеленых осей. Решаем проблему просто – входим в редактирова-
ние Match Photo, опускаем Origin ниже линии горизонта и выставляем в этот уровень низ мо-
дели – тени появились! Заметим, что перемещение Origin никак не влияет на настройки пер-
спективных направляющих (то есть камеры)! Конечно, и тени SketchUp далеки от реалистич-
ности, но, подобрав для них подходящий цветовой тон Background или Ground в диалоговом 
окне Styles > Edit, можно добиться вполне приемлемого результата. 

Можно предложить еще одно интересное решение проблемы «реалистичности» – эк-
спортировать отдельными имиджами содержимое сцены Match Photo – сначала только фото 
(скрыв модель), затем только модель (выключив показ Background Photo). А в итоге «собрать» 
из них финальный имидж с необходимой доработкой в графическом редакторе.
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Возможность «обмениваться» 3D-моделями с другими редакторами – один 

из основных критериев «профессиональности» любой 3D-программы. И если 
любитель под «домашние» нужды вполне может обойтись только внутренни-
ми возможностями SketchUp (плюс ресурсами моделей на «складе» Google 3D  
Warehouse), то для продвинутого пользователя, профессионального архитек-
тора, дизайнера и т. п. возможность импорта/экспорта разнообразных 3D-дан-
ных принципиально важна и необходима. 

иМПОрТ 3D-МОделей
еще раз напомню – рассматриваемые возможности работы с «внешними» форма-

тами 3D-данных доступны только в Pro-версии. 
импорт 3D-форматов не выделен отдельно – производится через тот же пункт 

меню, что и ранее рассмотренный импорт 2D-графики, – File > Import.... При этом от-
крывается окно Проводника, в котором выбираем формат и собственно импортируемый 
файл. Пять типов поддерживаемых 3D-форматов приведены в верхней части списка, на-
чиная с собственного формата файлов SketchUp – .skp.

Мы уже встречались с опциями помещения «внешнего» файла .skp в текущий про-
ект разными способами – простым перетягиванием из Проводника, загрузкой компонен-
тов из библиотек и т. п., что по сути и является импортом «.skp – в .skp». Эта простая оп-
ция никаких дополнительных действий не требует, за исключением возможного появле-
ния окошка с информацией (требуется подтверждение) о несовпадении версий текуще-
го и загружаемого файлов. 

Сразу заметим одну важную особенность SketchUp, о которой надо помнить как об 
источнике возможных проблем при импорте 3D-моделей (независимо от формата файла) 
и в целом ряде опций их редактирования (к этому еще вернемся позже), – автоматически 
действует «нижний предел распознавания» поверхностей – площадь в 0,001 квадратного 
дюйма! в чем это проявляется? Упрощенно – в «дырах» вместо поверхностей, «закрыть» 
которые будет весьма непросто. например, такой неприятный результат будет гаранти-
рован, если импортируется в масштабе 1:1 очень мелкая деталь (да еще и со сложными 
криволинейными поверхностями), в которой длина ребер поверхностей может состав-
лять десятые доли миллиметра. Позже, в завершающей теме курса, мы вернемся к под-
робному разбору ситуаций, которые приводят к возникновению этой проблемы, а пока 
запомним способ решения: – назначаем заведомо избыточно большие единицы измере-
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ния (например, метры) – получаем заведомо увеличенную модель, чем избегаем «потерь» 
поверхностей. ну а изменить размеры модели на «правильные, реальные» легко сможем 
масштабированием и после импорта. 

DWG/DxF
Опции (окно настроек) импорта этих форматов AutoCAD совершенно аналогичны 

и для 2D-, и для 3D-файлов (см. предыдущую тему) – только выбор единиц измерения и 
поведения поверхностей. Это и понятно – как уже было сказано, формат DWG/DXF уни-
версален, поддерживает и 2D-, и 3D-данные, так что после импорта получаем результат 
в том исходном виде, в котором он был создан и сохранен – или «плоский» чертеж, или 
трехмерную модель. надо иметь в виду, что не исключены и определенные ошибки им-
порта (особенно из «чужих» файлов) – например, SketchUp не поддерживает часть спе-
цифических для AutoCAD данных, которые при импорте будут просто проигнорированы. 
Поэтому для их совершенно корректной передачи может потребоваться определенная 
подготовительная работа в самом AutoCAD... но это уже вопросы владения другой про-
граммой, не входящие в тематику книги. 

3Ds 
в окне Options видим две панели с уже знакомыми по импорту DWG/DXF (см. пре-

дыдущую тему импорта векторной графики) параметрами настроек – Geometry (Геомет-
рия) и Scale (Масштаб):

Этот формат «патриарха» программ трехмерного моделирования и анимации 
Autodesk 3DS Max (ранее – 3D Studio MAX), хотя и во многом устаревший, является са-
мым распространенным. в частности, это объясняется его возможностями наиболее пол-
ной и точной передачи информации о 3D-моделях, несоизмеримой, например, с импор-
том через CAD-форматы DWG/DXF. Получается, что это главный и единственный дейст-
вительно универсальный вариант импорта в SketchU – практически все 3D-редакторы его 
поддерживают, а значит, через .3ds могут полноценно передаваться модели любого из 
них. Конечно, корректность импорта во многом зависит и от геометрии исходной модели, 
и от установленных при ее сохранении в .3ds параметрах. Описать все возможные про-
блемы модели, появившейся после такого импорта в SketchUp, практически невозмож-
но, но о некоторых типичных стоит сказать. 



86 Тема 22. иМПОРТ/ЭКСПОРТ 3D-МОделей

не раз упоминалось, что SketchUp – низкополигонный (Low-Poly) моделер, а мо-
дель, «пришедшая» из других редакторов, может быть построена из сотен тысяч, а то 
и миллионов полигонов... что для SketchUp может оказаться просто «непосильной но-
шей». Кроме того, такие высокодетализированные (High-Poly) модели неизбежно содер-
жат слишком «мелкие» полигоны... о проблеме «нижнего порога» размера поверхности 
в SketchUp уже было сказано выше.

вторая, практически неизбежная проблема – импортировав файл .3ds в SketchUp, 
почти всегда видим множество бесполезных, не связанных с геометрией линий-ребер, 
то есть того самого «строительного мусора», от которого надо избавляться. вручную де-
лать это весьма трудоемко, поэтому имеет смысл пользоваться специальными плагина-
ми «очистки» (о них далее).

и последнее по теме импорта/экспорта 3D-моделей – можно настоятельно реко-
мендовать обратить внимание на программу Deep Exploration CAD Edition (http://www.
righthemisphere.com/products/dexp/de_cad.html), основная функция которой – просмотр 
графических, 3D- и CAD-файлов с конвертацией данных между разными форматами и с це-
лым рядом других полезных возможностей. всего Deep Exploration поддерживает более 
80 (!) форматов, и что особенно важно для нас – в том числе и формат SketchUp. Проще 
говоря, если нашли нужную модель, но в «чужом» формате, не требуется устанавливать 
другие 3D-редакторы – просто открываем (просматриваем) модель и сохраняем ее в «на-
шем» формате .skp. но и это только самая малая часть возможностей! доступны также 
мощные механизмы оптимизации модели – упрощения геометрии, устранения ошибок (в 
том числе удаление «мусора») и многое, многое другое, что невозможно даже обзорно 
представить здесь – без труда найдете всю информацию по Deep Exploration в интернете...

DeM/DDF
Этот формат используется для передачи данных программ моделирования релье-

фов местности (на основе высотного положения опорных точек). Понятно, что такие узко-
специальные данные могут быть необходимы для архитекторов, проектировщиков, ланд-
шафтных дизайнеров, работающих с топографическими подосновами реальной местно-
сти. в окне Options видим две панели со следующими параметрами настроек:

TIN
Points/Faces (Точки/Поверхности) – окошки назначения количества опорных то-

чек и зависящего от них количества образуемых поверхностей. 
Color
Generate a gradient texture (Генерировать градиентую текстуру) – опция обо-

значения высот рельефа градиентным цветом: – чем ниже, – тем темнее, чем выше, – тем 
светлее. 

эКсПОрТ 3D-МОделей
Очевидно, что экспорт моделей из SketchUp в сторонние форматы имеет смысл 

только в случае их передачи в другие программы-«партнеры», которые не поддержива-
ют «напрямую» формат файлов .skp. Здесь главное – достаточный набор форматов об-
мена и корректность (то есть без ошибок и потерь) передачи данных «в обе стороны».  
в основном у SketchUp с этим все в порядке, но на самом деле результаты экспорта/им-
порта достаточно сложно предсказать – многое зависит от конкретного проекта... и от 



87 Тема 22. иМПОРТ/ЭКСПОРТ 3D-МОделей

второй, «принимающей» стороны. например, возможны в некоторых случаях как пробле-
мы с передачей «маппинга» – то есть позиционирования текстурных имиджей на повер-
хностях, так и с разрушением или искажением геометрии. еще раз: – экспорт (как и им-
порт), – это всегда «конвертация» данных между форматами, что нередко сопровожда-
ется определенными потерями и искажениями данных. 

К счастью, как уже было сказано в самом начале нашего курса, явно обозначи-
лась тенденция (особенно в последние годы) все более широкого «признания» SketchUp 
сторонними разработчиками, которые все чаще включают в свои 3D-программы или не-
посредственную поддержку файлов SketchUp, или обмен данными с ним через специаль-
ные плагины.

Форматы далее будут рассматриваться в порядке, в котором они открываются в 
списке окна экспорта. для экспорта 3D-моделей из SketchUp используем команды меню 
File > Export > 3DModel.... При этом открывается окно Проводника, в котором выбира-
ем место сохранения файла, назначаем его имя и Export Type – один из поддерживаемых 
программой 3D-форматов. в зависимости от выбора формата в окне настроек Options 
доступны соответствующие параметры экспорта.

kMZ
Формат KMZ является «сжатым» вариантом специфического формата KML, исполь-

зуемого во всех проектах Google, который, кроме данных о геометрии построений, пе-
реносит еще и данные географического местоположения модели. именно в нем потре-
буется сохранять вашу модель, если решите разместиться в Google Earth или Google 3D 
Warehouse (см. далее тему «Google. Геолокация»). 

никаких дополнительных настроек в окне экспорта не требуется, достаточно на-
значить имя и место сохранения файла.

Dae
Формат DAE (Collada) – надежный, достаточно распространенный формат, кото-

рый поддерживается большинством 3D-редакторов. 
в окне Options видим четыре панели со следующими параметрами настроек:
Geometry (Геометрия):
Export only current selection (Экспортировать только выбранное) – то есть толь-

ко объекты, выбранные инструментом Select. При выключенной опции будут экспорти-
рованы все построения проекта;

Triangulate all faces (Триангулировать все поверхности) – опция замены всех поли-
гонов построений только на треугольные (например, разбиение четырехугольных на два 
треугольных). для некоторых «принимающих» редакторов это принципиальное условие;

Export two-sided faces (Экспортировать двухсторонние поверхности) – эта опция 
удваивает количество многоугольников построения поверхностей в результирующем фай-
ле DAE и может замедлять манипуляции с файлом. Однако дает возможность корректной 
передачи материалов для лицевых и оборотных сторон поверхностей, если это необхо-
димо для используемой программы фотореалистичного рендеринга. 

Materials (Материалы):
Export texture maps (Экспортировать текстурные карты) – опция передачи текстру-

ных координат «как есть», фактически – сохранение настроек текстурирования в SketchUp.
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Cameras (Камеры):
Generate cameras from scenes (Генерировать камеры из сцен) – опция передачи 

параметров камеры в каждой из сцен, то есть передача настроек опции Scenes.
Scale (Масштаб):
Это опция передачи масштаба модели за счет выбора единиц измерения из выпа-

дающего списка Units (Единицы): или Model Units (Назначенных в модели), или из на-
бора других единиц. Механизм масштабирования заключается в том, что если при после-
дующем открытии (импорте) файла DAE в другом 3D-редакторе назначить те же едини-
цы измерения, – перенос произойдет в масштабе 1:1. если заменить их на другие – про-
изойдет масштабирование, пропорциональное соотношению величин единиц измерения. 

3Ds
Про этот формат уж было сказано ранее в теме импорта, заметим только одну су-

щественную деталь – необходимо учитывать, что этот формат (в силу своей «древности») 
не поддерживает длинных имен файлов и кириллицы. Проще говоря, при несоблюде-
нии данных условий после экспорта вы увидите, что файл выглядит как бессмысленный 
набор не более чем 8 символов на латинице (остальное отсекается). По этой же причи-
не могут возникнуть проблемы при использовании кириллицы «внутри» SketchUp напри-
мер, в именах материалов и других «именных» опциях.

необходимо помнить еще об одном техническом ограничении – элементы построе-
ний, скрытые в момент экспорта опцией Hide (или находящие в скрытых слоях), не будут 
передаваться в файл .3ds.

в окне Options видим четыре панели со следующими параметрами настроек:
Geometry (Геометрия)
В списке Export доступен выбор:
Full hierarchy (Полная иерархия) – экспорт полной структуры групп и компонен-

тов в виде отдельных объектов с сеточными поверхностями, в том числе с учетом «вло-
женности» одних в другие и с их именами; 

By layer (По слоям) – экспорт объектов SketchUp в виде отдельных сеточных объ-
ектов с учетом их размещения по слоям. При этом связанные (соприкасающиеся) объек-
ты на одном слое будут группироваться в единый самостоятельный объект. иерархиче-
ская «вложенность» при этом не поддерживается.

By material (По материалам) – экспорт объектов SketchUp в виде отдельных се-
точных объектов с учетом материалов их поверхностей. При этом связанные (соприка-
сающиеся) объекты и с одинаковыми материалами будут группироваться в единый само-
стоятельный объект. иерархическая «вложенность» и здесь не поддерживается.

Single Object (Единый объект) – экспорт всех построений в виде одного сеточно-
го объекта, который наиболее прост для выбора и манипуляций с ним после импорта в 
другие программы. При этом надо учитывать, что формат .3ds имеет ограничение на ко-
личество вершин и поверхностей в одной сетке (65536), поэтому со слишком большими 
и сложными моделями могут быть проблемы; 

Export only current selection (Экспортировать только выбранное) – то есть эк-
спортируются только объекты, выбранные инструментом Select. При выключенной оп-
ции будут экспортированы все построения проекта;

Export two-sided faces (Экспортировать двухсторонние поверхности) – эта оп-
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ция удваивает количество многоугольников сетки поверхностей и может замедлять ма-
нипуляции с файлом. Однако это дает возможность корректной передачи материалов 
для лицевых и оборотных сторон поверхностей, что иногда может быть необходимо для  
качественного рендеринга. 

Эта опция имеет дополнение – два возможных варианта передачи поверхностей: 
As Material (Как материал) и As Geometry (Как построение). в зависимости от выбора 
в экспортированном файле будет учитываться именно этот параметр.

 Стоит принять за правило – перед экспортом в .3ds (да и в любые другие форма-
ты) проконтролировать ситуацию с лицевыми/оборотными сторонами поверхностей и на-
значенными им материалами. во-первых, можно задействовать опцию меню Model Info > 
Statistics > Fix Problem, которая ищет и исправляет проблемы и ошибки в построениях. 
во-вторых, выявить «вывернутые наизнанку» поверхности, переключившись в стиль ото-
бражения Monochrome. Эти моменты очень важны, так как некоторые программы-ренде-
ры «оборотные, внутренние» поверхности просто «не увидят» или будут некорректно их 
воспринимать. выбор из этих вариантов определяется тем, как в дальнейшем планиру-
ется использовать экспортируемый файл. например, для программ рендеринга сущест-
венными являются не сами объекты, а материалы их поверхностей, поэтому в этом слу-
чае логично выбрать вариант «По материалам», соответственно тщательно подготовив 
модель в SketchUp именно по этому параметру;

Export Standalone Edges (Экспорт автономных ребер) – автономные линии, не свя-
занные с поверхностями, – уникальная особенность SketchUp и не поддерживаются фор-
матом .3ds и большинством других 3D-программ. При включенной опции линия экспорти-
руется в виде очень узкого прямоугольника и возможны ошибки в создании файлов .3ds  
и последующего их открытия в других 3D-редакторах. 

Materials (Материалы):
Export Texture Maps (Экспорт текстурных карт) – передача UVs текстурных имид-

жей, используемых в материалах SketchUp, в формат материалов .3ds. 
Эта опция имеет дополнение – два возможных варианта передачи текстур на по-

верхностях: Preserving Texture Coordinates (Сохранение координат текстуры) и Welding 
Vertices (Сварка вершин). Кратко можно охарактеризовать эти параметры как дополни-
тельные опции качества передачи текстур.

на самом деле здесь речь идет о достаточно сложных понятиях и параметрах 
управления точностью положения и представления текстуры на сеточной поверхности 
(UV-Mapping), поэтому, не вдаваясь в подробности, можно только посоветовать поэкс-
периментировать с назначением этих параметров для получения лучшего результата в 
конкретных случаях; 

Use «Color by Layer» Materials (Использовать материалы «Цвет по слоям») – хотя 
формат .3ds непосредственно не поддерживает Слои, эта опция важна при использова-
нии в SketchUp опции «Color by Layer» для правильной передачи материалов в .3ds, осо-
бенно если затем этот файл будет использован в программе-рендере. 

Cameras (Камеры):
Generate cameras from scenes (Генерировать камеры из сцен) – опция передачи 

параметров камеры в каждой из сцен. надо заметить, что эта очень полезная опция на 
самом деле может и не поддерживаться в программе-импортере...

Scale (Масштаб): 
Это опция передачи масштаба модели за счет выбора единиц измерения из выпа-
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дающего списка Units (Единицы): или Model Units (Назначенных в модели), или из на-
бора других единиц. Механизм масштабирования аналогичен предыдущим форматам.

autoCaD DWG и DxF
в окне Options видим две панели со следующими параметрами настроек:
AutoCAD Version (версия AutoCAD):
Здесь производится назначение версии программы, в которой будет сохранен экс-

портируемый файл.
Export (Экспорт):
Здесь производится назначение различных элементов, которые могут экспортиро-

ваться в различных сочетаниях: Faces (Поверхности), Edges (Ребра), Constration Geometry 
(Направляющие линии), Dimensions (Измерительные элементы), Text (Тексты). 

Поверхности из SketchUp экспортируются как сплошные сетчатые с треугольными 
ячейками, при этом передача опций сглаживания и смягчения ребер не поддерживается.

При экспорте используются размеры и единицы измерения, назначенные в про-
екте, и для корректной передачи они же должны быть использованы при последующем 
открытии файлов DWG/DXF в AutoCAD или других программах.

FBx
Это файлы внутреннего формата программы персонажной анимации Autodesk 

MotionBuilder, которые могут быть открыты в ней или импортированы в другие 3D-ре-
дакторы. 

в окне Options видим три панели со следующими параметрами настроек:
Geometry (Геометрия):
Export only current selection (Экспортировать только выбранное) – то есть толь-

ко объекты, выбранные инструментом Select. При выключенной опции будут экспорти-
рованы все построения проекта;

Triangulate all faces (Триангулировать все поверхности) – опция замены всех по-
лигонов построений только на треугольные (например, разбиение четырехугольных на 
два треугольных);

Export two-sided faces (Экспортировать двухсторонние поверхности) – эта оп-
ция удваивает количество многоугольников построения поверхностей в экспортиро-
ванном файле и может замедлять манипуляции с файлом. Однако это дает возможность  
корректной передачи материалов для лицевых и оборотных сторон поверхностей, что 
может быть необходимо для качественного рендеринга; 

Separate disconnected faces (Разделять несоединенные поверхности) – разделе-
ние таких поверхностей на самостоятельные сеточные объекты. 

Materials (Материалы):
Export texture maps (Экспортировать текстурные карты) – опция передачи пара-

метров текстурных материалов.
Scale (Масштаб):
Swap YZ coordinates (Y is up)(Замена положения координат YZ (Y – вверх)) – оп-

ция изменения положения вертикальной оси на ось Y. Такая ориентация принята по умол-
чанию в некоторых 3D-редакторах. При выключенной опции вертикальной будет ось Z.

ниже находится опция передачи масштаба модели за счет выбора единиц измере-
ния из выпадающего списка Units (Единицы) или Model Units (Назначенных в модели). 
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Механизм масштабирования аналогичен предыдущим форматам.

oBJ и xCi
Полученные экспортом из SketchUp файлы формата OBJ являются «внутренним» 

форматом программы 3D-моделирования и анимации Advanced Visualizer и могут быть 
открыты в ней или импортированы во многие другие 3D-редакторы. Одновременно с  
записью файла OBJ создается файл формата MLT с данными по материалам модели.

Аналогичные настройки экспорта имеет и формат XCI (формат файлов редактора 
Soft Image), поэтому они и рассматриваются вместе. 

в окне Options видим три панели со следующими параметрами настроек:
Geometry (Геометрия):
Export only current selection (Экспортировать только выбранное) – то есть толь-

ко объекты, выбранные инструментом Select. При выключенной опции будут экспорти-
рованы все построения проекта;

Triangulate all faces (Триангулировать все поверхности) – опция замены всех по-
лигонов построений только на треугольные (например, разбиение четырехугольных на 
два треугольных). Каждая поверхность (Face) SketchUp передается в файл OBJ как один 
многоугольник, что может иногда вызывать ошибки – например, некоторые поверхности 
могут исчезнуть или изменить ориентацию. использование этой опции может решить та-
кие проблемы; 

Export two-sided faces (Экспортировать двухсторонние поверхности) – эта оп-
ция удваивает количество многоугольников построения поверхностей в экспортиро-
ванном файле и может замедлять манипуляции с файлом. Однако это дает возможность  
корректной передачи материалов для лицевых и оборотных сторон поверхностей, что 
может быть необходимо для качественного рендеринга; 

Export edges (Экспорт ребер) – опция передачи элемента Line (Линия) SketchUp в 
аналогичный элемент формата OBJ. Обычно этот переключатель имеет смысл держать 
выключенным, поскольку многие программы могут не воспринимать этот элемент. 

Materials (Материалы):
Export texture maps (Экспортировать текстурные карты) – опция передачи пара-

метров текстурных материалов.
Scale (Масштаб):
Swap YZ coordinates (Y is up)(Замена положения координат YZ (Y – вверх)) – опция 

изменения положения вертикальной оси на ось Y. Такая ориентация принята по умолчанию 
в некоторых 3D-редакторах. При выключенной опции вертикальной будет ось Z.

ниже находится опция передачи масштаба модели за счет выбора единиц измерения 
из выпадающего списка Units (Единицы) или Model Units (Назначенных в модели). Меха-
низм масштабирования аналогичен предыдущим форматам.

надо иметь в виду технические ограничения формата OBJ:
1. не допускаются пробелы в именах файлов (заменяются на знак «_» ).
2. Формат не поддерживает структурную иерархию («вложенность») объектов проекта. 

VrMl 
Это стандартный формат файлов для демонстрации трехмерной интерактивной век-

торной графики. используется для передачи 3D-сцен и объектов в презентационные и веб-
приложения. 
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в окне Options видим две панели со следующими параметрами настроек:
Appearance (Появление):
Output Texture Maps (Вывод текстурных карт) – опция, если возможно, будет эк-

спортировать текстуры, если нет – только цвет поверхностей; 
Ignore Back of Face Materials (Игнорировать оборотные стороны материалов) – 

опция передачи материалов лицевой и оборотной сторон поверхностей (SketchUp экспор-
тирует все поверхности как двойные); 

Output Edges (Вывод ребер) – опция конвертации элементов ребер SketchUp в 
аналогичные элементы VRML;

Use «Color by Layer» Materials (Использовать материалы «Цвет по слоям») – хотя 
формат VRML непосредственно не поддерживает слои, эта опция важна при использо-
вании в SketchUp опции «Color by Layer» для правильной передачи материалов, особен-
но если затем этот файл будет использован в программе-рендере; 

Use VRML Standard Orientation (Использовать стандартную ориентацию VRML) – 
опция замены ориентации осей SketchUp на ориентацию, принятую в VRML;

Generate cameras from scenes (Генерировать камеры из сцен) – опция передачи 
параметров камеры в каждой из сцен;

Allow Mirrored Components (Допускать зеркальные компоненты) – опция пере-
дачи «отзеркаленных» или измененных в размерах компонентов; 

Check for Material Overrides (Выбор игнорирования материала) – опция переда-
чи элементов с материалами «по умолчанию». 

в завершение темы экспорта моделей SketchUp в «сторонние» форматы еще раз под-
черкнем: – для корректной передачи необходимо прежде всего учитывать особенности и 
требования «принимающей стороны», то есть той конкретной программы, которая через 
свои опции импорта будет загружать эти модели. Поэтому самый рациональный путь – про-
верить на простой тестовой модели несколько возможных вариантов (форматов) передачи 
и выбрать самый «правильный». Кроме того, возможно, придется поработать и с подбором 
самых корректных вариантов назначаемых параметров экспорта – понятно, что и они могут 
существенно влиять на качество результата...
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Эта группа инструментов Google служит для работы с интернет-ресурсами 

Google непосредственно из SketchUp. Используя их, можно стать участником от-
крытых проектов: Google Earth (Google планета Земля) – 3D-модели планеты на ос-
нове спутниковых фотографий земной поверхности, пользоваться интернет-скла-
дом 3D-моделей (и пополнять его своими) с Google 3D Warehouse и получить до-
ступ к нескольким другим возможностям. 

инсТруМенТЫ GooGle
в начальном обзоре истории программы уже было сказано, что Google в свое время 

приобретал SketchUp прежде всего для популяризации и продвижения своих проектов, и это 
направление максимально широко реализовано в рассматриваемой 8-й версии. не все из 
этих «узкоспециальных» инструментов на практике одинаково актуальны... хотя бы по при-
чине того, что некоторые из них имеют существенные «территориальные» ограничения. Тем 
не менее знать принципы их работы необходимо, поскольку эти инструменты тесно «завяза-
ны» между собой и с остальными функциями SketchUp.

Панель инструментов Google (если отсутствует в интерфейсе) открывается через меню 
View > Toolbars > Google. Рассмотрим функции инструментов не в порядке следования кно-
пок, а по степени их реальной практической актуальности.

Get Models... (Получить модель)
Кнопка открывает окно браузера интернет-сервиса Google – 3DWarehouse (Скла-

да 3D-моделей). Кроме того, эта же функция доступна через меню File > 3D Warehouse > 
Get Model. вспомним, кстати, что с загрузкой моделей из «склада» мы уже знакомы по теме 
«Components (Компоненты)» – аналогичная опция доступна через диалоговое окно Браузе-
ра компонентов. 

3D Warehouse – огромная, открытая для всех (если иное не установлено автором) би-
блиотека готовых моделей самого разного характера, в которой через систему поиска (ра-
ботает и на русском!) наверняка найдете нужное. Представьте, что работаете над интерье-
ром помещения, и понадобилась дверная ручка, светильник, кресло... и другие объекты, ко-
торые не являются предметом вашей разработки (не требуются оригинальные, авторские), 
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но необходимы для достоверного «наполнения» проекта... нетрудно понять, насколько эта 
возможность может ускорить и упростить работу! Однако надо заметить, что поскольку это 
открытый ресурс, то и наполнение его – самого разного уровня и качества исполнения. Ка-
чественные, профессионально выполненные модели – отличный способ повысить свой уро-
вень владения SketchUp. Загружайте, разбирайте, анализируйте, стараясь понять логику – как 
это сделано… но, к сожалению, таких не так и много. все-таки основная масса – невысокого 
любительского уровня, так что стоит принять за правило после загрузки модели вниматель-
но ее проверить на наличие ошибок, которые могут впоследствии создать проблемы, и ис-
править их. в любом случае выбор аналогичных моделей очень большой, так что лучше по-
тратить время на поиск наиболее качественной и подходящей, чем на исправление безгра-
мотно замоделированной... 

и еще – при вроде бы очевидно удобной возможности загрузки моделей непосред-
ственно «изнутри» текущего проекта все-таки вряд ли это лучший вариант... Почему?  да как 
раз по перечисленным выше причинам – очевидно, рациональней исправить ошибки (воз-
можно – и скорректировать по своим потребностям), загрузив отдельно файл модели просто 
через браузер (http://SketchUp.Google.com/3dwarehouse/) и уже затем поместив его в текущий 
проект. Помним, что импортируемая модель, кроме возможных ошибок построения, «тянет 
за собой» и назначенные в ней автором слои, материалы, стили  и прочее, которые для ва-
шего текущего проекта также могут оказаться совершенно ненужным «мусором», избавлять-
ся от которого в этом случае будет куда более трудоемко...

надо также иметь в виду, что на 3DWarehouse различаются два типа моделей – объ-
екты, помещенные в него авторами с «геолокацией», то есть с географической привязкой 
к конкретному месту на Google Earths, и отдельные объекты без «геолокации», которые ти-
пичны в роли компонентов (стул, окно, дверь и т. п.). если ваш текущий проект содержит ге-
ографическую привязку, при загрузке модели появится окно выбора, – какую локацию ис-
пользовать – проекта или загружаемой модели. 

Кстати, надо заметить, что сервис 3DWarehouse настолько очевидно удобен, практи-
чен и востребован, что включение его поддержки (возможности загрузки из него моделей) 
в последние несколько лет уже стало почти правилом для других 3D-редакторов, рендеров 
и т. п. ... и очевидно способствует росту популярности SketchUp.

Add location (Добавить место размещения)
Кнопка открывает окно браузера интернет-проекта Google Earths (Земля Google) – 

приблизительно в установленных по умолчанию координатах района (об этом далее в теме 
«Геолокация»). выбираем любое нужное место на карте через поиск в окошке Search (ра-
ботает и по-русски!) – вводим, например, название города. далее уточняем местоположение 
и устанавливаем необходимое зуммирование изображения нужного участка. 

далее кнопкой Select Region вызываем еще одно окно, в котором видим и уточня-
ем «кадрирование», передвигая прямоугольник с «булавками» по углам или меняя его разме-
ры/пропорции за эти булавки. в завершение кнопкой Grab загружаем в проект имидж–груп-
пу Google Earth Snapshot. Эта группа – спутниковый снимок выбранного участка местности – 
появляется в центре сцены в масштабе проекта (!) и в зафиксированном (Lock) по умолчанию 
состоянии (рис. ниже слева). 

Затем этой же кнопкой Add location (которая после первого применения получает 
обозначение Add More Imagery...) можем загрузить и соседние участки, «сшив» их с преды-
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дущим теми же повторными шагами. для получения корректного результата необходимо со-
блюсти два условия: – дистанция между выбранными участками должна быть не более 1000 
метров, и они должны находиться на примерно одинаковых высотных отметках.

 

 Toggle Terrain (Переключить на рельеф) 
Кнопка переключает состояние полученного предыдущей опцией «плоского» сним-

ка (рис. ниже слева) в трехмерную модель рельефа того же участка в том же масштабе, в том 
числе по высотным отметкам проекта (рис. ниже справа). 

Открыв диалоговое окно Layers, видим, что фактически предыдущей опцией сразу 
загружаем оба этих состояния, которые помещаются в разные слои, скрытие/показ кото-
рых происходит автоматически в зависимости от выбранной опции – Google Earth Terrain 
или Google Earth Snapshot. ну и далее, сняв фиксацию «снимков» (Unlock), можем работать 
с ними, как и с любыми другими аналогичными объектами SketchUp...

впечатляет, не правда ли? нетрудно понять, насколько мощные, уникальные возмож-
ности предоставляют эти опции не только архитектору, ландшафтному дизайнеру, проекти-
ровщику, но и любому пользователю, чтобы, например, поставить свою модель на географи-
чески реальную подоснову... и разместить в Google Earth свой дом. Собственно, именно этот 
механизм и является основой проекта, существование которого трудно представить без та-
кого уникального по доступности инструмента 3D-моделирования, как SketchUp. 
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Share Model... (Поделиться моделью)

Share Component... (Поделиться компонентом)
Обе функции имеют аналогичное назначение – размещение своих творений в 

3DWarehouse для свободного всеобщего (или с ограничениями – если захотите) поль-
зования. в чем разница? Опция Share Model... доступна всегда, то есть фактически для 
всех объектов текущего проекта, а Share Component... становится активной только по-
сле выбора в сцене конкретного объекта-компонента – соответственно, будет разли-
чаться и отправляемое «на склад» содержимое модели. Понятно, что в роли компонен-
та имеет смысл отправлять подходящие для этой роли типы отдельных объектов. и еще 
– так же как в случае загрузки модели в проект (Get Model), – эти опции доступны и че-
рез меню File > 3D Warehouse > Share Model... и > Share Component... Кроме того, ком-
поненты можно «отправлять на склад» непосредственно из сцены через одноименный 
пункт их контекстного меню.

Расписывать подробно последовательность действий не имеет смысла – желаю-
щие получают необходимые пошаговые подсказки в процессе размещения. Заметим, что 
если размещение отдельных объектов (компонентов) практически не вызывает затруд-
нений, то ситуация с отправкой моделей на Google Earth несколько сложней. не вдава-
ясь в подробности, – эта процедура весьма сложна, обставлена множеством техниче-
ских и юридических условий и ограничений, так что, кроме авторских амбиций, требу-
ется терпение и веские личные основания довести до конца «борьбу» со всеми этими 
трудностями... ну а чтобы получить конкретное представление, о чем идет речь, може-
те ознакомиться с «Критериями принятия модели для слоя фотореалистичных 3D-зданий 
в Google планета Земля» на сайте Google (http://SketchUp.Google.com/support/bin/answer.
py?answer=1267260&hl=ru).

впрочем, вряд ли есть основания предъявлять в этом плане претензии к Google – 
естественно, для корректного функционирования и удобства для всех такой глобальный 
сервис не может допускать «анархии» в его наполнении...

Add New Building... (Добавить новые здания)
Кнопка открывает окно браузера дополнительного 3D-интернет-сервиса Google – 

Building Maker (в русскоязычном варианте – Google Архитектор). Эта же опция доступна из 
меню File > Building Maker. Задерживаться на нем не будем прежде всего потому, что сер-
вис работает только для определенных районов Земного шара, например из восточной ев-
ропы доступны только несколько городов Чехии, Польши, венгрии. Фактически это «мик-
ро-SketchUp» – набор нескольких предельно простых инструментов моделирования «коро-
бок» зданий на основе спутникового снимка выбранного района и размещения их в том же 
Google Earth. Кроме того, для пользователя SketchUp, которому доступны несоизмеримо бо-
лее продвинутые возможности работы с Google Earth и 3DWarehouse, вряд ли применение 
Building Maker имеет какой-то смысл.

Photo Textures (Текстуры из фото)
Кнопка открывает окно браузера еще одного 3D-интернет-сервиса Google – Street 

View (Просмотр улиц», позволяющего рассматривать панорамные виды улиц ряда опреде-
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ленных городов мира с «человеческой точки зрения» – камеры на высоте около 2,5 метров 
от «земли». А затем назначенный «кадр» можно перенести на предварительно выбранную 
поверхность модели в проекте в качестве текстурного материала поверхностей. Ситуация 
с доступностью и практической пользой этой функции фактически аналогична предыдущей, 
поэтому можно только предложить для интересующихся ввести в окошке поиска места, на-
пример, «Прага»... и посмотреть, как это выглядит. 

Preview Model In Google Earth (Предпросмотр модели в Google Earth)
Опция создания временного файла SketchUp c предварительным показом модели (про-

екта) в назначенном месте геолокации (см. далее) на Google Earth. Тот же пункт доступен из 
меню File. использование этой функции становится доступно только после отдельной загрузки 
и установки программы работы с сервисом (http://www.google.com/intl/ru/earth/download/ge/).

Google Earth Ocean Modeling (Слой мирового океана Google Earth)
Это еще одна возможность, предоставляемая Google – помещение трехмерной мо-

дели океанской поверхности в проект SketchUp. Хотя такая функция скорее из разряда эк-
зотики, о ее существовании все-таки стоит знать. 

Открываем меню «Расширений» Window > Preferences > Extensions и включаем пункт 
Google Earth Ocean Modeling. далее устанавливаем (выбираем) локацию – место на океан-
ской части земной поверхности и… выполняем все остальные опции и действия, уже знако-
мые по работе с рельефами земной поверхности. ну и здесь могут встретиться те же пробле-
мы, связанные с наличием спутниковых снимков нужной детализации для выбранных (нуж-
ных) участков Мирового океана.

в завершение темы инструментов и 3D-сервисов Google заметим, что все они доступ-
ны и вне SketchUp, только в этом случае от интернет-пользователя потребуется ряд дейст-
вий, связанных не только с регистрацией (получением аккаунта), но и с установкой нужных 
программных компонентов.

геОлОКаЦиЯ
в SketchUp с самых ранних версий присутствовали функции, аналогичные по назначе-

нию рассмотренным инструментам Google, – «привязки» к реальному географическому поло-
жению (геолокации). на самом деле это достаточно типичная для программ архитектурного 
и ландшафтного проектирования опция, основное назначение которой – достоверная ими-
тация естественного солнечного освещения (теней) по географическому положению моде-
ли, времени года и суток. Понятно, что эти параметры весьма значимы при принятии и оцен-
ке технических решений проектов указанного профиля.

Управление этими опциями находится в диалоговом окне Geographic Location, ко-
торое может быть открыто несколькими способами. начнем с кнопки в левой части статус-
ной строки под рабочим окном. Здесь, при помещении курсора на кнопку, видим показан-
ную ситуацию – модели не назначена локация (или подсказку с инфо по текущей локации, 
если она уже назначена). 
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Кликаем кнопку – открывается диалоговое окно:

Как видим, это один из пунктов меню Model Info > Geo-location (то есть окно может 
быть сразу открыто и через меню Window). в текущем состоянии выводится прежде всего 
та же информация – что модели не назначена локация и что для точной имитации солнечного 
освещения в определенном местоположении модели следует воспользоваться инструмента-
ми Google для назначения геолокации. Тут же видим кнопку знакомой функции Add Location, 
через которую можно «визуально» решить рассматриваемую задачу. 

вторая часть окна – Advanced Setting (Расширенные настройки) – позволяет подой-
ти к решению той же задачи как бы с другой стороны – через назначение точных географи-
ческих координат. Кнопкой Set Manual Location (Установить координаты вручную) откры-
ваем диалоговое окно, в котором вводим точные значения географической широты/долго-
ты (Latitude, Longitude). 

Ресурсы с данными по нужному городу можно без труда найти в интернете, напри-
мер по поисковым словам «координаты широты и долготы городов». 

Чтобы убедиться в том, что функция учета локации работает, включим в сцене показ 
теней – видим, что изменением географических координат меняется и характер теней в сце-
не. Окошки Country (Страна) и Location (Место) можно заполнять как угодно – они чисто 
информационные и никакой другой функции не несут. все введенные данные сохраняются в 
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текущем файле, в том числе при сохранении файла как Template (Шаблона).
После назначения локации (применения в проекте) видим информацию по ней в ин-

формационном поле диалогового окна. Кнопкой Clear Location «сбрасывается» привязка 
модели к локации, о чем появляется соответствующее предупреждение и требуется новый 
ввод данных в Set Manual Location.

еще одна возможность управлять геолокацией текущей модели (хотя и весьма при-
близительно), а значит, и положением Солнца (тенями) – назначение часового пояса, в кото-
ром модель расположена. По умолчанию (сразу после установки) в SketchUp установлен ча-
совой пояс: USA, Boulder (CO), 40.017000N, 105.283000W. новый файл (модель) открывается 
в часовом поясе, который считывается из установок Windows на вашем компьютере: Пуск > 
Панель управления > Дата и время. 

Эти данные будут использоваться до тех пор, пока мы их не изменим на другие. Часо-
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вой пояс обозначается аббревиатурой GMT или UTC со знаками « + » или « – », что означа-
ет часовые сдвиги в большую или меньшую сторону (западнее или восточнее) от «нулевого» 
часового пояса (в примере GMT+8:00 для Москвы – на 8 часов сдвинуто на более раннее). 
для справки: – UTC – это универсальное координированное время в данном часовом поя-
се, GMT – среднее время «по Гринвичу» (упрощенно можно считать, что это одно и то же).

Открыв список кнопкой правее окошка, можем выбрать и использовать наиболее 
подходящие к нашему проекту данные для дальнейшего использования в SketchUp. Понятно, 
что менять здесь часовой пояс не стоит, иначе изменится системное время самой Windows... 
если требуется более точный подход, ищем в интернете подходящий ресурс по поисковым 
словам «часовые пояса» (их так же, как и по координатам – множество!) и выбираем кон-
кретный населенный пункт. 

далее открываем хорошо знакомое диалоговое окно Shadow Settings... и вот теперь 
нам становится ясно, что за данные показаны в верхнем окошке (о них ранее при изучении 
теней умолчали). выбираем (назначаем) в раскрывающемся списке нужное значение UTC+ 
... или UTC– . видим, что с изменением этого параметра тут же меняется и характер тени на 
объектах в сцене. вполне возможно, что для большинства задач достоверного отображе-
ния теней с привязкой к географической локации нам будет вполне достаточно применить 
эту методику. 

аВТОрсКие ПраВа
Это еще одна функция, которой можете воспользоваться при размещении моделей в 

Google 3D Warehouse и Google Earth, – «прикрепить» данные о своих авторских правах. От-
кроем новый «пустой» файл и поместим курсор на показанную ниже кнопку Sign (Подпись) 
в левой части статусной строки:

 
Опция Sign служит для оформления своих авторских прав на сервисах Google – ви-

дим, что пока этого не сделано. Кликнем на кнопке – открывается окошко «подписи» файла 
вводом своего аккаунта (регистрации) в Google, а если такового еще нет, предлагается его 
создать (ссылки в нижней части окна):
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еще одна кнопка рядом – Credits (Удостоверение) – при помещении на нее курсора 
показывает, что в новом файле пока нет данных об авторе. 

А, например, в файле с детским городком из темы «Match Photo (Совмещение с фото)» 
увидим, что автор компонента «городок» – Google (так оно и есть – использован авторский 
компонент из 3D Warehouse). Ту же информацию увидим, кликнув на кнопке, – открывается 
аналогичный пункт меню Window > Model Info > Credits. Отсюда также можно выйти на опцию 
(и то же диалоговое окно Sign In) «подписи» своего текущего проекта кнопкой Claim Credit.

Конечно, ваше право разместить модель и «анонимно». Так, например, если подписали 
модель, а потом передумали, можно отменить эти данные, кликнув на кнопке Credits, – в этом 
случае открывается диалоговое окошко Sign Out, в котором подтверждаем снятие «подписи».
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Сразу может возникнуть логичный вопрос: – а почему эту группу инструмен-

тов мы не рассматривали в ранее изученной теме «Компоненты»? На это есть не-
сколько причин, и прежде всего – Динамические компоненты (далее – DC) имеют 
намного более «узкую» сферу применения, чем «обычные», в силу своей специ-
фичности. Или, проще говоря, – большинство пользователей на практике спокой-
но обходятся без них, поскольку применение DC относится не столько к задачам 
моделирования, сколько к так называемому «параметрическому» программиро-
ванию. Понятно, что это на самом деле отдельный «жанр», на непростое освое-
ние которого требуются не только соответствующие склонности и способности, но 
и веские причины тратить на это время и силы. 

начнем с демонстрации того, как работают и могут быть использованы DC, на прос-
том примере уже знакомого по одной из первых тем персонажа-компонента – «Susan». От-
крываем опцию меню Tools > Interact (Взаимодействие) и помещаем ее специальный кур-
сор «рука» на компонент. Появляется подсказка «Кликни для изменения цвета моей кофточ-
ки», что и происходит сменой нескольких цветов после каждого клика – такое «поведение» 
и заложено разработчиком в этот DC. 

думаю, основное отличие DC от «обычных» Компонентов очевидно – они интерактив-
ны, динамически (отсюда и название) реагируют на действия пользователя. При этом, заме-
тим, обладают всеми теми же свойствами и возможностями, что и «обычные», а также под-
держивают все те же средства и способы управления Компонентами в сцене. При этом су-
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ществуют и действуют только в рабочем пространстве SketchUp, то есть их специфические 
возможности никаким образом не могут быть переданы в другие программы...

в состав библиотек Компонентов (диалоговое окно Components) включены и несколь-
ко примеров DC – их можно отличить от «обычных» компонентов по специальному зелено-
му значку-стрелке.

уПраВление DC В сЦене
для быстрого доступа к опциям предусмотрены контекстное меню, вызывае-

мое на вставке DC в сцене, и специальная панель инструментов (View>Toolbars>Dynamic 
components).

Кроме доступных из этой панели опций (рассмотрим далее), только из контекстного 
меню доступны две дополнительные:

Swap component (Замена компонента) – позволяет выбрать в рабочем окне DC (или 
несколько) и затем через открывающееся окно Проводника указать файл .skp, содержащий 
другой (заменяющий) DC; 

Redraw (Обновить) – обновляет выбранный компонент, если он поддерживает та-
кую функцию.

Кнопки панели инструментов:

Interact with Dynamic Components (Взимодействие с Динамическими Компонен-
тами). Эта опция уже знакома – дублирует меню Tools > Interact.

Component Options (Настройки компонента). Открывает диалоговое окно с пол-
ной информацией по компоненту, а также список возможных действий (поведения) – тот же 
Interact. То есть можно и здесь выбрать нужный вариант и применить его кнопкой Apply в 
нижней части окна.

Component Attributes (Атрибуты компонента). Открывает диалоговое окно с пол-
ной информацией по этим специфическим параметрам DC, которые определяют их пове-
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дение. некоторые атрибуты являются встроенными, то есть действуют автоматически и 
для изменения пользователем недоступны, для других разработчиком может предусма-
триваться возможность изменения (настройки) пользователем. 

Подробно рассмотреть работу со всеми элементами и функциями этого диалогового 
окна (да и вообще темы DC) в рамках нашего курса нереально, поскольку, как было сказано,   
это уже другая, специфическая и очень объемная тема... Тем не менее здесь обзорно все-та-
ки ознакомимся с теми параметрами и принципами управления, которые «работают» в DC.

Типичные характеристики
ниже перечислены несколько типичных характеристик – большинство DC имеет одну 

или несколько из них: 
1. Constrained (Принуждение)
Отдельные части DC могут иметь фиксированное значение (например, размера), ко-

торое не будет позволять им меняться при изменении размеров других частей, – например 
при масштабировании, или позволять им изменяться только в заданном определенном на-
правлении. например, для дверцы шкафа можно установить неизменяемые размеры рамы, 
то есть при масштабировании будут меняться только габариты обшивки. Такой механизм 
очень подходит, например, для серии однотипных изделий, в которых (в зависимости от ти-
поразмерного ряда) меняется только часть конструкции.

2. Repetitive (Повторение)
DC могут иметь «вложенные компоненты» (или подкомпоненты), которые, оставаясь 

неизменными, добавляются (повторяются) при масштабировании, например ступени лестни-
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цы. Аналогично повторение может быть использовано, например, для DC планок обрешет-
ки забора, подушек дивана, строительных решетчатых конструкций и т. п. 

3. Configurable (Конфигурирование)
DC могут иметь предварительно назначенные значения, которые доступны для изме-

нения пользователем, например длина объекта, промежутки между элементами конструк-
ций и т. п. 

4. Animated (Анимация)
DC могут иметь анимированные «вложенные» подкомпоненты, которые воспроизво-

дят анимацию при клике на них инструментом Interaction (Воздействие) – например, откры-
вающиеся двери. 

разрабОТКа DC
Пользователи Pro-версии могут разрабатывать собственные DC. Рассмотрим обзор-

но порядок действий по разработке на конкретном примере DC забора, который при мас-
штабировании по длине будет автоматически добавлять вертикальные рейки обрешетки. 

1. Создаем новый «обычный» компонент, который включает в себя подкомпоненты 
(подгруппы) – каждый со своим уникальным именем. Показанный «родительский» компонент 
PicketFence (Забор) включает в себя четыре подкомпонента со своими уникальными имена-
ми: столб, верхний брус, нижний брус и рейка (здесь и далее приведены переводы «имен»).

2. Открываем диалоговое окно Attributes. 
3. Под именем компонента (или его вложенных составляющих) кликаем кнопку (+) – от-

крывается полный список доступных атрибутов (набор может быть различен). Каждый атри-
бут имеет определенное value (значение), которое может быть представлено текстом, числом 
или формулой (текст + число). 

Типичные атрибуты:
Component info (Общая инфо по компоненту):
Name – имя, которое видит пользователь;
Summary – краткая текстовая инфо; 
Description – дополнительное текстовое описание;
ItemCode – номерная идентификация;
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Position (Позиция):
X, Y, Z – координаты по осям X (красной), Y (зеленой), Z (синей).
Size (Размеры):
LenX, LenY, LenZ – размеры (в сантиметрах или дюймах) вдоль соответствующих осей. 
Rotation (Угол поворота):
RotX, RotY, RotZ – угол поворота (в градусах) относительно соответствующих осей.
Behaviors (Поведение):
Material – материал, например в числовых параметрах цветовых моделей;
Scale Tool – контролирует, какие из «захватов» (по каким осям) появляются и работают; 
Hidden – 1 – скрытый , 0 – отмена скрытия;
onClick – определяющий реакцию компонента на клик инструментом Interact; 
Copies – общее количество экземпляров компонента, которые будут созданы (в той 

же позиции). Связан со следующим атрибутом; 
Copy – количество специальных копий, которые ( в рамках предыдущего параметра) 

могут появляться по параметрам, заданным формулой. например, мы хотим, чтобы рей-
ка копировалась вдоль оси Х на определенную дистанцию: =5+Copy*(Fence!spacing+LenX).

Form Design (Форма дизайна):
Creator – имя разработчика;
ImageURL – интернет-ссылка на имидж, который будет появляться внутри окна 

Component Options;
DialogWidth, DialogHeight – ширина, высота в пикселах окна Component Options.
4.  По каждому атрибуту открываем дополнительные окна для назначения функцио-

нальных значений – числовых, текстовых, формул, функций. 
5. Тестируем на корректную работу. 
6.  Сохраняем в файл компонента.

Резюмируя тему DC, можно сказать, что их применение может иметь практическую 
ценность, но... только под определенный круг задач и обстоятельств. например, если вам  
постоянно приходится работать с некими большими сериями (модулями) однотипных объек-
тов, которые отличаются друг от друга только определенным набором параметров. в то же 
время стоит сначала оценить целесообразность и преимущество применения DC в конкрет-
ных обстоятельствах... на примерах того же «Забора» или «перекраски» кофточки Susan оче-
видно, что вряд ли имеет смысл под такого рода разовые задачи затрачивать столько уси-
лий на освоение и разработку DC, если тот же результат легко достигается другими, «стан-
дартными» инструментами и опциями SketchUp. 

и второе – если все-таки есть интерес и смысл освоить разработку и применение 
DC, необходимую подробную информацию можно найти по этой теме на офсайте SketchUp: 
http://SketchUp.Google.com/support/bin/answer.py?answer=115545 (естественно, только на  
английском языке).
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Итак, проделав большую работу, вы завершили проект и теперь можете с 

гордостью продемонстрировать его на своем компьютере, открыв в SketchUp. Но, 
поскольку возможность (и целесообразность) такой демонстрации имеет место 
далеко не всегда, для любого 3D-редактора очень важны возможности переда-
чи результатов моделирования «во внешний мир» в доступном для всех, нагляд-
ном и эффектном виде. Эти возможности можно обозначить как «презентацион-
ные» – какими опциями и инструментами они реализованы в SketchUp, и рассмо-
трим подробно в данной теме.

Фактически в предыдущих темах мы уже рассмотрели два из такого рода механизмов – 
самые простые и доступные: распечатка на принтере и экспорт в виде 2D-графики (статично-
го имиджа). в принципе, и представление проекта в виде 3D-модели (в том числе экспортом в 
другие форматы) можно рассматривать как вариант презентации... с оговоркой, конечно, что 
доступна она будет ограниченному кругу «зрителей», имеющих соответствующие технические 
(программные) возможности и знания.

в любом варианте презентация начинается с ее планирования (сценария), оформле-
ния, настройки в SketchUp – конечно, с учетом будущего «жанра» и предполагаемого спосо-
ба представления проекта. в то же время основные методы и шаги такой подготовки в по-
давляющем числе случаев универсальны, поскольку фактически строятся на «съемке» вир-
туального мира проекта с нужными настройками отображения и с разных ракурсов (точек 
взгляда). А для фиксации, сохранения последовательности таких «кадров» в рабочем про-
странстве SketchUp (и файле проекта) используется механизм Scenes (Сцен), который был 
подробно рассмотрен в первой части (книге) нашего курса. 

если предполагается представлять работу в виде статичных имиджей (или их распе-
чаток), логика определения содержания и настроек вида Сцен достаточно проста и понят-
на. в этом случае фактически создаем аналог необходимого комплекта страниц, листов чер-
тежей традиционного «бумажного» варианта проекта. Кстати, в ранних версиях SketchUp 
вместо нынешних «Сцен» в этом же механизме и использовался термин «Pages (Страницы)». 

Тот же механизм Сцен используется и для самого интересного и эффектного спосо-
ба презентации, в котором вы можете стать не только «чертежником» и «фотографом», но 
и «режиссером-оператором» собственного «фильма», представляющего выполненный про-
ект. Речь идет об анимационном фильме – инструменты и опции его создания мы и рассмот-
рим подробно далее.
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аниМаЦиЯ – насТрОйКи ПараМеТрОВ
Основной принцип создания анимации в SketchUp прост: фильм «монтируется» из 

последовательного ряда созданных в проекте Сцен (от первой – к последней), фактически 
«ключевых кадров» по терминологии видеоредакторов. вторая принципиальная составля-
ющая – механизм автоматического создания промежуточных «кадров» перехода от одной 
сцены к другой. Уточним, что под анимацией здесь и далее понимается именно «плавное, по-
степенное» изменение доступных для этой опции параметров. и наконец – результат мож-
но сохранить (экспортировать) в файл видеоформата AVI или в последовательность отдель-
ных имиджей-кадров. 

Теперь разберемся с главной особенностью анимации в SketchUp. Как мы знаем,  
каждая Сцена – это зафиксированный «взгляд» в нее через камеру, которая может как бы 
перемещаться по виртуальному миру проекта (между сценами), показывая его с разных то-
чек установки в сцене (ракурсов) и с разными настройками отображения. При этом помним 
о втором принципиальном моменте – управление камерой и параметрами отображения в 
Сценах совершенно независимы от собственно геометрии построений, это только механизм 
показа, обзора объектов проекта. А отсюда следует, что нам доступен только лишь один 
фактор анимации – только камера, но не объекты! Это можно считать серьезным ограниче-
нием или даже недостатком механизма анимации SketchUp, однако заметим, что такой под-
ход типичен для многих редакторов аналогичного назначения. ведь здесь главная задача – 
провести «экскурсию, прогулку» зрителя по виртуального миру проекта, дав возможность 
рассмотреть его объекты. 

Базовые, основные параметры механизма анимации в текущем проекте назначают-
ся в диалоговом окне, которое открывается через меню Window > Model Info > Animation. 
Продолжительность презентации (фильма) зависит от количества Сцен в проекте и парамет-
ров перехода между ними:

Scene Transitions (Переход сцен):
Enable scene transitions (Включить переход сцен) – вкл./выкл. эффекта плавного пе-

рехода между сценами за счет автоматического создания промежуточных «кадров». Окош-
ко ниже служит для ввода продолжительности (фактически – скорости) перехода в секундах. 
Очевидно, что число «0» аналогично по действию выключению этого пункта.

Кстати, переходя между сценами ранее, на этапе моделирования, вы наверняка на-
блюдали этот плавный «проезд» камеры, поскольку показанные на рисунке выше настрой-
ки установлены по умолчанию. и так как там это совершенно излишне (только отнимает 
время), имеет смысл до этапа начала работы над презентацией Scene Transitions выключать. 

Scene Delay (Задержка сцен):
Опция назначения (в окошке ввода, в секундах) времени демонстрации одной сцены 
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(задержки до начала перехода к другой), то есть фактически паузы между переходами. От-
сюда следует, что если требуется получить непрерывное «движение» на экране, этот пара-
метр надо устанавливать = 0.

и еще один принципиальный момент – эти две настройки действуют на весь «фильм», 
то есть на всех сценах и переходах между ними одинаковы. или по-другому – возможность 
разных настроек «переходов и задержек» для разных сцен не предусмотрена. и это тоже 
весьма существенное ограничение механизма анимации в SketchUp, неудобство которого 
можете ощутите на практике...

итак, сцены созданы и настроены, параметры перехода назначены, что дальше? За-
метим, что хотя презентация предполагает в основном возможность представления проек-
та «вне SketchUp», то же самое можно увидеть и в рабочем пространстве (окне моделиро-
вания), просто переходя между сценами, например кликами на их панелях-заголовках. По-
нятно, что такая возможность «предпросмотра» просто необходима и для уточнения различ-
ных настроек, отладки презентации. Причем в этом режиме можно переходить по сценам в 
любой последовательности (не обязательно по порядку их следования) – в любом случае 
«проезд» от сцены к сцене (точнее от камеры в одной сцене до камеры в другой) будет про-
исходить по кратчайшей прямой. Обратим внимание на это существенное обстоятельство – 
к нему мы еще вернемся чуть позже...

если хотим увидеть фильм в том виде, в каком он и будет сохранен в видеофайл, вклю-
чаем «проигрывание» анимации пунктом Play Animation контекстного меню панели-заголовка 
любой сцены. При этом появляется панель, через которую проигрывание можно «поставить 
на паузу» или выключить (до этого остальные опции и инструменты остаются недоступными):

Конечно, логичней запускать «проигрывание» с первой сцены, однако заметим, что 
здесь демонстрация «закольцована» в бесконечную «ленту», поэтому это не так существенно. 

Можно прийти к выводу, что доступных управляемых параметров анимации в SketchUp – 
предельный минимум, однако на самом деле эти возможности значительно шире, чем кажется 
на первый взгляд. дело в том, что поскольку этот механизм базируется на переходах по Сценам 
как ключевым кадрам, могут быть анимированы («плавно» изменяться на протяжении «фильма») 
и большинство параметров визуализации сцены. Разберемся подробней, как это работает, или 
– что можно анимировать?

Camera (Камера)
1. Позиция камеры («проезд» камеры между позициями в каждой сцене – по кратчай-

шей прямолинейной траектории).
2. направление взгляда (ракурс). 
3. Степень и направление зуммирования объектива.
4. FOV (Ширина поля взгляда).
Shadows (Тени)
По-другому можно сказать, что управляем солнечным освещением, меняя положе-

ние (направление) теней изменением параметров даты (месяц, число) и времени суток. Та-
кой анимацией, например, может быть показано при проектировании интерьера изменение 
солнечного освещения через оконные проемы в помещении в течение дня (от раннего утра 
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до позднего вечера). Аналогичная задача актуальна и при планировке территорий (напри-
мер, городской застройки), и в ландшафтном дизайне. Причем с учетом возможности уста-
новки географического местоположения (средствами геолокации), а также даты и времени 
суток в настройках теней эта имитация будет совершенно достоверна.

Sections (Разрезы)
возможность анимирования разрезов (см. тему 17 «Разрезы») очевидна из того факта, 

что это на самом деле тоже один из механизмов визуализации, то есть параметров камеры. 
Таким образом можно, например, очень эффектно показать внутреннее устройство объекта.

Принцип действия такой анимации прост: – в каждой из сцен показываем разные ак-
тивные разрезы, и в итоге при проигрывании «фильма» видим как бы плавный «проезд» от 
одного активного разреза до другого, от сцены к сцене. Разберем подробней, как это сде-
лать, на примере нашего тестового домика:

1. Создаем три разреза на разных уровнях от «земли» и три сцены.
2. в каждой из трех сцен включаем (делаем активным) один из трех разрезов и не 

забываем зафиксировать это в Update сцены. Кроме того, в сценах фиксируем настройки – 
должны быть включены Display Section Cuts (Показать сечения) и выключены Display Section 
Plans (Показать секущие плоскости). 

3. Запускаем проигрывание анимации – видим плавный «подъем» разреза от одного 
положения до другого, как бы последовательное «строительство» домика. 

WalkthrouGh (инсТруМенТЫ ПрОгулКи)
Прежде чем завершить чисто технические вопросы экспорта подготовленного про-

екта в виде «фильма», остановимся на очень важной теме – его «режиссуре». Что имеется 
в виду? Конечно, освещение вопросов профессионального «кинопроизводства» (начиная с 
грамотного сценария) не умещается в рамки нашего курса, поэтому остановимся только на 
дополнительных возможностях управления камерой. 

Как правило, первый же опыт создания «фильма» после просмотра готовой анимации 



111 Тема 25. УПРАвление ПРеЗенТАциЯМи

выявляет странные вещи – «взгляд» при переходе от сцены к сцене совершает непонятные 
кульбиты, объекты на время исчезают с экрана, камера «въезжает» во внутренние полости 
объектов и т. п. Почему это происходит? дело в том, что пока в каждой сцене мы научились 
выставлять камеру как для отдельного, как бы независимого снимка в «альбом» статичных 
имиджей, но здесь требуется еще и организовать переход к следующей сцене. Как это сде-
лать? Помним, что камера всегда «перемещается» между сценами по кратчайшему прямоли-
нейному пути, а отсюда следует, что нужно этот путь контролировать, однозначно обозначая 
траекторию «движения». для решения этих задач в SketchUp и предусмотрена специальная 
группа инструментов Walkthrough (Прогулки).

в отличие от уже знакомых инструментов аналогичного назначения, они предназначе-
ны прежде всего для имитации «человеческого» взгляда на сцену. А точнее – для имитации 
прогулки, прохода, проезда «зрителя» по построенному виртуальному трехмерному миру 
проекта. впрочем, это не отменяет возможности применения инструментов Прогулки в лю-
бых ситуациях, где требуется четкий контроль за камерой.

Панель инструментов Прогулки (если отсутствует в интерфейсе) открывается через 
меню View > Toolbars > Walkthrough. 

 
 position Camera (Позиция камеры)/look around (смот-

реть вокруг)
Эти два инструмента работают чаще всего в паре и используются для установки каме-

ры (точки взгляда) в назначенное место в сцене, на определенной высоте и с определенным 
направлением взгляда, что позволяет применять их для контроля (имитации) обзора сцены 
с точки зрения находящегося в этом месте наблюдателя. для этого:

1. Кликаем на кнопке инструмента Position Camera – в панели статуса появляется подсказ-
ка: «Select the camera position (Выберите позицию камеры)», а в панели Measurements – уста-
новленная по умолчанию величина Hight Offset (Высота подъема) камеры над «землей» – кра-
сно-зеленым планом осей. По умолчанию эта величина установлена, исходя из среднестатисти-
ческого роста человека. Можно сразу ввести свое значение, то есть как бы изменить рост на-
блюдателя, или, по-другому, – поднять/опустить камеру относительно уровня «земли». Хотя это 
же можно сделать и позже, после установки камеры на место.

2. Кликаем в нужном месте сцены (например, «земли» или «пола» в интерьере), уста-
навливая камеру на эту позицию. При этом происходит автоматический переход в режим 
инструмента Look Around, в котором при фиксированном (!) положении камеры по месту 
и высоте над «землей» можем имитировать взгляд человека, стоящего на месте и повора-
чиваю-щего голову вверх, вниз или вокруг себя по горизонтали, перемещением курсора 
инструмента в этих направлениях. или по-другому это можно преставить как взгляд через  
видоискатель камеры, которая установлена и поворачивается в любом направлении на шта-
тиве... При этом в панели Measurements видим теперь величину Eye Hight – высоту от земли 
глаз наблюдателя, которую можно изменить и на этом этапе, а в панели статуса подсказку: 
«Drag in direction to turn camera (Потяните в направлении поворота камеры)».

инструмент Look Around, естественно, можно включить и отдельно нажатием кноп-
ки инструмента – в любой момент и на любом этапе работы над проектом. 

есть и второй вариант позиционирования камеры и направления взгляда, называемый 
назначением целевой точки, который удобнее всего использовать по принципу «от одно-
го объекта до другого». например – буквально, как это показано на рисунке ниже, исполь-
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зуя объекты «камера» и «фотомодель». для этого:
1. Курсором инструмента Position Camera кликаем в точке установки камеры и, удер-

живая клавишу мышки, перемещаем курсор в целевую точку, то есть куда должен быть на-
правлен взгляд. При этом для контроля за опцией появляется точечная тянущаяся линия тра-
ектории взгляда.

2. Отпустив курсор, перемещаемся в вид сцены из назначенной точки на назначен-
ную точку (объект). При этом также происходит автоматический переход в режим инстру-
мента Look Around.

 Walk (Прогулка)
именно этот инструмент позволяет последовательно назначить маршрут движения (о 

чем говорили ранее) и направление взгляда в каждой точке этого маршрута. 
Помещаем курсор на кнопку инструмента – в панели статуса появляется подсказ-

ка: «Walk whith the camera» (Прогулка с камерой). Кликаем кнопку – включаем инстру-
мент – в панели статуса появляется подсказка: «Click and drag to walk» (Кликнуть и тянуть 
для прогулки) и еще три подсказки, о которых будет сказано далее. Кликаем курсором ин-
струмента на «земле» в месте начала маршрута – ставим камеру в эту точку. Курсор меняет-
ся на крестик указателя направления («прицел»), при этом видим величину Eye Hight в пане-
ли Measurements – это высота камеры над «землей», которую при необходимости меняем в 
соответствии с нашим операторским замыслом. А далее, удерживая клавишу мышки, тянем 
курсор «подошвы» в следующую точку маршрута прогулки: если выше крестика – двигаем-
ся вперед, ниже – назад, аналогично – влево/вправо. Причем чем дальше перетягиваем «по-
дошвы» от крестика, тем быстрее происходит движение. напоминает управление движени-
ем персонажа в компьютерных играх, не правда ли?

Следующая подсказка в панели статуса: «Ctrl = run» – о том, что при нажатой клави-
ше Ctrl «шаг» прогулки меняется на «бег», то есть просто ускоряем перемещение курсора. 
вторая подсказка в панели статуса «Shift = move verticaly or sideways» говорит о том, что 
при нажатой клавише Shift опция переходит в режим, при котором движение курсора впе-
ред/назад вместо перемещения будет поднимать/опускать камеру на месте. 

Заметим, что инструмент Walk для полной реалистичности показа прогулки по умол-
чанию поддерживает замечательную опцию «сопровождения» неровности поверхности, по 
которой мы «идем» (например, по ступенькам), то есть камера (высота взгляда) будет под-
ниматься или опускаться в нужных местах. Этот же механизм определяет непроходимые пре-
пятствия на пути следования, например не дает проходить сквозь стены. еще одна аналогия 
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с движением в компьютерных играх...
и последняя подсказка: «Alt = disable collision detection» – о том, что при нажатой кла-

више Alt отключается режим определения препятствий на пути движения камеры и прохода 
сквозь них. Эта возможность тоже необходима, поскольку иногда все-таки может потребо-
ваться, например при создании презентации прогулки по интерьеру с проходом сквозь стены. 

ну и, собственно, главное, что позволяет применить этот инструмент для полного 
контроля над траекторией движения камеры (наблюдателя), – каждую такую позицию фик-
сируем в отдельной сцене. Теперь гарантировано корректное отображение последователь-
ной «прогулки, проезда, прохода» по контролируемому маршруту (между сценами) и соот-
ветственно – записи фильма на их основе. 

Кроме того, в SketchUp включен основанный на этих механизмах плагин Advanced 
Camera Tools (ACT), который фактически дает возможность построить виртуальную модель 
съемочной площадки с разнообразной съемочной техникой и смоделировать операторско-
режиссерскую работу на съемках фильма. По умолчанию он выключен, и для того чтобы он 
появился в интерфейсе, включаем этот пункт в меню Window>Preferences>Extensions, по-
сле чего через меню View > Toolbars открывается панель инструментов ACT. в подробном 
руководстве: http://SketchUp.Google.com/support/bin/answer.py?answer=1219223 – можно 
ознакомиться с порядком работы плагина. 

Таким образом, видим, что SketchUp предоставляет более чем достаточный набор ин-
струментов для создания эффектного анимированного «фильма о проекте». 

FoG (ТуМан)
Этот самостоятельный инструмент наиболее подходит именно для стадии презентаций, 

позволяя получить красивый и достоверный эффект «глубины пространства». вы, вероятно, 
заметили, что при включении в настройках Стиля показа Sky (Неба) и Ground (Земли), даже с 
учетом их градиентой заливки цветом, все-таки смотрятся они весьма неестественно. Причи-
на понятна – «в жизни» не может быть такой четкой границы между землей и небом на линии 
горизонта, поскольку всегда присутствует атмосферная дымка, «размывающая» эту границу. 
инструмент Fog как раз и решает эту задачу, позволяя имитировать эффект тумана (или атмос-
ферной дымки), при котором удаленные объекты на больших пространствах выглядят более 
размытыми, затуманенными. 

Открываем меню Window > Fog, после чего появляется диалоговое окно, в котором 
доступны настройки опции:
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Display Fog (Показ тумана) – переключатель вкл./выкл. показа эффекта в сцене. 
Та же опция доступна через меню View > Fog.

Distance (Дистанция) – слайдер-регулятор границ (диапазона) эффекта: левый 
движок устанавливает ближнюю границу относительно камеры (точки взгляда), правый 
движок – самую удаленную границу максимальной плотности тумана, фактически грани-
цу видимости в сцене. Заметим, что при масштабировании показа сцены зуммированием 
или вращением камеры движки также будут автоматически двигаться, масштабируя на-
стройки эффекта по текущей точке взгляда.

Color (Цвет) – переключатель вкл./выкл. использования в эффекте цвета. во вклю-
ченном состоянии (ставим галочку) используется фон (Background), установленный в данный 
момент для сцены в диалоговом окне Styles. При снятой галочке, кликнув в окошке цвета, от-
крываем палитру, в которой можно назначить любой другой цвет для тумана. 

возможно (в зависимости от конфигурации вашего компьютера), что для качественно-
го отображения эффекта потребуется проверить, включена ли опция Window > Preferences 
> OpenGL > Use hardware acceleration. 

аниМаЦиЯ – заПись В фильМ
итак, фильм создан, отлажен... но пока доступен для просмотра только в самом 

SketchUp. для записи (сохранения) анимации в видеоформат открываем меню File > Export > 
Animation, в открывшемся диалоговом окне Export Type (Формат экспорта) выбираем Avi 
File (*.avi) и вводим имя файла. далее открываем окно настроек Options:

Здесь доступны для назначения (изменения) следующие параметры:
Width/Height) (Ширина/Высота) – размеры кадра в пикселях. известно, что видео-

файлы – одни из самых «тяжелых» цифровых форматов, и размеры кадра очень существенно 
влияют на «вес» файла, поэтому имеет смысл назначать минимально необходимые под кон-
кретную задачу. Здесь по умолчанию «замкнута цепочка» кнопки сохранения пропорций – при 
изменении одного из измерений имиджа соответственно будет меняться и второе. в окошке 
правее можем выбрать один из вариантов стандартных пропорций видеокадра – 4:3 или 16:9. 
если хотим отключить эту функцию, коротко кликаем на кнопке для «разрыва цепочки» – при 
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этом каждое из измерений становится возможным менять независимо друг от друга, то есть на-
значать свои габариты кадра. Однако этого лучше не делать, поскольку видеоформаты жест-
ко стандартизированы по пропорциям кадра.

Frame Rate (Показатель кадров) – выпадающий список выбора скорости записи/
воспроизведения – количества кадров в секунду (fps). Это ключевой фактор восприятия плав-
ности движения в фильме, который определяется психофизиологией зрения – для обычно-
го видео используется число 24, 25 или 30. Поскольку принятое число fps напрямую влияет 
на продолжительность видео, а значит, и на размер видеофайла, там, где возможно (напри-
мер, для учебных роликов), принято назначать этот параметр значительно меньшим, 10–16. 

Loop to Starting Page (Зацикливание на стартовую страницу) – опция созда-
ет дополнительный кадр перехода от последнего кадра (сцены) снова на первую, организуя 
непрерывный цикл воспроизведения видео. 

Play When Finished (Проиграть после завершения) – опция после завершения 
экспорта запускает воспроизведение созданного видеофайла на установленном в системе 
по умолчанию видеопроигрывателе для файлов avi. 

Codec (Кодек) – выбор для создаваемого видеофайла видеокодека компрессии/де-
компрессии. После нажатия на кнопку с установленным по умолчанию кодеком открывает-
ся окно со списком других поддерживаемых SketchUp кодеков и опциями их настроек. По-
следним пунктом в списке кодеков можно выбрать вариант отказа от использования кодека 
(без сжатия), что гарантирует его воспроизведение без проблем на любом другом компью-
тере, но... за это придется «расплачиваться» резким, а чаще – просто неприемлемым увели-
чением размера файла.

вообще, тема видеокодеков – отдельная и специфическая, поэтому здесь отметим 
только несколько ключевых понятий, связанных с ними. Прежде всего назначение и принцип 
работы кодека – уменьшение размера видеофайла за счет механизма сжатия (компрессии) 
при его записи и декомпрессии «на лету» тем же кодеком при его воспроизведении. Отсю-
да – главная проблема: если ваше видео должно быть воспроизведено на другом компью-
тере, на нем должен быть установлен тот же кодек, иначе нельзя гарантировать исключе-
ние проблем с воспроизведением. Здесь фактически есть два варианта решения – не углуб-
ляясь в проблемы видеокодеков, оставить кодек, предлагаемый программой по умолчанию, 
или вместе с видеофайлом передавать и сам использованный кодек. Понятно, что такое ре-
шение трудно назвать удачным, поскольку «зрителю» придется перед просмотром вашего 
видеоролика сначала устанавливать кодек в свой компьютер, что вряд ли его обрадует... 

на самом деле в последние годы появилась отличная возможность обойти все эти  
проблемы и обеспечить максимальное удобство передачи видео зрителю – так называемые  
«видеохостинги». Постоянному пользователю интернета наверняка знаком хотя бы один 
из них, самый популярный – YouTube.com, который позволяет любому пользователю загру-
жать туда свое видео, получать ссылку, сообщать ее зрителю, а тому – просматривать ви-
део в интернет-браузере.

Rendering > Anti-Alias – переключатель включения/выключения опции сглаживания 
«ступенек» граничных пикселей в имидже (аналогично опции в настройках экспорта графи-
ческих файлов). 

Always Prompt for Animation Options (Всегда выводить окно опций) – пере-
ключатель включения/выключения показа по умолчанию диалогового окна настроек при  
каждом открытии опции экспорта анимации. 

Defaults – опция «сброса» настроек до установленных по умолчанию.
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сериЯ ПОКадрОВЫх сниМКОВ
SketchUp, кроме создания анимации в виде единственного файла формата AVI, позво-

ляет создавать презентацию как серию покадровых (то есть с каждой сцены) имиджей. Та-
кая серия (англ. – image sequence) может быть использована для последующего монтажа из 
них фильма в стороннем видеоредакторе, или как слайд-шоу в презентационной програм-
ме, или просто для быстрого сохранения нескольких сцен проекта. Фактически этот вариант 
можно рассматривать как частный случай предыдущего – разница только в выборе формата 
экспорта, поскольку речь идет об аналогичном сохранении кадров-имиджей. 

Открываем меню File > Export > Animation, затем в диалоговом окне Export Type (Фор-
мат экспорта) выбираем (вместо AVI) один из 4 графических 2D-форматов (JPG, PNG, TIF или 
BMP). Открыв окно Options, видим аналогичный анимации набор настроек, за исключением, 
естественно, настроек видеокодека и проигрывания видеофайла. и (обратим внимание!) от-
сутствует и пункт настройки параметра Rendering > Anti-Alias. в итоге, после нажатия кнопки 
OK и указания места сохранения, получаем набор имиджей, которым автоматически присва-
иваются «номерные» имена в виде, например, XXXX.jpg. Понятно, что общее количество по-
лученных при этом снимков в серии (также, как и для анимации) зависит от назначенного ко-
личества кадров в секундах и параметров, установленных в панели Model Info  > Animation. 

Завершая рассмотрение технической стороны создания анимации «напрямую» из 
SketchUp, приходится констатировать, что это одно из самых «узких мест» программы... дело 
в том, что, кроме уже упомянутых выше ограничений этого механизма, качество «картинки» 
в большинстве случаев оставляет желать лучшего. То есть здесь имеем все те же проблемы 
(прежде всего – с качеством Anti-Alias линий), что и при экспорте статичной растровой гра-
фики, но только еще более «отягощенные» их движением, что выражается (как минимум) в 
неприятном «дрожании» линий – ребер объектов. Экспортом в покадровую серию имиджей 
эта проблема снимается, но остальные все-таки остаются...

и последнее – многие отсутствующие в SketchUp анимационные функции и возмож-
ности успешно реализованы в целом ряде специализированных плагинов... об этом подроб-
нее и далее в отдельной теме.

GooGle sketChup VieWer
Это еще один доступный способ демонстрации проектов SketchUp – свободная про-

грамма просмотра и распечатки, которую можно скачать отсюда: http://sketchup.google.com/
intl/en_uk/download/gsuviewer.html. на самом деле это фактически сильно урезанная версия 
того же SketchUp – без инструментов редактирования моделей и вообще без возможностей 
внесения каких-либо изменений. Теоретически предполагается, что Viewer намного проще 
в использовании для тех, кто незнаком со SketchUp, поэтому можно передать ее «клиенту» 
вместе с проектом, который теперь он сам сможет рассматривать как и сколько угодно...

Почему «теоретически»? Потому что, во-первых, на самом деле для человека, совер-
шенно незнакомого даже с навигацией в 3D-, «простота» весьма сомнительна. во-вторых, 
это связано с предварительной установкой на свой компьютер и освоением новой програм-
мы, в-третьих – все-таки для качественного просмотра (особенно «тяжелых» моделей) не-
обходима соответствующая видеокарта, наличие которой, скажем, на офисном компьюте-
ре сомнительно... список возможных затруднений «клиента» можно продолжать. Тем не ме-
нее, о такой возможности  представления своего проекта стоит знать – при каких-то обсто-
ятельствах это может оказаться и вполне подходящим решением... 
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Эта тема, завершающая изучение собственно SketchUp, специально выне-

сена в финальную часть изложения материала, что дает возможность уже совер-
шенно предметно рассмотреть вопросы рациональной организации рабочего про-
странства в текущем проекте и в программе в целом. Здесь мы, с этой точки зре-
ния, пройдем как по уже знакомым инструментам и опциям, так и по нескольким 
не вошедшим ни в одну из ранее изученных тем.

глаВнЫе Меню
Обычно изучение новой программы начинают именно с панели главных – текстовых 

меню, однако на протяжении нашего курса при изучении панелей инструментов и диалого-
вых окон конкретных опций постоянно приводились только отсылки на то, что те же фун-
кции управления доступны и через меню (дублируются в них). Со SketchUp такой подход бо-
лее логичен, поскольку в подавляющем большинстве ситуаций доступ к управлению через 
главные меню нельзя назвать самым рациональным с точки зрения быстроты и удобства. 
думаю, пояснений тут не требуется – на самом деле элементарное количество кликов мыш-
кой на протяжении работы над проектом в значительной степени влияет на общее время, 
затраченное на него!

Тем не менее полное содержание и возможности главных текстовых меню надо знать, 
тем более что некоторые функции доступны все-таки только отсюда. Пройдем обзорно по 
перечню уже знакомых и подробнее – по еще не рассмотренным...

File (файл)
New (Новый) – закрывает текущий документ и открывает область рабочего окна 

построения новой модели. При этом используются настройки файла шаблона, назначен-
ного в Window > Preferences > Template. если мы хотим одновременно открыть другой 
файл, придется еще раз запустить программу и открыть второй файл в ней, или (что ана-
логично) открыть файл из Проводника, так как одновременное открытие в одном сеансе 
нескольких файлов не предусмотрено.

Open... (Открыть) – открывает ранее сохраненный файл SketchUp. если уже загру-
жен файл (проект) и в нем произведены какие-либо изменения, будет предложено его 
сохранить перед закрытием и открытием другого. 

Save (Сохранить) – сохраняет текущий файл в указанное место. если попытаемся 
закрыть несохраненный документ, SketchUp предложит предварительно сохранить его.
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Save As... (Сохранить как) – сохраняет текущий файл как новый документ с любым 
новым именем и местом размещения, и (или) в любой из предыдущих версий (выбор – в рас-
крывающемся списке «Тип файла»). 

Save A Copy As... (Сохранить копию как) – сохраняет текущий файл на жесткий 
диск как вариант текущего с новым именем, если необходимо – с новым местом разме-
щения или в другой версии. имя назначается автоматически по принципу – к имени ори-
гинала добавляется порядковая цифра копии.

Save As Template... (Сохранить как шаблон) – сохраняет текущий файл на жест-
кий диск как шаблон, с сохраненными настройками которого будет открываться новый 
«пустой» проект через пункт New. 

Revert (Возврат) – возвращает текущий файл к последнему (предыдущему) со-
храненному состоянию. 

Send to LayOut (Передать в LayOut) – передает и открывает текущую модель в 
приложении LayOut.

Preview In Google Earth (Предпросмотр модели в Google Earth); 
Geo-location (Геолокация); 
Building Maker (Архитектор); 
3D Warehouse (Склад 3D-моделей)
Эти четыре пункта дублируют опции Инструментов Google (см. тему 23).
Import (Импорт) – импорт 3D-моделей из файлов других форматов в SketchUp.
Export (Экспорт) – экспорт моделей SketchUp в другие приложения в 3D- и 2D-

форматы или в анимацию. 
Print Setup... (Настройка печати) – вызывает стандартное диалоговое окно на-

стройки принтера.
Print Preview... (Предварительный просмотр печати) – вызывает диалоговое 

окно настроек распечатки модели. 
Print (Печать) – вызывает диалоговое окно, аналогичное предыдущему пункту, с 

некоторыми ограничениями возможностей настроек. 
Generate Report... (Генерировать отчет) – создает файл отчета по проекту (от-

дельным объектам или всем) с их атрибутами и числовыми значениями, который можно со-
хранить в форматы HTML или SCV.

далее следует список – «история» последних восьми файлов, которые открывались 
до этого в SketchUp. 

Exit (Выход) – закрывает текущий файл и рабочее окно SketchUp. 

еdit (редактирование)
Undo (Отменить) – отменяет последнюю команду рисования или редактирова-

ния. SketchUp позволяет отменять все команды (до 100 шагов назад ) в любое время до 
момента сохранения файла. 

Redo (Повторить) – возвращает последнюю отмену в ее предыдущее состояние. 
Cut (Вырезать); Copy (Копировать); Paste (Вставить) – стандартные опции ра-

боты Windows с буфером обмена.
Paste in Place (Вставить на место) – вставляет содержимое буфера обмена в то 

же место сцены, откуда оно было скопировано или вырезано.
Delete (Удалить) – удаляет все выбранное.
Delete Guides (Удалить опорные элементы) – удаляет все ранее созданные раз-
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меточные элементы (конструкционные линии и точки) в области моделирования.
Select All (Выбрать все) – выбирает одновременно все доступные элементы мо-

дели. 
Select None (Отменить выбор всего) – отменяет все опции выбора (снимает вы-

бор со всех объектов) в сцене. 
Hide (Скрыть) – скрывает (выключает показ) любого выбранного элемента. 
Unhide (Отменить скрытие) – опция, обратная предыдущей – включает показ 

скрытых ранее элементов, в том числе в подменю доступны варианты: Selected – выбран-
ных элементов; Last – элементов, скрытых последней командой Hide; All – всех элемен-
тов, скрытых командой Hide.

Lock (Фиксировать) – «закрывает» любые Компоненты или Группы от перемеще-
ния или редактирования. 

Unlock (Снять фиксацию) – опция, обратная предыдущей – «открывает» любые 
ранее «закрытые» компоненты или группы.

Make Component (Создать компонент) – создает Компонент из выбранных эле-
ментов. 

Make Group (Создать группу) – создает Группу из выбранных элементов.
Close Group/Component (Закрыть группу/компонент) – закрывает текущий от-

крытый режим редактирования внутри Компонента или Группы. 
Intersect Faces (Пересечение поверхностей) – создает сложные объекты за счет 

образования новых поверхностей, образующихся при пересечении двух построений, в 
том числе с выбором вариантов в подменю: With Model (С моделью); With Selection (С 
выбранным); With Context (С содержимым).

Тип выбранного – содержат большинство возможных команд манипуляций теку-
щим (выбранным) элементом построений или объектом. Фактически аналог контекстно-
го меню на этом же объекте. 

 
View (Виды)
Toolbars (Панели инструментов) – открывающиеся подменю показа/скрытия па-

нелей инструментов:
Getting Started (Начальный набор инструментов)
Large Tool Set (Большой набор инструментов)
Camera (Камера)
Construction (Конструкционные)
Solid Tools (Твердотельные инструменты)
Drawing (Рисование) 
Face Style (Стили отображения поверхностей) 
Google (Инструменты Google)
Layers (Слои) 
Measurement (Измеритель) 
Modification (Модификации) 
Principal (Основные) 
Sections (Разрезы) 
Shadows (Тени) 
Standard (Стандартные) 
Views (Виды) 
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Walkthrough (Прогулка) 
Save Toolbar Positions (Сохранить позиции панелей инструментов)
Restore Toolbar Positions (Восстановить позиции панелей инструментов)
Задержимся на этих двух новых для нас пунктах (опциях). 
в SketchUp всегда имела место одна «врожденная» проблема – при принудительном  из-

менении размеров (пропорций) окна программы, в том числе стандартными кнопками Windows 
(от «Развернуть» к «Свернуть в окно» в правом верхнем углу), или при изменении размеров кно-
пок (View > Toolbars > Large Buttons), или при попытке перетаскивания (добавления) панелей 
инструментов верхних рядов, их порядок размещения «разрушается» непредсказуемым образом. 
А главное – автоматически не восстанавливается при возврате в предыдущее состояние, так что 
исправить ситуацию можно только ручным перетаскиванием панелей по своим прежним местам. 

Отсюда – типичный вопрос пользователей: – можно ли как-то закрепить панели на 
своих местах в постоянном (нужном, привычном) порядке? К сожалению, приходится отве-
тить, что полноценно – нет... Точнее, в 8-й версии разработчики частично решили пробле-
му как раз этими двумя рассматриваемыми опциями – если сохранить позиции панелей пер-
вой опцией, то затем, после «разрушающих» изменений, можно восстановить их исходное 
положение второй опцией. Однако, к сожалению, есть существенное  ограничение данных 
полезных опций – они действуют только в рамках текущего, открытого сеанса программы! А 
при новом открытии программы (файла) в любом случае работает только один общий прин-
цип – открытия интерфейса в том виде, в котором он был закрыт в предыдущем сеансе (про-
екте, файле) программы...

Dinamic Components (Динамические компоненты) 
Sandbox (Песочница) – чтобы этот пункт появился в меню, опцию необходимо пред-

варительно включить в меню Window > Preferences > Extenions > Sandbox Tools.
Shadow Strings Fix (Исправление ошибки теней)
включение кнопки исправляет ошибку рендеринга теней на объекте, которая может 

возникать в ситуациях, когда сама камера находится в тени какого-либо объекта. Особенно 
явно этот дефект может проявляться в анимации в виде непредсказуемых «мерцающих» зате-
нений наблюдаемого объекта. Чтобы этот пункт появился в меню, опцию необходимо пред-
варительно включить в меню Window > Preferences > Extenions > Shadow Strings Fix Toolbar.

Solar North (Север). Опцию следует предварительно включить в меню Window > 
Preferences > Extenions > Solar North Toolbar.

Large Buttons (Большие кнопки) – переключатель между двумя возможными ти-
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поразмерами кнопок инструментов (опций).

Scene Tabs (Заголовки сцен) – переключатель показа/скрытия заголовков создан-
ных сцен проекта в области моделирования. 

Hidden Geometry (Скрытая геометрия) – переключатель показа/скрытия по-
строений или элементов, которым перед этим была назначена невидимость опцией Hide 
(Скрыть). 

Section Planes (Показ плоскости разреза) – переключатель показа/скрытия пло-
скости разреза.

Section Cut (Показ отсеченного объема) – переключатель показа/скрытия отсе-
ченных разрезом объемов объекта.

Axes (Оси) – переключатель показа/скрытия основных осей сцены.
Guides (Разметочные элементы) – переключатель показа/скрытия всех разме-

точных вспомогательных линий и точек построений.
Shadows (Тени) – переключатель показа/скрытия теней в сцене. 
Fog (Туман) – переключатель показа/скрытия опции эффекта тумана (атмосфер-

ной дымки) в сцене.
Edge Style (Стиль ребер) – открывающиеся вправо подменю – переключатели 

показа/скрытия ребер и возможных стилей их отображения: Edges (Ребра); Back Edges  
(Рабра сзади); Profiles (Профильные ребра); Depth Cue (Утолщенные ребра); Extension 
(Удлиненные ребра).

Face Style (Стиль поверхностей) – открывающиеся вправо подменю – пере-
ключатели показа/скрытия стилей отображения (рендеринга) поверхностей: X-ray (Рент-
ген); Wireframe (Каркасы); Hidden Line (Линейный); Shaded (Затененный); Shaded with 
Textures (Затененный с текстурами); Monochrome (Бесцветный) 

Component Edit (Редактирование компонентов) – открывающиеся вправо 
подменю – переключатели вариантов показа/скрытия элементов при редактировании 
компонентов: Hide Rest of Model (Скрыть модель) – остальных объектов сцены; Hide 
Similar Components (Скрыть аналогичные компоненты) – аналогичных вставок редак-
тируемого компонента.

Animation (Анимация) – открывающиеся вправо подменю опций работы со сцена-
ми и анимацией: Add Scene (Добавить сцену) – добавление новой сцены в текущий проект; 
Update Scene (Обновить сцену) – сохранение текущих изменений в сцене при переходе к дру-
гой; Delete Scene (Удалить сцену) – удаление открытой сцены в текущем проекте; Previous 
Scene (Предыдущая сцена) – переход на предыдущую по порядку сцену; Next Scene (Сле-
дующая сцена) – переход на следующую по порядку сцену; Play (Запуск) – стартует проиг-
рывание анимации; Settings (Настройки) – открывает панель настроек параметров анима-
ции в проекте (диалоговое окно Window > Model Info > Animation).

Camera (Камера) 
Previous (Предыдущая точка взгляда); Next (Следующая точка взгляда) – ко-

манды отмены последней установки точки взгляда (возврата к предыдущей/последующей). 
Текущая точка взгляда автоматически сохраняется при перемещении камеры к следующей.

Standard (Стандартные проекции)
Открывающиеся подменю доступа к стандартным (предварительно установлен-

ным) точкам взгляда или проекциям: Iso (Изометрия), Top (Сверху), Front (Спереди), 
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Right (Справа), Back (Сзади), Left (Слева) и Bottom (Снизу). 
Parallel Projection (Параллельные проекции) 
Переключатель на обзор сцены в параллельных проекциях. Снятие галочки ана-

логично включению следующего пункта меню.
Perspective (Перспектива) – переключатель между Перспективной и Парал-

лельной проекциями. Снятие галочки аналогично включению предыдущего пункта меню. 
Two-Point Perspective (Двухточечная перспектива) – вариант перспективной 

проекции, при которой имеются только две точки схода, а все вертикальные линии па-
раллельны между собой и синей (вертикальной) оси. 

Match New Photo (Новый сеанс совмещения с фото); Edit Matched Photo (Ре-
дактировать совмещение с фото) – переход к опциям Match Photo).

Orbit (Вращение) – инструмент вращения камеры вокруг наблюдаемого объек-
та на фиксированном расстоянии.

Pan (Панорамирование) – инструмент перемещения камеры параллельно объ-
екту (плоскости экрана) на фиксированном расстоянии от наблюдаемого объекта; 

Zoom (Лупа) – инструмент увеличения или уменьшения изображение объекта за 
счет зуммирования объектива.

Field of View (Поле взгляда) – инструмент расширения или сужения ширины 
поля взгляда объектива (фокусного расстояния) при фиксированном положении камеры.

Zoom Window (Окно увеличения) – инструмент установки границ окна прос-
мотра. 

Zoom Extents (Показать все) – инструмент показа всех объектов сцены однов-
ременно.

Zoom to Photo (показать на все фото) – показ сцены в границах фонового 
фото в сеансе Match Photo.

Position Camera (Позиция камеры) – инструмент размещения камеры в опре-
деленном месте сцены. 

Walk (Прогулка) – инструмент управляемой траектории прогулки по сцене. 
Look Around (Смотреть вокруг) – инструмент осмотра сцены «вокруг себя» – 

вращения камеры при фиксированном положении камеры на «земле». 
Image Igloo – одна из опций работы с сервисом  Google Building Maker (см. тему 

23 «Google. Геолокация»).
Animation – запуск и остановка встроенного плагина «облета» модели. Появля-

ется в интерфейсе, если включен пункт Ruby Script Examples (Примеры скриптов Ruby) в 
меню Window > Preferences > Extensions. 

Draw (2D-рисование)
Line (Линия) – инструмент рисования линейных элементов (ребер объектов). 
Arc (Дуга) – инструмент рисования дуговых (арочных) элементов.
Freehand (От руки) – инструмент рисования мышкой нерегулярных, свободных 

кривых в пространстве сцены.
Rectangle (Прямоугольник) – инструмент рисования четырехугольных фигур 

(поверхностей).
Circle (Окружность) – инструмент рисования правильных окружностей (круго-

вых поверхностей).
Polygon (Многоугольник) – инструмент рисования регулярных многоугольных 
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фигур (поверхностей), вписанных в круг и содержащих от 3 до 100 сторон (ребер). 
Box (Ящик) – встроенный пример действия простого плагина – построение тако-

го рода объекта «в один клик». Появляется в интерфейсе, если включен пункт Ruby Script 
Examples (Примеры скриптов Ruby) в меню Window > Preferences > Extensions. 

Sandbox (Песочница) – в открывающихся подменю доступны два инструмента 
этой группы – начальных построений: From Contur (Из контуров) и From Scratch (Из линий).  
Появляется в интерфейсе, если включен пункт меню Window > Preferences > Extenions > 
Sandbox Tools. 

tools (инструменты) 
Select (Выбрать) – инструмент выбора одного или нескольких элементов для их 

последующих модификаций.
Eraser (Ластик) – инструмент удаления линий (ребер) построений. используется 

также для их скрытия или сглаживания.
Paint Bucket (Палитра) – инструмент для назначения или редактирования мате-

риалов поверхностей построений. 
Move (Перемещение) – инструмент перемещения, искажения, копирования лю-

бых элементов построений и вращения Компонентов и Групп.
Rotate (Вращение) – инструмент вращения отдельных элементов и объектов, а 

также перекашивания или искажения построений их частей. 
Scale (Масштабирование) – инструмент изменения размеров и искажения вы-

бранных построений относительно их исходных параметров и других элементов модели.
Push/Pull (Толкать/Тянуть) – инструмент создания новых объемов на основе вы-

талкивания (вытягивания) их из поверхностей. 
Follow Me (Следуй за мной) – инструмент выталкивания (вытягивания) новых 

объемов из поверхностей вдоль направляющей – любой линии или ребра поверхности. 
Offset (Контур) – инструмент создания копий линий и новых поверхностей на на-

значаемом расстоянии от оригинала (внутрь или наружу).
Outer Shell (Внешняя оболочка) – инструмент «слияния» нескольких твердотель-

ных (сплошных) объектов в один объем. 
Solid Tools (Инструменты сплошных тел) – инструменты модификаций твердо-

тельных (сплошных) тел. в открывающихся подменю доступны варианты действий (инстру-
ментов): Intersect (Отсечение), Union (Объединение), Subtract (Вычитание), Trim (Обрез-
ка), Split (Разделение)

Tape Measure (Рулетка) – инструмент линейных измерений, в том числе рассто-
яния между двумя точками, создания Конструкционных линий и точек, а также пропорци-
онального масштабирование объектов на точную величину. 

Protractor (Транспортир) – инструмент измерения углов и создания Конструкци-
онных линий – сторон угла.

Axes (Оси) – инструмент изменения положения (ориентации) основных осей сце-
ны или Компонентов. 

Dimensions (Размеры) – инструмент нанесения размерных элементов на объек-
ты построений с автоматическим выводом их размеров.

Text (Текст) – инструмент создания текстовых элементов (выносок, пояснений и 
т. п.). 

3D Text (3D-текст) – инструмент создания трехмерного текста. 
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Section Plane (Разрезы) – инструмент создания секущей плоскости разреза. 
Interact (Взаимодействие с динамическим компонентом) – запуск действий, 

назначенных выбранному динамическому Компоненту.
Sandbox (Песочница) – инструменты создания и модификаций рельефов (сложных 

криволинейных поверхностей). Чтобы этот пункт появился в меню, его необходимо включить 
из меню Window > Preferences > Extenions > Sandbox Tools. в открывающихся вправо под-
меню доступны варианты действий (части из этих инструментов): Smoove (Присоска), Stamp 
(Штамп), Drape (Драпировка), Add Detail (Добавить детали), Flip Edge (Отразить ребро).

Utilities (Утилиты) – активирует встроенные скрипты (плагины). Чтобы этот пункт 
появился в меню, его необходимо включить из меню Window > Preferences > Extenions > 
Utilities Tools. в открывающихся подменю доступны: Create Face (Создать поверхность) – 
создает поверхность внутри замкнутых ребер 2D-фигуры, если она не образовалась ав-
томатически или была до этого удалена.  Query Tool (Инструмент запроса) – выводит те-
кущие координаты курсора и доступную информацию по элементам построений под кур-
сором в окошко рядом с курсором и в Measurements.

К обширной теме скриптов-плагинов обратимся далее, а по этим можно сказать 
только, что они включены в комплект программы скорее как демонстрация возможно-
стей этого «жанра», чем из соображений практической необходимости... 

Window (Окно)
Model Info (Инфо по модели) – открывает диалоговое окно для назначения ос-

новных настроек текущего проекта. все его пункты – параметры – были рассмотрены ра-
нее по ходу изучения конкретных отдельных тем.

 

Entity Info (Инфо по элементу) – открывает диалоговое окно информации и на-
значения «внутренних» настроек выбранного элемента построений.

Materials (Материалы) – открывает диалоговое окно выбора, назначения, ре-
дактирования и организации Материалов.

Components (Компоненты) – открывает диалоговое окно выбора, назначения, 
редактирования и организации Компонентов. 

Styles (Стили) – открывает диалоговое окно назначения, редактирования и ор-
ганизациия Стилей в проекте. 
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Layers (Слои) – открывает диалоговое окно управления Слоями в модели.
Outliner (Структура) – открывает диалоговое окно показа и управления струк-

турой (иерархическим деревом) Компонентов и Групп в проекте. 
Scenes (Сцены) – открывает диалоговое окно (Менеджер) выбора, назначения, 

редактирования и организации Сцен. 
Shadows (Тени) – открывает диалоговое окно управления Тенями в сцене. 
Fog (Туман) – открывает диалоговое окно управления эффектом Тумана (атмо-

сферной дымки).
Match Photo (Совмещение с фото) – открывает диалоговое окно управления 

опциями Совмещения с фото.
Soften Edges (Сглаживание ребер) – открывает диалоговое окно управления 

опциями визуального смягчения и сглаживания ребер в построениях. 
Instructor (Инструктор) – открывает диалоговое окно инструктажа по работе с не-

которыми из выбранных инструментов в виде анимации и краткой текстовой информации. 
Preferences (Основные настройки) – открывает диалоговое окно назначения ос-

новных настроек программы. Подробно – далее в отдельном разделе, завершающем тему.
Hide/Show Dialogs (Скрыть/Показать диалоговые окна) – переключатель 

одновременного временного скрытия/показа всех текущих диалоговых окон на рабо-
чем столе программы. 

Ruby Console (Консоль Ruby) – открывает окно консоли для написания и отлад-
ки скриптов программным языком Ruby API.

Component Options (Опции компонента), Component Attributes (Атрибуты 
компонента) – окна контроля и управления Динамическими Компонентами.

Photo Textures (Текстуры из фото) – открывает окно браузера 3D-интернет-сер-
виса Google – Street View (Просмотр улиц). 

plugins (скрипты – Подключаемые модули)
Обратим внимание, что по умолчанию этот пункт в строке главных меню отсутствует! 

А чтобы он появился, надо в меню Window > Preferences > Extensions включить пункт Ruby 
Script Examples (Примеры скриптов Ruby). После чего увидим в нем как минимум скрипт 
Cost (Стоимость). Коротко по нему замечу только, что «в теории» Cost предназначен для 
назначения «цен» на материалы и элементы построений модели... и непригоден для нашей 
реальной практики.

Таким образом, пункт включает в себя скрипты-плагины в составе программы по умол-
чанию, и в дальнейшем, при установке пользователем новых плагинов, большая часть из них 
доступна именно из этого меню.

help (Помощь)
Предоставляет доступ к справочным и учебным материалам по программе. 
Welcom to SketchUp – открывает то же окно «приглашения» входа в программу, 

которое встречает нас при первом запуске SketchUp. 
Help Center (Центр on-line-справки) – открывает доступ к этому ресурсу на офи-

циальном сайте Google SketchUp. По умолчанию вы попадаете на англоязычную страни-
цу, на русском языке аналогичную можно открыть по адресу http://SketchUp.Google.com/
support/?hl=ru.

Learn about Ruby Plugins – открывает доступ к интернет-ресурсу на официаль-
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ном сайте Google SketchUp по теме плагинов Ruby. 
Contact us (Контакт) – открывает официальный сайт Google SketchUp.
License (Лицензионная инфо) – открывает ряд подменю управления лицензи-

рованием, авторизацией и тому подобных опций программы. 
Check for Update (Обновление) – открывает доступ к информации по online-

обновлениям текущей версии программы. 
About SketchUp (О SketchUp) – открывает окно с информацией по версии и дру-

гим параметрам установленной программы. 

preFerenCes (ОснОВнЫе насТрОйКи) 
Как уже не раз упоминалось ранее, это диалоговое окно включает в себя основ-

ные настройки, которые действуют по умолчанию до их изменения на другие во всех се-
ансах программы. Как и для Model Info, часть его функций была изучена ранее в конкрет-
ных темах опций и инструментов (для таких далее будет приведено только название и 
назначение), однако осталось несколько еще не рассмотренных очень важных опций – 
о них подробно:

applications (Приложения) – назначение растрового редактора (из уста-
новленных в системе – требуется указать путь в файловой системе к пусковому файлу про-
граммы) для редактирования «на лету» растровых текстур материалов.

Compatibility (совместимость)
Component/Group Highlighting (Подсветка компонентов/групп): 
Bounding box only (Только габариты) – переключатель стиля «подсветки» габаритов 

при выборе групп и компонентов: каждого из составляющих элементов или только общего 
габарита группы или компонента. 

Mouse Wheel Style (Стиль колесика мышки) – Invert (Обратное) – переключатель 
направления действия на обратное в опции зуммирования (приближения и удаления) каме-
ры при вращении колесика трехкнопочной мышки. Можно сказать, что вряд ли стоит ме-
нять установленные настройки по умолчанию, если только это не покажется обоснованным 
по каким-то личным предпочтениям (привычкам).

Drawing (рисование)
Click Style (Стиль клика) – назначение вариантов реакции мышки на клик пере-

ключателями:
Click-drag-release (Кликнуть-потянуть-отпустить) – включение этой опции действует 

на инструмент Line следующим образом: кликнуть для назначения стартовой точки линии, 
удерживая клавишу, потянуть курсор до конечной точки линии, отпустить клавишу для за-
вершения рисования; 

Auto Detect (Автоопределение) – вариант по умолчанию, при котором программа 
позволяет использовать как предыдущую, так и следующую схему работы с мышкой. его и 
рекомендуется оставить, поскольку практика показывает, что это самый логичный и удоб-
ный вариант;

Click-move-click (Кликнуть-переместить-кликнуть) – включение этой опции действу-
ет на инструмент Line следующим образом: кликнуть и отпустить клавишу мышки для назна-
чения стартовой точки линии, переместить мышь, растягивая линию, кликнуть снова в ко-
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нечной точке линии для завершения рисования; 
Continue Line Drawing (Продолжить рисование линии) – включение этой опции дей-

ствует на инструмент Line (Линия) следующим образом: стартовая точка новой линии авто-
матически назначается в конечной точке предыдущей, что обеспечивает их непрерывное 
рисование. 

Miscellaneous (Разное): 
Display crosshairs (Показ перекрестья) – включение этой опции добавляет к инстру-

менту рисования перемещающееся вместе с ним перекрестье осей соответствующих цветов. 
Disable pre-pick on Push/Pull Tool – выключение (по умолчанию включена) опции работы 

инструмента в варианте с предварительным кликом – указанием поверхности «вдавливания/
вытягивания» (подробно об этом варианте см. книгу 1, тему 5 «Инструменты модификаций»).

extensions (расширения)
Панель включения/выключения меню и панелей инструментов дополнительных опций 

и плагинов, как уже включенных в SketchUp, так и новых, устанавливаемых вами самостоя-
тельно, и которые по умолчанию отсутствуют в интерфейсе. вспомним, что в соответствую-
щих темах инструментов (плагинов) уже неоднократно приводились отсылки к этой панели.

Обратите внимание на кнопку Install Extension (Инсталлировать расширение) – че-
рез нее устанавливаются плагины, которые представлены их авторами в виде специального 
формата-архива – .RBZ. Это самый удобный способ установки, поскольку при этом происхо-
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дит автоматическая корректная распаковка в нужные программные папки, избавляющая от 
необходимости делать это вручную. 

Files (файлы)
Панель используется для назначения мест размещения файлов по умолчанию в не-

скольких типичных опциях, фактически – указания «стартовых точек» при каждом открытии 
или сохранении файлов: Models (Модели), Components (Компоненты), Materials (Матери-
алы), Styles (Стили), Texture Images (Имиджи текстур), Watemark Images (Имиджи водя-
ных знаков), Export Models (Экспорт моделей). естественно, можно назначить в этих окош-
ках свои пути, или просто каждый раз при каждом открытии/сохранении файлов показывать 
нужные папки.

две кнопки внизу окна позволяют загружать сохраненные ранее (Import…) и сохра-
нять текущие (Export…) настройки File Locations (Размещение файлов) и Shortcuts (Клавиа-
турные сокращения (см. далее об этом пункте) в специальном файле preferences.dat. Что и 
где сохранять, можно выбрать при импорте (экспорте) в закладке Options….

General (главные)
Эта панель используется для назначения главных (глобальных) настроек сохранения 

файлов и элементов интерфейса программы.
Saving (Сохранение):
Create Backup (Создавать копию предыдущего сохранения) – включенная (в том чи-

сле по умолчанию) опция автоматического создания резервных копий предыдущих сохране-
ний файла. Эти файлы, в отличие от «обычного» сохранения (*.skp), имеют формат *.skb. Та-
кое стандартное решение, типичное для большинства программ, позволяет избежать без-
возвратных потерь уже проделанной части работы, поэтому, конечно, имеет смысл держать 
опцию включенной.

Auto-Save (Автосохранение) – включенная (в том числе по умолчанию) опция авто-
матического сохранения изменений во временном файле через определенный промежу-
ток времени (вводим нужный в окошке). Эти файлы сохраняются при нештатном (аварий-
ном) завершении программы в файловой системе в той же папке, что и оригинал с именем 
«AutoSave...имя файла.skp». естественно, имеет смысл держать и эту опцию всегда включен-
ной... Кстати, надо заметить, что со SketchUp это происходит очень редко, что говорит еще 
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об одном его чрезвычайно важном для пользователя достоинстве – стабильности и надеж-
ности работы. Кроме того, в процессе автосохранения программа автоматически проверя-
ет построение на наличие неисправимых ошибок, предотвращая перезапись корректного 
сохраненного файла. если в модели будут обнаружены такие ошибки, открывается диало-
говое окно с инструкциями. 

Однако с автосохранением возможна одна проблема, которую следует учитывать. 
дело в том, что установленный по умолчанию параметр (через каждые 5 мин.) может, осо-
бенно при открытии очень больших и сложных проектов («тяжелых» файлов), вызвать так 
называемый «резонанс сохранений». в чем это выражается? возникает ситуация, когда файл 
еще полностью не загрузился, а автосохранение уже заработало... Понятно, что это приво-
дит к тупиковому «зацикливанию» в бесконечное сохранение, то есть практически к оста-
новке работы. выход прост – увеличить этот параметр до 15 – 30 минут.

Check Model For Problems (Фиксация проблем в модели):
Automatically check models for problems (Автоматическая фиксация проблем в мо-

дели) – переключатель активирует автоматическую проверку и оптимизацию модели при за-
грузке или сохранении файла. Аналогичная функция (Fix Problems) доступна «принудитель-
но» и через меню Window > Model Info > Statistics. 

Automatically fix problems when they are found (Автоматическое исправление най-
денных проблем) – переключатель активирует автоматическое исправление проблем (без 
вывода сообщений о них на экран). Конечно, имеет смысл держать и эти две опции всегда 
включенными.

Scenes and Styles:
Warn of style changes when creating scenes (Предупреждать об изменениях при со-

здании сцены) – переключатель включает напоминания о том, что, создавая новую сцену, 
надо сохранить изменения в текущей. Эти опции нам уже знакомы – дублируют аналогичные 
в диалоговых окнах Scenes и Styles.

Software Updates (Обновления программы): 
Automaticaly check for updates (Автоматически проверять на наличие обновлений) – 

при появлении новых версий программы будет выведено окошко с соответствующей инфор-
мацией. Требует подключения к интернету.



130 Тема 26. УПРАвление ПРОеКТОМ

openGl – панель назначений параметров системного графического «движка» 
OpenGL, под которым и работает программа, для оптимизации отображения графики в окне 
моделирования.

напомню, что эти настройки, важные с самого начала работы в SketchUp, были по-
дробно рассмотрены в первой книге (тема 9 «Рабочая визуализация»), поэтому здесь повто-
ряться не будем. 

shortcuts (Клавиатурные сокращения)
Панель назначения клавиатурных сокращений (иногда называемых «горячими кла-

вишами») для подавляющего большинства опций (функций) SketchUp. вам такая возмож-
ность наверняка знакома и по другим программам... Часть из них уже назначена по умол-
чанию – видим их, например, в открытых списках меню правее текстовых пунктов. А эта 
панель дает возможность переназначить сокращения по своим предпочтениям и (или) на-
значить новые, для чего: 

1. выбираем в списке Function (Функция) ту, которой хотим присвоить клавиатурное 
сокращение. для быстрого отбора определенных функций удобно использовать окошко 
Filter(Фильтр). например, если хотите назначить сокращение какой-либо опции из меню 
Window, начинаем вводить буквы Win... – по ним будут «отфильтрованы» названия соот-
ветствующих функций, а остальные не будут отображаться в списке.

2. Переходим в окошко Add Shortcut (Добавить клавиатурное сокращение), вво-
дим нужную клавишу (или сочетание клавиш).

3. Подтверждаем назначение кнопкой (+) – назначенное появляется в окошке 
Assigned (Назначение).

Могут быть использованы почти все буквенные и цифровые клавиши (за некоторы-
ми редкими исключениями – об этом далее) в различных сочетаниях. и кроме того – с кла-
вишами модификаций Shift, Ctrl, Alt. При назначении следим, чтобы не произошла путаница 
с буквенными и другими символами, которые используются при вводе значений и обозна-
чений с клавиатуры в Measurements, например буквы S, R, X, символы «/» и «*». из этих же 
соображений не используем клавиши Spacebar и Backspace. в любом случае SketchUp выво-
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дит соответствующее предупреждение, если такая комбинация клавиш уже задействована в 
клавиатурных сокращениях или не может быть использована по указанным выше причинам. 

две кнопки внизу окна позволяют загружать сохраненные ранее (Import…) и сохра-
нять текущие (Export…) настройки Shortcut в специальном файле preferences.dat анало-
гично рассмотренной ранее панели Files. 

Следует заметить, что использование клавиатурных сокращений, безусловно, явля-
ется мощным средством ускорения работы (вспомним еще раз про количество кликов)... 
Однако надо понимать, что на самом деле это будет верно только в случае их постоянно-
го, доведенного до автоматизма применения! Поэтому можно рекомендовать не увлекать-
ся назначением многих десятков клавиатурных сокращений, а использовать тот действи-
тельно необходимый минимум, который реально можно запомнить и постоянно применя-
ете в своей практике...

template (шаблоны)
Панель выбора шаблона используется для назначения основных настроек исход-

ного состояния программы, которое будет автоматически загружаться в новых (создавае-
мых опцией File > New) файлах SketchUp. Тот же шаблон будет использован и при откры-
тии программы (файл с именем Untitled). Прежде всего видим список шаблонов, включен-
ных в программу по умолчанию (аналогично стартовому окну открытия SketchUp). в самом 
начале нашего курса мы уже рассматривали выбор из этих шаблонов, исходя только из вы-
бора единиц измерения, однако на самом деле в шаблоне сохраняются настройки всех (!) 
параметров, доступных из диалоговых окон Model Info, Style и Shadow. Кроме того, в со-
ставе шаблона сохраняются и созданные в нем построения, что и видим (персонаж Susan) 
в готовых шаблонах, включенных в программу.

Отсюда следует, что можно создать свой шаблон, наиболее подходящий под ваши 
типовые задачи, с сохранением в нем основных параметров «оформления» проекта. А еще 
рациональней создать несколько шаблонов, например один – максимально «легкий» (с ми-
нимальной нагрузкой на визуализацию), рабочий – для начального моделирования, и вто-
рой – с вашей любимой манерой «подачи» (стили линий, поверхностей, текстов, настрой-
ки теней и прочего). 

итак, сохраняем подготовленный файл (File > Save as Template...) со своим именем 
(например, «Мой рабочий.skp») – по умолчанию он будет помещен в программную папку C:\
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Program Files\Google\Google SketchUp 8\Resources\en-US/ Templates. Кроме того, видим в 
панели кнопку Browse... (Просмотреть), через которую можно открыть и назначить в каче-
стве шаблона любой файл из любой папки в файловой системе (по умолчанию сначала от-
крывается папка Templates). Это возможно потому, что на самом деле шаблон – это любой 
обычный файл SketchUp, указанный «в этой роли» в списке шаблонов (причем необязатель-
но из папки Templates). 

иногда у пользователей возникает вопрос – а что же с настройками из диалогового 
окна System Preferences, сохраняются ли они с шаблоном? нет, эти параметры независимы 
от системы шаблонов и действуют одинаково при открытии любого из них.

еще один типичный вопрос: – а можно ли «поменять» шаблон на другой из списка, не 
выходя из текущего сеанса программы? нет, через эту панель назначается и «запоминает-
ся» ваш выбор шаблона для будущих открытий программы, но не для текущего сеанса. Та-
ким образом, открыть файл, выполненный в одном шаблоне, в параметрах другого шаблона 
можно только загрузив файл импортом в открытый сеанс SketchUp с нужным шаблоном. По 
этой же логике открытие ранее сохраненного файла означает, что он откроется в SketchUp 
с настройками шаблона, в котором этот файл (проект) был создан. 

еще одно обстоятельство (и ответ на типичный вопрос): – к сожалению, в шаблоне 
не сохраняется набор и расположением диалоговых окон и панелей инструментов... Как уже 
было сказано ранее – при открытии программы (файла) в любом случае работает только 
один общий принцип: – интерфейс появляется в том виде, в котором он был закрыт в пре-
дыдущем сеансе (проекте, файле) программы.

и последнее – имеет смысл сохранять свои настройки программы в отдельном архи-
ве с файлами preferences.dat (см. выше об опциях его импорта и экспорта) и файлами шабло-
нов для их использования в последующих инсталляциях программы, иначе при переустанов-
ке SketchUp они будут утеряны безвозвратно.

Workspace (рабочее пространство)
в этой панели доступны только две простые функции:

Use large toolbuttons – SketchUp поддерживает два размера кнопок на палитрах 
инструментов: большой (large) по умолчанию и уменьшенный (что позволяет увеличить об-
ласть моделирования), и эта опция выполняет переключение между размерами (дублирует 
аналогичное действие меню View > Toolbars > large Buttons).

Workspace (Рабочее пространство) – кнопка «сброса» вида интерфейса до исход-
ного (по умолчанию) состояния, а фактически просто закрывает все отрытые до этого диа-
логовые окна.
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Эта завершающая тема нашего курса посвящена наиболее типичным во-
просам и проблемам, через которые, осваивая SketchUp, проходят практически 
все пользователи. И конечно, – рекомендациям по способам их решений на ос-
нове наработанного практического «багажа» опытных «скетчаперов»... то есть 
тому, что часто в учебной литературе обозначают как «секреты, хитрости, трю-
ки...». Рассмотрим еще непосредственно связанную с этими вопросами тему скрип-
тов-плагинов к SketchUp, а также взаимодействия SketchUp с другими программа-
ми – «партнерами». 

несмотря на все достоинства SketchUp, обладающего уникальными возможностями 
простого, удобного, быстрого, универсального инструмента 3D-моделирования, налицо и тот 
факт, что его инструментальные средства, по сравнению с «тяжелыми» редакторами «полно-
го цикла», ограничены весьма жесткими рамками «жанра». А потому для профессионально-
го уровня работы необходимо свободное владение всеми инструментами SketchUp и рацио-
нальными приемами их применения. не менее важно умело использовать не только штатные 
и очевидные, но и все доступные дополнительные средства повышения функциональности 
SketchUp. Так, возможности и приемы применения инструментов не всегда «лежат на повер-
хности» или отсутствуют даже в официальной документации к программе, а плагины-скрип-
ты расширяют диапазон применения и усиливают мощь редактора «в разы». все это позво-
ляет опытному пользователю находить оптимальные решения конкретной текущей задачи, 
а значит – получать очень важную возможность максимально сосредоточиться на самой ин-
тересной, творческой части работы. 

Пытаться полностью осветить все возможные вопросы, обозначенные в этой теме, – 
задача просто нереальная, хотя бы из-за того, что области применения, частные случаи и ха-
рактер задач, решаемых пользователями SketchUp, бесконечно разнообразны. Кроме того, 
буквально ежедневно в интернете на форумах «скетчаперов» можно найти новые интерес-
ные решения, приемы, плагины и т. п. Поэтому не остается другого варианта, как исходить 
из собственных опыта, предпочтений и оценок и познакомить читателя с той информацией 
по «секретам» работы в программе, которая представляется типичной, универсальной, ин-
тересной, полезной и практичной. 

Провести четкие тематические границы по обозначенному содержанию такого пла-
на достаточно сложно, поэтому здесь лучше всего подходит наверняка знакомая читателю 
форма так называемых FAQ (Frequently Asked Questions) – ответов на наиболее часто зада-
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ваемые вопросы. Таким образом, дальнейшее изложение будет представлено по принципу 
«вопрос – ответ» с произвольным порядком следования... 

Что такое плагины (скрипты) к SketchUp, где их искать, как выбирать, 
устанавливать, рационально применять... и так далее?

Одно из весомых достоинств SketchUp – возможность расширения функциональных 
возможностей за счет использования скриптов-плагинов (подключаемых дополнительных 
программных модулей) на основе относительно простого свободного языка программиро-
вания Ruby API. С ним пользователи могут самостоятельно создавать фактически мини-про-
граммы, автоматизирующие выполнение определенных опций и задач, и включать их в ин-
терфейс SketchUp. Благодаря такой открытости за годы существования программы написа-
ны многие сотни скриптов-плагинов (как правило, – энтузиастами-«скетчаперами»), которые 
доступны для свободного скачивания через интернет. вообще же, диапазон тем скриптов 
очень широк – от автоматизации простых опций «в один клик» до реализации принципиаль-
но новых и нетипичных для SketchUp механизмов, которые скорее можно назвать дополни-
тельными самостоятельными программными модулями, встраиваемыми в интерфейс SketchUp. 

А теперь по порядку:
1. Полную информацию по технической стороне вопроса те, кого интересует эта 

тема, могут найти в интернете по адресу: http://SketchUp.Google.com/support/bin/answer.
py?answer=114282.

2. Самый короткий путь поиска необходимого скрипта – «скетчаперские» интернет-
форумы, на которых к тому же можно следить за новостями (в том числе обновлениями, но-
выми версиями), задать вопрос и получить самый быстрый ответ по конкретной задаче – на-
пример, на русском: http://stroyka.in; на английском: http://www.sketchucation.com/forums/
scf. Стоит еще особо отметить, пожалуй, самый полный специализированный тематический 
«архив» скриптов: http://rhin.crai.archi.fr/rld/plugins_sections.php. 

и здесь еще раз нельзя не коснуться темы «русификаций» – очевидно, что для лю-
бителей работы в этом варианте SketchUp очень многие актуальные пути совершенствова-
ния (и программы, и своего профессионального уровня) остаются недоступны или очень за-
труднены... 

3. Поскольку скрипты в общем случае – просто текстовые файлы (с расширением .rb), 
для их установки, как правило, достаточно скопировать файл скрипта в программную пап-
ку Plugins (Подключаемые модули), и при последующем открытии программы они появля-
ются в интерфейсе. Хотя есть и более сложные конструкции, например со своей структу-
рой папок, своими панелями инструментов (кнопками). Примерно та же ситуация с запуском 
скриптов – как правило, они появляются дополнительным пунктом в меню Plugins, чаще всего  
дублируются в контекстных меню, однако есть и такие, которые запускаются из других меню 
или своими кнопками на своих дополнительных панелях инструментов. в любом случае, всег-
да авторами скриптов включается в их состав инструкция по установке и применению, с ко-
торой, конечно, следует ознакомиться. 

4. есть и определенные проблемы работы с плагинами, которые надо иметь в виду. Как 
уже было сказано, доступно огромное количество разнообразных скриптов, а потому пра-
ктически под каждую задачу (или группу задач) можно найти подходящий, но отсюда налицо 
и «оборотная сторона медали» – сложности поиска и выбора, тем более что многие скрипты 
по функциям дублируются или близки друг другу. Кроме того, этот процесс все время в дви-
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жении: – постоянно появляются все новые, авторы выпускают обновленные версии старых 
– по этой причине даже назвать их точное число сложно... Поскольку в абсолютно подавля-
ющем числе скрипты – бесплатные любительские продукты программного творчест-ва раз-
ных авторов – «скетчаперов»-энтузиастов, неизбежны разные подходы к устройству управ-
ления (интерфейсам), разные уровни сложности освоения и работы, удобства, надежности 
и т. д. Здесь же можно заметить, что нередко отличные по задумке и назначению скрипты так 
и остаются в состоянии скорее бета-версий (то есть не работают корректно в отдельных си-
туациях), чем полноценных рабочих инструментов. немало и практически бесполезных, на-
значение которых и соображения автора при их написании объяснить достаточно сложно... 

Поэтому, прежде чем устанавливать новый плагин, имеет смысл оценить смысл ра-
боты с ним в принципе – иногда за внешней привлекательностью скриптовой «автоматиза-
ции» скрываются такие сложности освоения и настроек, что бывает проще (или быстрее) ту 
же задачу решить штатными инструментами SketchUp. Тем более если речь идет не «конвей-
ере» аналогичных моделей, а о разовой задаче. надо заметить, что в этой теме, к сожале-
нию, существует и еще одна характерная тенденция – начинающие пользователи при пер-
вом же затруднении пытаются найти выход вопросом: «А есть ли такой плагин, которым мож-
но сделать...». Причем, как правило, очень быстро выясняется, что проблема просто в не-
знании возможностей основных инструментов SketchUp... в принципе, можно условно раз-
делить все доступные скрипты на две большие группы. Первую условно назовем «универ-
сальными» или даже «повседневными» – как правило, это простейшие (но очень полезные) 
дополнения к штатным инструментам, работающие «в пару кликов мышкой». Соответствен-
но, их применение не вызывает никаких затруднений. вторая группа – намного более слож-
ные (в том числе в освоении), специализированные под определенные задачи. Причем неко-
торые из них по набору функций и сложности уже ближе к самостоятельным программам...

Так как же рационально организовать порядок работы со скриптами? Опять прин-
цип минимальной достаточности... Устанавливайте только тот проверенный минимум, кото-
рый действительно вам необходим постоянно, плюс – наиболее подходящие для текуще-
го проекта. Соответственно, после завершения и перехода к другому проекту (другого ха-
рактера задач) удаляем старый набор и устанавливаем новый. Чтобы каждый раз не проде-
лывать эти манипуляции вручную в программных папках SketchUp, удобно создать сразу, на  
«чистой» установке программы, резервную копию папок Plugins и Tools (иногда скриптами 
задействуется и она) и быстро возвращаться к исходному состоянию программы заменой их 
содержимого. Аналогичным образом можно создать и использовать несколько вариантов 
своих рабочих наборов скриптов (этих папок) под разные задачи.

в любом случае, не стоит без разбора устанавливать все скрипты, которые «попа-
даются под руку», – это неизбежно в какой-то момент приведет (как минимум) к замедле-
нию загрузки и работы SketchUp. Кроме того, иногда возникает и проблема совместимости 
в SketchUp установленных «рядом» разных скриптов, что проявляется в их отказе или некор-
ректной работе. да и загромождение рабочего пространства лишними, редко используемы-
ми кнопками вряд ли имеет смысл... 

и последнее. Чтобы не загромождать текст интернет-ссылками (на авторов и адреса, 
откуда можно скачать плагины), в «вопросах – ответах», где приводятся их обзоры, упомина-
ются только названия скриптов. А остальную информацию, если она вас интересует, можно 
будет без труда найти в интернете по ссылкам, упомянутым в пп. 1 и 2.
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Что влияет на время запуска сеанса SketchUp? Иногда открытие даже 
одного и того же файла может происходить быстро, а иногда почему-то явно мед-
ленней...

Мы уже говорили о том, что в любом случае программа при закрытии «запоминает», 
а при открытии восстанавливает ситуацию с набором и расположением панелей инструмен-
тов и диалоговых окон из предыдущего сеанса. Отсюда – прямая зависимость времени, ко-
торое требуется для их загрузки и восстановления положения в интерфейсе при открытии 
программы... Особенно существенно влияние диалоговых окон с большими объемами дан-
ных (например, библиотеками Materials, Components), а поэтому полезно принять за правило 
перед закрытием файла (и сеанса программы) закрывать и открытые диалоговые окна. А для 
выполнения этой процедуры в один клик удобно через окно настроек Window > Preferences 
> Shortcuts назначить и использовать «горячую клавишу» для опции Window > Hide Dialogs 
(Закрыть все диалоговые окна). Причем эта же возможность не менее полезна и в текущем 
сеансе работы для быстрого скрытия и показа в нужный момент диалоговых окон.

Кроме того, любители интерфейса со множеством дополнительных панелей инстру-
ментов, «пришедших» с установленными десятками плагинов, также неизбежно получают 
аналогичную проблему...

Почему после открытия SketchUp: экран пуст; не работают некоторые 
инструменты; инструмент Select выбирает не тот элемент, на который указываю, 
или вообще ничего не выбирает; ребра и поверхности явно «повреждены»... (воз-
можны и другие варианты)?..

Такие симптомы (некоторые показаны на рис. выше) указывают на одну из самых бо-
лезненных проблем – конфликты аппаратной визуализации в программе. Мы знаем, что ви-
зуализация (рендеринг) в SketchUp происходит в режиме realtime, то есть одновременно с 
процессом моделирования в реальном времени, с использованием системного графическо-
го движка OpenGL, который работает под управлением видеокарты. А здесь налицо несов-
местимость видеокарты (или ее драйвера) со SketchUp, со всеми вытекающими последствия-
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ми... Чтобы однозначно убедиться в этом, проверяем окно Window > Preferences > OpenGL. 
Здесь при нормальной работе по умолчанию должны быть включены пункты Use Hardware 
Acceleration (Использовать аппаратное ускорение), то есть задействованы ресурсы виде-
окарты и Use Fast Feedback (Использовать быструю обратную связь). если же при выклю-
чении этих пунктов указанные выше симптомы исчезают, наше предположение оправдалось 
– проблема в видеокарте... Что делать? для начала попробовать найти и поменять драйвер 
видеокарты на другой, а если и это не снимает проблемы, скорее всего придется подбирать 
другую видеокарту по рекомендациям, которые уже упоминались (тема 9 «Рабочая визуали-
зация»), поэтому здесь повторяться не будем. 

Иногда на экране вдруг возникает такая странная картина... Это тоже 
проблема видеокарты?

Ситуация, с который рано или поздно сталкивается каждый пользователь: переме-
щаете камеру вокруг модели и вдруг видите странную картину на мониторе – часть моде-
ли как будто «отсекается» некой невидимой плоскостью, параллельной плоскости экрана. 
Прежде всего не надо беспокоиться – это никакого отношения к разрушению, поврежде-
нию модели не имеет: – с построением ничего не происходит. 

Это известная «врожденная» проблема программы, имеющая даже имя собственное – 
Camera Clipping Plane (Резка плоскостью камеры), которая может проявиться в определен-
ном сочетании ракурса камеры и величины зуммирования. Причины и способы исправления:

1.  FOV (Ширина поля взгляда) очень большая, близкая или равная максимальной 
(120 град.). Уменьшаем через меню Camera > Field of view или мышкой – Shift+Zoom.

2.  выключена перспективная камера (снята галочка на пункте меню Camera > 
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Perspective) или, что аналогично, – включена параллельная (галочка на Parallel Projection). 
изменяем величину зуммирования колесиком мышки, или кнопкой Zoom Extents «откаты-
ваемся» на показ всей сцены целиком. надо заметить, что вообще такой «изометрический» 
вид смотрится совершенно неестественно, поэтому все-таки логичней работать либо в стан-
дартных ортогональных видах, либо в перспективных.

3.  Модель расположена очень далеко от нулевой точки начала осей (origin point). Пе-
ремещаем модель (выбрав все – например, командой Ctrl+A) к началу осей.

4.  Модель масштабируется к очень маленькой или очень большой абсолютной вели-
чине. Меняем коэффициент масштабирования.

У меня мощный современный компьютер (в том числе по параметрам 
видеокарты), все рекомендации по «облегчению» интерфейса выполнены, но все 
равно – если в начале моделирования в новом проекте все работает отлично, то 
с постепенным усложнением сцены любое действие сопровождается заметным 
«подтормаживанием», и чем дальше, тем больше... 

Какие можно еще рекомендовать способы, приемы, общие принципы мо-
делирования в SketchUp, позволяющие решать эту проблему и ускорять работу?

Как уже упоминалось, «тяжелые» проекты, – пожалуй, главная проблема SketchUp, и 
умение ее избегать принципиально важно для быстрой, эффективной, да и просто прият-
ной работы. 

начнем с очевидного факта, что SketchUp изначально был разработан и предназначен 
для эскизного, поискового 3D-моделирования, прежде всего в архитектурном проектиро-
вании, или более широко – в техническом. для таких объектов характерна достаточно про-
стая геометрия, в основе которой – прямая линия, дуга, круг и «регулярные» объемы на ос-
нове куба, шара, цилиндра и т. п. Отсюда – низкополигонные (low-poly) механизмы 3D-моде-
лирования программы, действие которых выражается в том, что при превышении доволь-
но невысокого уровня сложности геометрии (количества поверхностей и ребер) начинают-
ся проблемы «подтормаживания» текущей перерисовки сцены на экране.

Самый объективный механизм контроля за фактической сложностью модели для 
программы – таблица статистики (Window > Model Info > Statistics), и здесь же располо-
жен самый быстрый механизм «чистки» уже неиспользуемых (ненужных), но пока хранящих-
ся в файле проекта данных – опция Purge Unused. Отсюда – первый и самый общий прин-
цип моделирования в SketchUp, которому в текущей работе надо просто постоянно следо-
вать. его можно сформулировать очень коротко: – «ничего лишнего!», – и применять по не-
скольким направлениям: 

степень детализации:
Заметим, что конечная цель любого 3D-проекта – не просто линии, объемы и объек-

ты, а некий виртуальный мир со всем своим наполнением и оформлением, который в итоге 
должен быть представлен максимально наглядно и эффектно в виде имиджа, анимации, чер-
тежей и т. п. Поэтому очень важно умение правильно оценивать необходимый уровень де-
тализации отдельных частей и объектов, ведь окончательный итог моделирования – все-та-
ки некая 2D-картинка (или анимация), представляющая сцену. Речь идет о том, что часто из-
лишне детально простраивается малозначащая, мелкая часть, подробности геометрии кото-
рой на общем виде сцены будут попросту неразличимы! Понятно, что требуется совершен-
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но разный уровень проработки деталей, скажем, в проекте дизайна дверной ручки и ручки 
на дверях в проекте интерьера. Как ни странно, но часто одна из причин таких ситуаций – 
неверная оценка фактических размеров и значимости деталей объекта по увеличенному ин-
струментом Zoom масштабу изображения. 

в итоге при неоправданно высокой детализации, кроме раздражающей некомфорт-
ности работы, получаем и непроизводительные потери времени, да и просто бесполезное 
увеличение размера файла проекта. Кроме того, если модель будет далее использоваться 
в других 3D- программах (например, – рендерах), излишняя сложность построения еще раз 
проявится во времени чтения, обработки геометрии и в целом – времени работы и в них. 

Кроме того, есть задачи, в которых нерациональная детализация может ввести в пол-
ный ступор не только низкополигонный SketchUp, но и мощный Hi-Poly редактор. Более того, 
зачастую вообще 3D-моделирование отдельных деталей не имеет смысла! Представим, что 
строим корпус корабля с клепаной обшивкой и пытаемся моделировать каждую из тысяч 
заклепок... Такие проблемы решаются уже совсем другими средствами – нанесением соот-
ветствующих текстур, причем, при несоизмеримо меньших «затратах» визуальный результат 
будет практически тот же (если не лучше). но это уже другая тема...

симметрия, компоненты:
для многих объектов моделирования, особенно технических, характерно наличие яв-

ной симметрии, точнее оси (плоскости) симметрии, относительно которой стыкуются две оди-
наковые части (прямая и зеркальная). Умение видеть такую особенность объекта позволяет 
ее очень выгодно использовать как для точности построения, так и для уменьшения разме-
ра файла – вообще, этот прием характерен для моделирования практически во всех 3D-ре-
дакторах. в SketchUp это реализуется «выявлением» и моделированием одной из таких сим-
метричных частей и тут же – созданием из нее компонента. 

дальнейших пояснений, пожалуй, не требуется, заметим только, что хотя на сложно-
сти геометрии мы при этом не экономим, но на размер файла (в зависимости от количества 
«повторений») такой прием может влиять весьма значительно. А кроме того, получаем воз-
можность эффективно использовать главное преимущество механизма компонентов – од-
новременного редактирования «внутренних» свойств всех его вставок за счет редактиро-
вания оригинала.

Поверхности сложной кривизны:
Стоит обратить особое внимание на построение криволинейных поверхностей – фак-

тически вариаций на тему цилиндра и шара, поскольку очевидно, что количество «строитель-
ных» элементов особенно резко нарастает при их построении. Моделирование таких объ-
ектов начинается с исходных плоских фигур – дуг и окружностей, и при этом многие поль-
зователи автоматически используют стандартные исходные значения количества сегментов 
для инструмента Аrc – 12 и Сircle – 24, забывая о возможности предварительно изменять эти 
значения (сразу после выбора инструмента) на меньшие, в большинстве случаев ничуть не 
ухудшая качества отображения модели. 

Заметим, что если сделать это (контролируем число в панели Measurements), парамет-
ры будут действовать и далее в текущем файле при последующих применениях Аrc и Сircle. 
То есть на эти настройки имеет смысл обратить внимание, прежде всего если далее надо 
будет работать с такого рода фигурами и объектами. 

в примере (на рис. ниже слева) оба цилиндра после сглаживания опцией Soften/Smooth 
Edges выглядят практически одинаково, хотя на самом деле правый, построенный на осно-
ве стандартного числа сегментов окружности, содержит вдовое больше элементов, чем ле-
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вый. во втором примере (на рис. ниже справа) – аналогичное сравнение полушарий, постро-
енных на окружностях выдавливанием сектора инструментом Follow Me (также с разными ко-
личествами сегментов), еще более показательно: разница в 4 раза (1729 и 433 элемента!).

 

«дробление» поверхностей:
нарисуем по существующей поверхности еще одну или несколько линий с конеч-

ным точками на внешних ребрах – если нам требуется разбить цельную поверхность на ча-
сти для каких-то дальнейших целей, смысл таких действий понятен, а если нет? Тогда полу-
чаем только совершенно бесполезные лишние элементы – чтобы убедиться в этом, можем 
безболезненно удалить такие ребра (при этом две поверхности просто «сольются» в одну), 
поскольку имеем так называемые coplanar поверхности – то есть смежные, лежащие в од-
ной плоскости. При построении объектов «с нуля» в SketchUp аналогичную нежелательную 
ситуацию можно получить также за счет неточностей построения, когда конечные точки ли-
ний, лежащих на поверхностях, не примыкают к другим элементам, а вот при импорте 3D-мо-
делей (особенно в формате .3ds), созданных в других редакторах, эта проблема достаточно 
типична и, главное, неуправляема. выявить такие линии можно, если включить в Edge Style 
показ профильных линий (Profiles) – при этом они будут отображаться явно более жирными, 
чем «внутренние», действительно разделяющие coplanar поверхности. 

При этом заметим, что «ручная» чистка излишней геометрии проекта при всей ее ак-
туальности – задача весьма трудоемкая и непростая, поэтому имеет смысл в качестве посто-
янно установленных плагинов иметь приведенные ниже (или один из них):

 deletecoplanaredges.rb
ФУнКциЯ: Удаление в выбранном лишних (между coplanar поверхностями) ребер и 

бесполезных «независимых» линий на поверхностях (не являющихся ребрами поверхностей).
УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
1. выбор нужных ребер и поверхностей (объекта). 
2. Контекстное меню > Delete Coplanar Edges (Удалить coplanar поверхности).
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cleanup_model.rb
ФУнКциЯ: Удаление лишних (между coplanar поверхностями) ребер и бесполезных 

«независимых» линий на поверхностях (не являющихся ребрами поверхностей) во всей мо-
дели (файле), то есть предварительный выбор объектов не требуется.

УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
Меню Edit > Remove Unused Edges (Удалить неиспользуемые ребра).
При применении этих плагинов надо быть внимательным – все-таки происходит суще-

ственное изменение геометрии... так что не помешает предварительно сделать сохранение 
файла, тем более что опцией Undo не всегда удается восстановить предыдущее состояние 
модели. и второе, о чем надо помнить, – если в построении были использованы Coplanar 
Edges, разделяющие разные материалы, то в результате «слияния» поверхностей один из ма-
териалов будет утерян. 

«строительный мусор»:
Стоит выработать твердую привычку сразу удалять временные, промежуточные эле-

менты построений. Типичная ситуация такого совершенно неоправданного и бесполезного 
«утяжеления» модели особенно часто возникает, когда внутри, под внешней (видимой) по-
верхностью завершенного объекта остаются ребра и поверхности, образовавшие в ходе 
работы, – а ведь в итоге они будут просто не видны! например, имеем некую обрешетку из 
брусьев, обшитую плоским листом, – естественно, поверхности брусьев, примыкающие к 
листу, никогда не будут видны в собранной конструкции, а значит, их можно удалить. Конеч-
но, при этом нужно следить за тем, чтобы не произошло разрушение соседних, нужных эле-
ментов. К такому же «строительному мусору» можно отнести и конструкционные (разметоч-
ные) линии, созданные инструментом Measurement (Рулетка), – их также имеет смысл пери-
одически удалять в ходе работы (удобнее всего сразу все опцией Edit > Delete Guides) и тем 
более после завершения моделирования.

Тени, материалы, стилевое оформление:
Как ни хочется скорее увидеть модель «во всей красе», однозначно имеет смысл на 

этапе начальных построений прежде всего отключить показ теней, поскольку именно меха-
низм их просчета создает одну из основных нагрузок на текущий рендеринг при каждом пе-
ремещении камеры. из тех же соображений не следует торопиться назначать материалы – 
все-таки это не более чем «отделочные работы», которые, как известно, выполняются по-
сле завершения основных, общестроительных. Прежде всего это касается текстур на осно-
ве импортируемых растровых имиджей, которые (в отличие от простой «окраски» цветом) 
могут значительно «утяжелять» файл проекта и также замедлять текущий рендеринг. Стоит 
обратить внимание и на «вес» таких текстур, который складывается из их габаритов и разре-
шения – зачастую для качественного отображения в SketchUp достаточно вполне скромных 
величин. не имеет смысл без необходимости снимать ограничение размера текстур (вклю-
чать пункт Use Maximum Texture Size (Window > Preferences > OpenGL).

Стилевые «излишества» оформления ребер и поверхностей также значительно вли-
яют на скорость визуализации – откладываем их на финальный этап работы над проектом. 
Замедление рендеринга может также происходить и при отображении прозрачных мате-
риалов – по крайней мере, проверяем, чтобы параметр качества прозрачности был уста-
новлен на Faster.
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Показ/скрытие:
Механизм текущей визуализации SketchUp работает по принципу: «что вижу на экра-

не в данный момент, то и просчитываю», а отсюда следует, что самое рациональное и эф-
фективное решение – просто временно скрывать все, что в данный момент не нужно. К тому 
же (кроме снятия одной из основных вычислительных нагрузок на систему) это в некоторых 
случаях единственный способ получить удобный доступ к текущему участку работы, закры-
тому другими элементами. 

для этих опций SketchUp имеет более чем достаточно специальных механизмов, преж-
де всего – «оперативное» скрытие/показ любого элемента или объекта опцией Hide/Unhide. 
и конечно, это еще два более мощных «многоцелевых» механизма скрытия/показа объек-
тов сцены, связанных к тому же и с рациональной организацией проекта в целом и в фина-
ле – презентационными возможностями – Layers (Слои) и Scenes (Сцены).

Почему иногда при завершении рисования (замыкании ребер) плоской 
фигуры поверхность «не хочет» образовываться? То же происходит всегда (!) при 
импорте векторных фигур из других редакторов, например CorelDraw.

Как известно, для автоматического образования поверхностей в SketchUp достаточно 
замкнуть три или более ребра, обязательно лежащих в одной плоскости. если же поверхность 
не образовалась, это однозначный сигнал о том, что одна из конечных точек линии оказалась 
смещенной из плоскости будущей поверхности. или налицо «недоведенность» конечных то-
чек линий до других элементов, что также не дает возможности замкнуть фигуру и образовать 
поверхность или правильно завершить другие типы построений. на самом деле эта конкрет-
ная ситуа-ция иллюстрирует одну из самых принципиальных и «тяжелых» ошибок при рабо-
те в SketchUp – неточность, неаккуратность построений. Почему «тяжелых»? Как правило, на-
копление таких ошибок (по «цепочке» примыкающих друг к другу элементов), а затем поиск 
и попытки их исправления рисованием дополнительных линий чаще всего в итоге приводят к 
необходимости переделки уже выполненной работы заново. 

важно с самого начала освоения SketchUp помнить, что, несмотря на свой внешне 
эскизный характер, программа на самом деле имеет все качества полноценного CAD-редак-
тора в части точности построений и просто не допускает понятий «примерно, приблизитель-
но»... Причем соблюдать эти требования не составляет никакого труда, поскольку SketchUp 
обладает замечательно организованной системой графических и текстовых подсказок по за-
действованным в данный момент инструментам и опциям. Те же принципы точного примыка-
ния элементов геометрии актуальны при перемещениях, простановках размеров, модифици-
ровании существующих объемов и др. – достаточно просто внимательно следить за подсказ-
ками, подтверждающими правильность выполнения опции.

По второй части вопроса – да, это «врожденная» особенность импорта «стороннего» 
вектора в SketchUp, и здесь только одно решение – требуется «подсказать» программе необ-
ходимость создания поверхности внутри ребер рисованием на одном из них (в любом месте) 
дополнительного отрезка линии произвольной длины.

Кроме того, можно рекомендовать очень полезный плагин, который, кроме решения 
указанной проблемы создания поверхности, еще и создает из отдельных сегментов единый 
элемент, что, понятно, удобно для его последующего выбора и использования с другими оп-
циями, особенно с Follow Me:



143 Тема 27. ЗАдАЧи и РеШениЯ. ПлАГинЫ. ПРОГРАММЫ-ПАРТнеРЫ

weld.rb 
 ФУнКциЯ: 
1. Объединение выбранных линий незамкнутых криволинейных фигур в единую за-

мкнутую за счет создания крайнего, «связующего» сегмента. 
2. Создание поверхности внутри замкнутого контура фигуры. 
УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
1. выбираем фигуру.
2. Меню Plugins > Weld (Объединить). 
По запросу «Close curve (Замкнуть кривую?)» замыкает контур, по запросу «Finde 

face for this curve (Создать поверхность для кривой)?» автоматически создает (или нет, 
если не требуется) поверхность внутри ее контура. Замкнуть можно любую (по ориентации 
в пространстве сцены) кривую, а поверхность, естественно, может быть образована толь-
ко из контура, образованного coplanar (лежащими в одной плоскости) сегментами линий.

 Есть ли более быстрые способы смены сторон внешней/внутренней 
поверхности (frontface/backface), чем стандартный (выбор и контекстная опция 
Reverse Faces)?

для ускорения этой рутинной процедуры можно рекомендовать не забывать о  
существовании еще одной штатной удобной опции: выбираем на объекте любую правильно 
ориентированную поверхность, вызываем кликом правой клавиши на ней контекстное меню 
и включаем пункт Orient Faces – все смежные поверхности («по цепочке», начиная с указан-
ной), должны также принять ее ориентацию. Заметим, что все-таки и эта опция не всегда сра-
батывает правильно и однозначно, поэтому можно рекомендовать более «элегантный» ва-
риант – быстрый и удобный плагин:

frontface.rb
ФУнКциЯ: 
изменение оборотных сторон поверхностей (backface), оказавшихся на внешних (ви-

димых) гранях объектов, на правильные, внешние (face).
УСТАнОвКА: содержимое папки «FrontFace» копируем в папку Plugins.
КАК РАБОТАеТ: 
1. включаем нажатием новой кнопки плагина на панели инструментов , выключа-

ем выбором любого другого инструмента.
2. Проводим (не нажимая кнопки мышки!) курсором по backface поверхностям, кото-

рые автоматически исправляют ориентацию на правильную обратную – лицевую. 
Поскольку на правильные frontface поверхности скрипт просто не действует, в итоге 

очень быстро и удобно получаем нужный результат.

Почему на некоторых объектах «не хотят» образовываться поверхно-
сти или при редактировании формы объекта в поверхностях образуются неустра-
нимые «дыры», хотя вроде бы все условия соблюдены? 

Эту проблему мы уже упоминали в теме импорта – разберемся с ней подробно. Одно 
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из самых ценных качеств SketchUp – четкая и точная привязка моделирования к понятным фи-
зическим размерным величинам. При этом «верхний предел» виртуального мира проекта пра-
ктически неограничен – хотя бы квадратные километры... А вот с «нижнем пределом» сущест-
вуют определенные проблемы, что проявляется в неожиданном появление «разрывов, дыр»  
в криволинейных поверхностях мелких объектов. Как правило, возникают они на таких объек-
тах при использовании инструмента Follow Me и опций Intersection. Аналогичные дефекты могут 
проявиться и при импорте объектов, созданных в высокополигонных моделерах, для которых 
характерно большое количество мелких полигонов на поверхностях сложной кривизны. и глав-
ное – эти дефекты чаще всего невозможно исправить (закрыть) обычным методом «подсказ-
ки» – рисованием дополнительного отрезка инструментом Line на каком-либо ребре «дыры». 

на рисунке ниже слева показана попытка построить купольный объем выдавливани-
ем сегмента по пути-окружности диаметром в 10 мм инструментом Follow Me. Как видим, на-
лицо дефект – «недостроенный» купол, а если еще уменьшить размеры исходных элемен-
тов, инструмент вообще не срабатывает. на рисунке справа показан результат пересечения 
(Intersect) двух цилиндров, построенных на той же окружности, – как видим, образовалась 
зона неустранимых разрывов на границе пересечения поверхностей. 

Объясняются эти неприятные явления тем, что SketchUp имеет нижний предел площади 
распознавания поверхности в 0,001 квадратного дюйма, а отдельные полигоны детализиро-
ванной модели могут оказаться меньше этой величины. Проблема досадная, но решить (обой-
ти) ее можно простым приемом – построением заведомо большей по размерам (например, 
в 10 раз) модели или, при импорте из других форматов, установив большие единицы изме-
рения – например, метры при единицах измерения, установленных в Model Info > Units в мм. 
ну и после завершения построения (импорта), естественно, просто масштабируем модель 
к «правильному» размеру – при таком порядке действий ограничение уже не срабатывает.

При работе с большим количеством слоев и объектов со сложной  
иерархей «вложенностей» (в группах и компонентах) очень сложно контролиро-
вать правильность распределения по слоям, а главное – исправлять такие ошиб-
ки. Есть ли плагины, облегчающие эти задачи? 

есть целый ряд плагинов, облегчающих работу со слоями, однако, пожалуй, самый 
простой, наглядный и эффективный этот – в любой момент и в любой ситуации позволяет 
назначить (переназначить) выбранное, включая всю иерархическую структуру объекта, в 
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нужный слой:

PutOnCurrentLayer.rb 
ФУнКциЯ: 
Перемещение всего выбранного (в том числе всего вложенного содержимого групп 

и компонентов!) в текущий активный слой.
УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
1. Активируем (делаем текущим) нужный слой (выключатель у имени слоя в окне 

Window > Layers).
2. Контекстный клик на выбранном > Put On Current Layer (Поместить в текущий 

активный слой).

Иногда для каких-то последующих опций в объекте надо выбрать толь-
ко ребра или только поверхности, а не весь объект целиком. Делать это инстру-
ментом Select, набирая нужное множественным выбором (+Shift), долго и утоми-
тельно... Есть ли какой более быстрый способ?

для выбора только ребер: переходим в «каркасный» режим Face Style – Wireframe, 
выбираем все рамкой выбора. возвращаемся в режим с показом поверхностей – видим, что 
выбраны только ребра.

для выбора только поверхностей: выбираем только ребра (как в п. 1) и скрываем их 
опцией Hide. возвращаемся в режим с показом поверхностей, выбираем все рамкой выбо-
ра и возвращаем видимость ребрам опцией Unhide – видим, что выбраны только поверхно-
сти. еще один прием – в Edge Style (Стиль показа ребер) отключаем показ Edges и Profiles, 
выбираем рамкой весь объект – получаем тот же результат.

не менее быстро и удобно это можно сделать, используя плагин:

Desel.rb 
ФУнКциЯ: 
из всего выбранного исключает только выбор ребер или только выбор поверхностей.
УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
Контекстный клик на выбранном > выбор из вариантов: Deselect edges (исключить 

из выбора ребра) или Deselect faces (Исключить из выбора поверхности).

Можно ли управлять в SketchUp вершинами построений, как в боль-
шинстве 3D-редакторов?

Прежде всего заметим, что понятие вершины – общей точки пересечения или начала 
нескольких ребер (vertices, по общепринятой 3D-терминологии) – в перечне базовых элементов 
SketchUp просто отсутствует. Отсюда следует, что и управление такими элементами вроде бы и не 
предусмотрено. Однако на самом деле это не совсем так – фактически контрольные конечные точки  
(endpoint) любых ребер (или сегментов, составляющих кривые, нарисованные инструментом Line) 
и выполняют роль вершин. А поскольку именно линии и формируют всю последующую геометрию 
(включая поверхности), то манипуляции с такими точками обеспечивают дополнительные возмож-
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ности редактирования построений, что почему-то часто остается без внимания пользователей. 
Чтобы убедиться в такой возможности, подведем инструмент Move или Rotate к такой точ-

ке в любом построении (появляется подсказка endpoint) – видим, что и перемещение, и вращение 
возможны. Заметим, однако, что, во-первых, этим и ограничиваются варианты модификаций, а во-
вторых, они действуют только на ближайшие, примыкающие к «вершине» сегменты ребер (и со-
ответствующие поверхности). 

еще один вариант – использование вспомогательных временных построений. 
Пусть требуется построить произвольно изогнутый или свернутый провод (шланг, трос 

и т. п.), например провод к электровилке. Очевидно, что сначала надо нарисовать его очерта-
ния некой кривой, а затем выдавить по ней круговой профиль провода инструментом PushPull. 

начинаем с рисования предварительного очертания кривой – для плавности (и луч-
шей управляемости) используем, например, набор из дуг, построенных инструментом Arc 
(рис. внизу слева). Затем в нужных точках кривой выставляем временные вертикальные линии, 
фактически создавая в этих точках новые вершины. Получаем линии-«ручки» и начинаем по 
очереди перемещать их в разных направлениях, добиваясь нужных очертаний (рис. справа). 

При этом срабатывают два механизма: после установки «ручек» на кривую они стано-
вятся ее частью, а далее при их перемещениях механизм автоискажения (auto-fold) переме-
щает и конечные точки дуг (к которым они примыкают), меняя общие очертания будущего 
провода. Получив устраивающий результат, остается удалить временные ручки, пристроить к 
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концу провода круглый профиль сечения и пустить его по траектории инструментом PushPull.

Здесь можно заметить, что описанный прием – хороший пример нестандартного при-
менения стандартных механизмов SketchUp...

Результат применения опции Follow Me вдоль криволинейной направ-
ляющей (пути-траектории) бывает довольно неожиданный, например искажает-
ся и поворачивается сам профиль выдавливания... 

в некоторых ситуациях, например при выдавливании по кривой линии, да еще и не лежа-
щей в плане осей, сложно соблюсти идеальные условия, указанные для этого инструмента, – при-
мыкание профиля, ориентированного в пространстве нужным образом к конечной точке направ-
ляющей так, чтобы ее конечный сегмент был нормален к профилю. и вторая проблема – при «сле-
довании» профиля вдоль такой кривой происходит его неуправляемое вращение, а в итоге – иска-
жение и «перекручивание» формы тела выдавливания. Особенно явно это проявляется в гео-
метрии, близкойх по характеру к спирали, а случай этот достаточно типичен – дугообразные 
пандусы, винтовые лестницы, их перила ограждения и т. п.:

Конечно, все зависит от конкретных обстоятельств и задач – для большинства из них, и 
с простой геометрией профиля и направляющей, эти проблемы несущественны... Тем не менее 
самый корректный результат и самая удобная работа с Follow Me обеспечиваются примене-
нием плагинов:
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 Perpendicular Face Tool
ФУнКциЯ: 
вспомогательный инструмент для работы с опцией Follow Me – выставляет профиль 

выдавливания в плоскость, перпендикулярную (нормальную) к конечному сегменту пути-
траектории, и пристыковывает его геометрическим центром к назначенной конечной (или 
промежуточной) точке пути. Причем расположение профиля в сцене перед применением 
не имеет значения!

УСТАнОвКА: содержимое папки «clf_perpendicular_face_tools» копируем в папку 
Plugins.

КАК РАБОТАеТ: 
1. Рисуем нужный профиль в любом месте на плоскости «земли» (красно-зеленых осей).

2. Активируем скрипт нажатием новой кнопки на панели инструментов . Это наибо-

лее общий вариант для любой фигуры, есть еще кнопки  и для круга и прямоугольника.
3. Указываем курсором на нужную точку пути-траектории (выделяется зеленым круж-

ком) > профиль (в виде группы) выставляется в ней в нужном положении (рис. слева). 
4. Разгруппировываем профиль и далее применяем штатную опцию Follow Me (рис. 

справа).

   

 FAK.rb (FollowMeAndKeep)
ФУнКциЯ: 
Оптимально ориентирует профиль относительно траектории и выполняет опцию Follow 

Me c сохранением исходной ориентации профиля без закручивания относительно криволи-
нейного (спирального) пути, что происходит при использовании стандартного инструмента.

УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
1. Рисуем профиль в плоскости, примерно перпендикулярной нужному конечному сег-

менту траектории. Можно применить и предыдущий плагин для установки идеальной ориен-
тации профиля к направляющей. 

2. выбираем вместе профиль и траекторию (рис. слева).
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3. Меню PlugIns > FollowMeAndKeep – получаем готовый выдавленный объем (как 
группу), независимый от исходного профиля и траектории (рис. справа).

   

4. Удаляем исходные построения.

Почему в некоторых ситуациях инструмент Move «не хочет» переме-
щать выбранные элементы объекта в определенных направлениях? Конкретно – 
как, например, из плана кровли (линий-ребер) «вытянуть» ее двухскатный объем?

нарисуем прямоугольник и по его поверхности – круг и попытаемся из этих исходных 
элементов построить объем переменного сечения – от прямоугольника (внизу, в основании) 
до круга (вверху). инструмент Push/Pull для этой цели неприменим – он просто будет вытя-
гивать по вертикали выбранное круговое сечение. Пробуем поднять только круг по верти-
кали инструментом Move – видим, что такое действие в этой ситуации просто невыполнимо. 
Здесь налицо установленное по умолчанию ограничение Move на такие перемещения, кото-
рые могут привести к искажению формы объекта. 
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если посмотрим на подсказки в панели статуса после выбора инструмента (не забы-
ваем это делать постоянно!), видим: «Alt = toggle Auto-fold», то есть с нажатой клавишей 
Alt происходит переключение в режим искажения в любом направлении (снятие всех ог-
раничений), с которым в одно движение получаем требуемый результат (рис. слева выше). 

Таким образом, Move, кроме своего очевидного назначения и применения, обладает 
этой мощной функцией, которая позволяет производить перемещения любых элементов и в 
любых направлениях, автоматически изменяя соседние связанные элементы. Заметим, кста-
ти, что почему-то эта замечательная возможность часто остается без внимания пользователя. 

Теперь можем и дальше модифицировать форму объекта (его поверхности и ребра) 
тем же Move+Alt и любыми другими доступными инструментами и опциями (рис. справа выше).

вторая часть вопроса – хороший пример практического применения механизма auto-
fold. Строим типичный план кровли с разметкой линиями-ребрами пересечений ее плоско-
стей (рис. внизу слева). Можно, конечно, последовательно простроить линиями все высот-
ные габариты, затем замкнуть периметр нужных ребер, удалить ненужные поверхности и 
получить требуемые плоскости кровли. но вместо этих многоходовых действий можно вос-
пользоваться тем же приемом – подъемом линии конька кровли (его самой высокой части) 
на нужную высоту опцией Move+Alt и получить нужный результат в один шаг (рис. справа)!

Как построить шар?
Один из самых частых вопросов начинающих пользователей, который возника-

ет по причине отсутствия в SketchUp инструментов построения так называемых объектов-
«примитивов» – готовых простейших объемных форм, что характерно для многих других 3D-
редакторов. А по сути вопрос относится к способам быстрого построения объектов на ос-
нове применения инструмента Follow Me по круговой траектории.

Рисуем инструментом Circe правильный круг в плоскости «земли» нужного диаметра – 
траекторию будущего выдавливания. Сразу уточняем количество сегментов: если не устраи-
вает стандарное 24, уменьшаем – шар будет более угловатый, или увеличиваем – будет бо-
лее гладкий. инструментом Move+Сtrl создаем и поднимаем копию круга вверх (по синей оси) 
и сразу разворачиваем ее на 90 градусов инструментом Rotate в вертикальную плоскость – 
получаем. Заметим, что диаметр круг-пути значения не имеет, важно, чтобы центры кругов 
были выравнены по одной вертикальной оси. выбираем нижний круг (траекторию), затем 
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кликаем Follow Me на верхнем круге (профиле) – получаем шар.

используя ту же методику, можно построить совершенно другой объект – тор («буб-
лик»), для чего верхний круг уменьшаем и сдвигаем по горизонтали от оси нижнего круга. ну 
и далее, действуя аналогично предыдущей задаче, получаем искомый результат (рис. ниже 
слева). Очевидно, что аналогичными приемами возможны самые разнообразные вариации 
для построения объектов типа шайб и т. п. (рис. ниже справа).

Продолжая тему 3D-примитивов, надо сказать, что хотя, в принципе, все эти объекты 
легко построить вручную стандартными инструментами, вряд ли имеет смысл тратить на это 
время, если есть возможность воспользоваться готовыми объектами – компонентами или, 
что еще удобней, плагином (есть несколько такого назначения), например этим:

3D ShapesTool
ФУнКциЯ:
Строит пять распространенных типов геометрических тел: конус, шар, пирамиду, 

12-гранник (грани – правильный пятиугольник), 20-гранник (грани – равносторонний тре-
угольник). Управляется соответствующими кнопками новой панели инструментов: 
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УСТАнОвКА: содержимое папки «3D ShapesTool» копируем в папку Plugins.
КАК РАБОТАеТ:
1. выбираем тип объекта – кликаем нужную кнопку. Появляется курсор инструмента 

в виде синего карандашика. 
2. 1-й клик в нужном месте сцены – начальная точка построения – центр объема или 

опорной плоскости (в зависимости от объекта); 2-й клик – завершает построение или ука-
зывает одно из измерений; 3-й клик – указывает второе измерение и завершает построение 
(только для пирамиды). 

Как построить спираль?
вопрос также один из самых распространенных... и это понятно – геометрия такого 

типа нередко встречается в разного рода конструкциях и технических объектах. Заметим, 
что «скетчаперами» придумано несколько «ручных» методик решения этой задачи, основан-
ных на построении стандартного криволинейного элемента и последующем последователь-
ном наборе из него спиральной кривой, – при желании такие тематические пошаговые уро-
ки можно найти на форумах. 

Однако также вряд ли имеет смысл строить спирали вручную, поскольку существуют 
несколько специальных скриптов решения этой задачи, в том числе предлагаемый простой и 
удобный: 

 drawhelix13.rb
ФУнКциЯ:
Строит спиральную кривую по назначаемым параметрам.
УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ:
Меню Draw>DrawHelix13 – открывается диалоговое окно назначения параметров:

End Radius – конечный радиус кольца спирали;
Start Radius – стартовый радиус кольца спирали;
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Pitch – подъем колец (расстояние между ними);
No of Rotations – количество колец спирали;
Sections per Rotation – количество сегментов в окружности кольца спирали. 
в результате после нажатия ОК получаем спиральную кривую. и далее, используя ме-

ханизм Follow Me, выдавливаем профиль вдоль спиральной кривой-направляющей, получа-
ем требуемый объект – например, пружину. 

 

Требуется построить объект на основе фигуры плавных криволиней-
ных очертаний. Средствами SketchUp (отрезки прямых и дуги) рисовать такую фи-
гуру получается долго, сложно, неудобно... Есть ли другие варианты?

Заметим прежде всего, что это типичная задача векторных графических редакторов 
– рисования и редактирования так называемых кривых Безье, поэтому рациональней отри-
совывать кривую именно в них (CorelDraw, Adobe Illustrator и т. п.). далее экспортируем гра-
фику в формат dwg  /dxf (векторные форматы, которые поддерживает SketchUp) и импорти-
руем в наш проект. 

 При этом необходимо учитывать, что в SketchUp кривых типа Безье не может быть 
в принципе, а любая линия (ребро), визуально воспринимая как плавная кривая, на самом 
деле представляет собой последовательность прямолинейных сегментов. Отсюда следует, 
что плавные кривые Безье между двумя контрольными узлами перегиба в векторном редак-
торе будут преобразованы в прямые сегменты при импорте в SketchUp. Поэтому для полу-
чения плавной кривой в SketchUp иногда в векторном редакторе приходится перед экспор-
том добавлять промежуточные узлы. Типичный пример — шрифтовые объекты, которые по 
сути являются именно такими векторными объектами, и их импорт без предварительной до-
работки очертаний, как правило, приводит к неудовлетворительному результату.

Тем не менее есть возможность построения кривых типа (и по принципу) Безье и в 
SketchUp, представленная рядом плагинов. Здесь рассмотрим самый простой из них, посколь-
ку другие (например, Bezierspline) – объемные, сложные в освоении и управлении, уже вызы-
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вают сомнения в целесообразности применения вместо импорта из векторных редакторов...

fr_bezier.rb
ФУнКциЯ:
инструмент рисования (и редактирования готовых) кривых по алгоритму Безье – по 

четырем «опорным» точкам: начальной, конечной и двум дополнительным точкам положе-
ния «рычагов» изгиба.

УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ:
1. Меню Draw>Courbe de Bizier включает плагин, появляется указатель инструмента 

в виде белой стрелки.
2. Первым кликом показываем стартовую, вторым – конечную точки кривой. Пере-

мещением указателя регулируем изгиб кривой в два приема, который фиксируется еще дву-
мя последовательными кликами. 

3. При необходимости последующего редактирования кривой: Контекстный клик на 
выбранном > Editer courbe de Bezier – появляется опорная линия из прямых сегментов, кон-
фигурацию которой можно изменять красными квадратиками – «захватами», и за счет этого 
изменять и характер самой кривой. Конечно, такое повторное редактирование возможно 
только до момента включения кривой в качестве ребра плоской фигуры, а тем более в со-
став трехмерного объекта, поскольку в итоге получаем все-таки обычную Curve SketchUp. 

Как сделать зеркальную копию объекта? 
еще один из самых типичных вопросов... есть несколько вариантов решения этой за-

дачи, а что рациональней выбрать – зависит от конкретной ситуации.
1. инструментом Scale – отзеркаливание самого исходного объекта «на месте». на-

чинаем масштабирование объекта вдоль нужной оси (за соответствующий красный кубик-
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«захват») на любую приблизительную величину в нужном направлении > отпускаем мышку > 
вводим с клавиатуры значение коэффициента масштаба «– 1» > получаем искомый результат. 

2. инстументом Move – создание дополнительно зеркальной копии объекта. Пере-
мещением объекта по одной из трех осей сцены с нажатой клавишей Ctrl создаем его ко-
пию-дубль > используя на ней контекстную опцию Flip Along (Отразить по оси...) > получа-
ем искомый результат. 

Как видим, все достаточно просто и вроде бы не требует никаких дополнительных ре-
шений. Тем не менее существует и несколько плагинов, решающих эту задачу, но уже с рас-
ширенными возможностями, например настройками дистанции условной плоскости «зерка-
ла» от объекта, направления отзеркаливания и т. п. Описание и ссылки на конкретные плаги-
ны давать не имеет смысла по причине предельной простоты и очевидности работы с ними. 
А найти их сможете без труда (по слову Mirror) на указанных ранее ресурсах по плагинам...

Инcтрумент масштабирования Scale во многих случаях применять за-
труднительно из-за его привязки только к основным осям сцены. Как решить эту 
проблему? 

действительно, это существенное ограничение затрудняет масштабирование объек-
тов (их частей), которые ориентированы не по основным осям. Штатными инструментами эта  
проблема решается только временным изменением в нужное положение ориентации осей – 
или основных осей сцены, или преобразованием объекта в компонент, который имеет уникаль-
ное свойство – собственные, независимые оси, выставляемые в любую нужную ориентацию.

Однако, если опции масштабирования используете постоянно, однозначно имеет 
смысл освоить и использовать в работе плагин FredoScale, который является продвинутым 
вариантом стандартного инструмента Scale, позволяя масштабировать любые объекты и 
их отдельные элементы в любых направлениях и в разных вариациях. А фактически плагин 
представляет собой мощный комплекс дополнительных инструментов модификаций фор-
мы объекта. 

По причине весьма солидного объема и сложности (в том числе документации по при-
менению) здесь его подробно рассматривать затруднительно – без труда найдете все необ-
ходимое на указанных ранее ресурсах по плагинам...

Требуется быстро построить большое количество низкополигонных мо-
делей реальных зданий (район города). Как рационально выполнить эту задачу?

Это типичная задача моделирования низкополигонных (Low-Poly) моделей, например 
предназначенных для размещения в Google Earht. Разберем ее максимально подробно... 
Одно из основных требований – модель должна быть «легкой» за счет минимально доста-
точного уровня геометрической детализации, а при большом количестве моделей немало-
важен и фактор времени, затрачиваемой на модель. Конкретизируем задачу-пример: коли-
чество faces (поверхностей) на здание – не более 1000 (только основные, характерные объ-
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емы), материалы: в основном текстуры (имиджи из архитектурного проекта или фото). Что 
касается трудоемкости – очевидно, что она напрямую зависит от особенностей архитекту-
ры, объемно-планировочного решения здания, поэтому здесь сознательно приведен при-
мер повышенной сложности.

1.  Обрабатываем в графическом редакторе исходные данные: в нашем примере име-
ем архитектурные чертежи (планы, фасады, разрезы). Конечно, этот вариант предпочтитель-
ней, чем фото, поскольку потребует меньше доработки. Формируем пакет имиджей, кото-
рые станут подосновой моделирования, – удаляем ненужное, выравниваем при необходимо-
сти виды (проекции) по горизонталям, вертикалям, взаимным размерам (масштабу). Уделя-
ем особое внимание чертежам фасадов в цвете (будущим текстурным материалам) – по воз-
можности добиваемся максимально высокого качества, остальные исходные имиджи (пла-
ны, разрезы) в итоге будут удалены – для них достаточен уровень хорошей читаемости ли-
ний. Компонуем и сохраняем полученное в один растровый файл (рис.1).

  

 

2.  импортируем файл имиджа основы в SketchUp (в окне импорта ставим галочку на 
«As Image»), пока не задаваясь размерами (масштабом) будущей модели – при импорте раст-
ра в сцену сделать это просто невозможно. С чего начать моделирование? все зависит от 
особенностей компоновки объемов здания – фактически речь идет о рациональном выбо-
ре характерного профиля (плоской 2D-фигуры), который будет выдавливаться (вытягивать-
ся) в третье измерение. 

для здания простой «коробочной» формы с регулярным протяженным фасадом – это, 
конечно, фасады, с которыми работать намного проще. в нашем случае имеем многоэтаж-
ное «точечное» здание, объемы которого формируются сложными очертаниями этажей, и 
они к тому же по высоте здания меняются – очевидно, что рациональней использовать в ка-
честве подосновы именно планы.

3.  настраиваемся на максимальную точность и аккуратность построений – это изба-
вит от будущих ошибок и потерь времени на переделки. Переключаем камеру на ортого-
нальный вид Top (Сверху) и на параллельные проекции (Camera > Parallel Projection) – то есть 
ограничиваем перемещение инструментов только в двух измерениях. Проверяем (в Model 
Info > Units) настройки уровня точности построений: Precision и lenght snapping лучше уста-
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новить на 2 или 3 нуля после запятой. и для точности позиционирования инструментов не-
обходимо работать при максимально возможном увеличении обрабатываемого участка. 

4.  начинаем с плана 1-го этажа. Обрисовываем линиями внешние границы стен,  
постоянно контролируя по подсказкам правильность направлений вдоль осей и перпенди-
кулярность линий. При необходимости используем временную предварительную разметку 
инструментами Measure и Protractor для установки точных направлений и углов. Количество 
сегментов по умолчанию после выбора инструментов Arc (Дуга) и Circle (Окружность) сразу 
уменьшаем – с 12 на 6 в дугах и с 24 на 12 в окружностях. Максимально задействуем возмож-
ность дублирования с перемещением (Move+Ctrl) повторяющихся одинаковых элементов.

Последовательно строим очертания остальных планов этажей, – и в итоге получаем 
«сечения» всех этажей (рис.2). Остается «затянуть» их поверхностями – планы готовы к вы-
давливанию. 

5.  Теперь имеет смысл выставить в проекте реальные размеры здания. Рулеткой за-
меряем любое известное («образмеренное» в чертежах) расстояние и вместо значения в па-
нели Measuremens (Измеритель) вводим реальный. Подтверждаем в появившемся окошке-
запросе изменение масштаба – все содержимое сцены масштабируется нужным образом. 

6.  возвращаемся к 1-му этажу и «поднимаем» его поверхность на высоту этажа инстру-
ментом Push/Pull. величину подъема берем или по размерам на чертеже, или замерив Рулет-
кой на имидже – основе. лучше эти опции делать в режиме Monochrome, который показы-
вает модель только в цветах лицевых и оборотных сторон поверхностей, – постоянно конт-
ролируем правильность их ориентации (лицевые – наружу) и сразу исправляем неточности. 

Помня об экономии поверхностей, сразу удаляем ненужные (лишние) coplanar ребра,  
то есть разделяющие соседние, лежащие в одной плоскости поверхности, а значит, не участ-
вующие в их формировании. и в итоге группируем объем – это гарантирует его «изоляцию» 
от остальных построений при последующих «сборочных» работах. 

7.  Переходим ко 2-му этажу и проделываем аналогичные манипуляции. Обращаем 
внимание на выступающие объемы балконов – «продавливаем» Push/Pull высоту балконных 
ограждений. Поскольку 2...4 этажи одинаковы, из них можно создать единый объем. Снача-
ла «надстраиваем» 3 и 4 этажи перемещением с дублирование объема 2-го этажа. Также чи-
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стим модель от лишних линий-ребер, и теперь получившийся единый объем можно сгруппи-
ровать (рис. 3).

8.  далее последовательно, аналогично предыдущему пункту, строим объемы осталь-
ных этажей. Постоянно внимательно «читаем» чертежи, сверяясь с ними. Особенно тщатель-
но приходится делать это в таком сложном случае: соотносить изменения планов по этажам 
с фасадами в соответствующих осях, по ходу исправлять неточности, принимать решения по 
обобщению объемов, исключая излишнюю детализацию.

  

9.  в итоге собираем «блоки» этажей – ставим их один на другой, совмещая характер-
ными (например, угловыми) точками. далее разрываем (Explode) все группы, соединяя все в 
единое связанное построение (рис. 4). 

10. Переходим к материалам – возможны несколько вариантов работы с ними. 
во-первых, можно воспользоваться уже находящимся в файле имиджем-подосновой, 

который пока находится в состоянии «закрытой» группы и после Explode появится в списке 
Windows > Materials > In Model в качестве нового текстурного материала. Поскольку имидж, 
кроме фасадов, содержит уже больше ненужных планов и разрезов (а значит, бесполез-
но увеличивает «вес» файла), можно обрисовать прямоугольную зону только с фасадами, 
а остальное (стерев ребра) удалить. Остается сохранить полученное в виде новой тексту-
ры – через контекстное меню Make Uniqui Texture – и удалить имидж подосновы из списка 
In Model. еще одна возможность – редактирование при необходимости «на лету» во внеш-
нем редакторе, назначенном предварительно в Window > Preferences > Applications > Default 
Image Editor. далее открываем список Windows > Materials > In Model и через контекстное 
меню имиджа Edit texture Image редактируем, и после завершения имидж появляется в сце-
не уже в отредактированном виде. 

во-вторых, можно просто предварительно подготовить отдельным файлом тексту-
ры фасадов в растровом редакторе и импортировать в сцену. Здесь возможны два вариан-
та, выбираемые в окне импорта: 

Первый – Use as texture (Как текстура). При этом сразу помещаем импортированный 
имидж на нужную поверхность, «цепляясь», например, его левым нижним углом за нижнее 
ребро и растягивая вправо/вверх до верхнего ребра поверхности. Точность контролируем 
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по подсказкам. Способ, конечно, самый быстрый и точный, но применимый только для плос-
ких поверхностей и тех же пропорций, что и имидж.

второй способ – импорт Use as Image (Как имидж). Мы его уже использовали, когда по-
мещали растровую подоснову в сцену: – в этом случае он появляется в сцене как независи-
мый объект – имидж-группа. Уже говорили о том, что, к сожалению, нет четкой зависимости 
между реальными размерами (и разрешением) имиджа и тем, в каких размерах он появится в 
сцене, поэтому приходится соизмерять имидж по модели практически «вприглядку». для это-
го предварительно переходим во фронтальную параллельную проекцию и конструкционны-
ми линиями намечаем высотные габариты здания. воспользуемся тем, что, как и в первом ва-
рианте, можно в два клика установить нужный размер – при импорте сразу пропорционально 
растягиваем имидж фасадов по этим габаритам. и выполняем опцию Explode – новый текстур-
ный материал фасадов появляется в списке Windows > Materials > In Model.

11. выставляем имидж перед моделью напротив одного из фасадов (или наоборот, 
как удобней) так, чтобы соответствующие поверхности модели и плоскость имиджа были 
параллельны. для удобства выравнивания можно временно включить полупрозрачный ре-
жим отображения сцены X-Ray или сделать полупрозрачным сам имидж (Windows > Materials 
> In Model > Edit – изменить Opacity) (рис. 5).

12. включаем «пипетку» (Paint Bucket+Alt), «снимаем» материал с имиджа и «заливаем» 
– фактически проецируем на поверхность модели. в идеале он должен точно вписаться в гра-
ницы (ребра) «противолежащей» поверхности, хотя на практике все-таки часто требуется кор-
ректировка, подгонка имиджа под поверхность. используем пункт Texture > Position (Позици-
онирование текстуры), вызываемый из контекстного меню, – он доступен только для плоских 
поверхностей. надо сказать, что управление этой опцией не отличается простотой и удобст-
вом (за исключением простого перемещения, сдвига по поверхности), а потому прак-тика по-
казывает, что остальные опции часто имеет смысл перенести в растровый редактор. вообще, 
трудоемкость этого этапа работы в основном зависит от качества исходных материалов – как 
в плане качества растра, так и точности размеров и пропорций. Фактически здесь мы исполь-
зовали то, что в общепринятой 3D-терминологии называется Planar mapping – наложения тек-
стур методом параллельных проекций. Уточним, что хотя в идеале плоскости проецируемо-
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го имиджа и поверхности должны быть параллельны, на самом деле речь идет только о том, 
что чем меньше угол между ними, тем меньше искажения проекции текстуры на поверхность: 
– так, на поверхности, перпендикулярной имиджу, текстура превратится просто в хаотичный 
набор линий. в этом случаем просто снимаем галочку Projected и выставляем через Position тек-
стуру на этой поверхности в нужное положение. Такая «непроецируемая» текстура получает 
способность «оборачиваться» или «перетекать» с одной поверхности на другую, если, конеч-
но, имеет достаточные для этого размеры. Аналогичными манипуляциями накладываем тек-
стуры на остальные поверхности фасадов (рис. 6). 

  

Остается окончательно «очистить» модель от coplanar ребер (и другого «строитель-
ного мусора») и проверить «расход» поверхностей (Model info > Statistics) – в нашем приме-
ре получилось всего около 600. и по времени даже в таком, достаточно сложном случае, ис-
пользуя описанную методику, вполне можно вписаться в требуемые 4 часа...

 

Можно ли средствами SketchUp cтроить сложные, в том числе «скуль-
птурные» объемы или все-таки имеет смысл использовать для этого другие, спе-
циализированные редакторы? 

вопрос, на который сложно дать однозначный ответ... Конечно, по большому сче-
ту программные механизмы SketchUp не предназначены для моделирования таких объек-
тов – так называемой «органики». даже если бы для этого имелись полноценные инструмен-
ты, остается принципиальная проблема таких «тяжелых» для SketchUp моделей – очевидно, 
что количество ребер и поверхностей в них несоизмеримо больше, чем в чисто технических 
объектах. дело в том, что работа с подобными поверхностями (практически во всех про-
граммах-моделерах) происходит в два этапа: сначала создается некая исходная сетка пло-
ских полигонов (или берется готовая заготовка), а затем выполняется ее модифицирование 
(«лепка») специальными инструментами. и поскольку эти опции призваны создавать плавную 
кривизну поверхностей, очевидно, что при этом количество полигонов резко увеличивается. 
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Конечно, все-таки логичней для проектов, в которых преобладает органика, исполь-
зовать другие, специализированные 3D-редакторы, которые с легкостью манипулируют мно-
гими тысячами (и даже миллионами!) полигонов и имеют для моделирования такого рода ши-
рокий спектр инструментов. Кроме того (хотя это уже другая, самостоятельная тема), эти ре-
дакторы имеют и специфические инструменты наложения и управления текстурами на таких 
поверхностях, что для полноценной реализации средствами SketchUp – в принципе нереша-
емая задача. С другой стороны, понятно желание пользователей иметь подобные возмож-
ности, что подтверждается наличием ряда плагинов этого назначения. 

Заметим вначале, что на самом деле многие задачи моделирования объемов с по-
верхностями сложной кривизны можно с успехом выполнять и стандартными инструмента-
ми. Это прежде всего группа инструментов Sandbox (Песочница), в числе которых есть, на-
пример, типичный «скульптурный» инструмент Smoove (Присоска). Однако (об этом подроб-
но было сказано в теме этих инструментов) жесткие ограничения их возможностей не по-
зволяет считать Sandbox полноценным набором инструментом для работы с органикой. Так, 
например, тот же Smoove работает только в вертикальном направлении (относительно пла-
на осей «земли», по синей оси) и к тому же всегда действует «насквозь», на все поверхности, 
попадающие под направление вектора его «силы». Определенными приемами эту особен-
ность инструмента можно обойти (разделяя объект на части, разворачивая перед редакти-
рованием поверхности в нужное положение, дополняя действиями других инструментов, од-
нако все-таки рациональней воспользоваться специальными плагинами. Здесь прежде все-
го стоит посмотреть возможности плагина с характерными для редакторов такого назначе-
ния «скульптурными» механизмами:

Subdivide and Smooth (SDS)
(платный, сайт автора: http://www.smustard.com/script/SubdivideAndSmooth)
ФУнКциЯ: преобразование формы исходного объекта механизмом Subdivide (Подраз-

деление) со Smooth (Сглаживанием) и последующие модификации дополнительными инстру-
ментами. Управляется соответствующими кнопками новой панели инструментов:

УСТАнОвКА: копируем содержимое папки Subsmooth файл в папку Plugins.
КАК РАБОТАеТ: 
Принцип действия плагина – типичный для редакторов-моделеров «органики» меха-

низм Subdivide – подразделения (или дробления) полигонов поверхностей на более мелкие 
части за счет создания внутри них новых полигонов. При этом он дополняется механизмом 
интерактивного автосглаживания внешних границ поверхностей, что позволяет получать со-
вершенно другие очертания и, соответственно, – новые формы. 

Плагин объемный, весьма сложный, поэтому разберемся с его инструментами под-
робно на тестовых примерах.

 Subdivide and Smooth (Подразделить и сгладить)
Сразу для наглядности стоит включить показ скрытых построений (View > Hidden 

Geometry). Строим плоскую фигуру – прямоугольник и объемную – кубик и выполняем над 
ними указанные ниже опции. выбираем любой (!) из элементов > кликаем кнопку инструмен-
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та > открывается диалоговое окно настройки опций с двумя параметрами:
Iterations (шаг цикла, количество повторов): фактически сила эффекта за один шаг  

(от 1 до 4) – можно сразу назначить большое значение или последовательно повторять не-
большие. Заметим, во-первых, что четыре раза при значении 1 или один раз 4 дадут разный 
результат, поскольку исходное состояние объекта при каждом шаге разное. и во-вторых: 
чем больше значение, тем больше образуется новых полигонов (причем в прогрессивной 
зависимости!), резко увеличивая вычислительную нагрузку, поэтому выбираем минимально 
достаточные решения.

Copy Materials (Копировать материал): опция сохранения (On) или нет (Off) исход-
ного материала в модифицированном объекте. Понятно, что это особенно важно в случае 
текстурных (растровых) материалов.

После нажатия ОК видим результаты (рис. слева), повторяем то же с усложненны-
ми объектами (рис. справа). Принципиальная особенность механизма – воздействие на лю-
бой (не важно, какой) из элементов (частей) объекта последовательно «передается» на все 
остальные, связанные с ним.

 

 

Рассмотрим второй вариант действия плагина. Предварительно создадим из тестовых 
объектов группы (материал оставим по умолчанию). После запуска опции видим, что в ди-
алоговом окне добавилась строка Auto-update – опция автообновления модели в процес-
се редактирования в реальном времени. Конечно, удобней держать ее включенной, но для 
очень сложных моделей это может приводить к значительному увеличению времени обра-
ботки (этапы отображаются в статусной строке). 

А далее – самое интересное... После отработки опции видим, что образовалась ком-
бинация из исходной группы, которая стала Subsurf Proxy (примерно можно перевести по-
нятие Proxy как «транслятор»), и вложенного в нее нового компонента – собственно сгла-
женного объекта – Subsurf (рис. ниже слева). Открыв окно материалов проекта, видим, что 
в нем появились два новых материала (Subsurf Proxy и Subsurf), которые при желании можно 
отредактировать (цвет, прозрачность). Кроме того, открыв окно компонентов проекта, ви-
дим появление нового – Subsurf, а значит, при необходимости можно использовать все его 
возможности, например для создания и одновременного редактирования зеркальных поло-
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вин симметричного объекта. 
Таким образом, используя интерактивную связь между исходным объектом (точнее, 

теперь Subsurf Proxy) и итоговым cглаженным Subsurf, можно последовательным редактиро-
ванием транслятора (любыми стандартными инструментами) редактировать и саму конечную 
форму, добиваясь желаемого результата (рис. вверху справа). и главное – эти изменения обра-
тимы и можно, например, менять параметры подразделения и сглаживания или форму объ-
екта сколько угодно раз вплоть до момента разрыва (Explode) группы Subsurf Proxy+Subsurf.

 

Опции плагина доступны также из текстового меню Tools > Subdivide and Smooth: в 
частности можно на любом этапе редактирования изменить значение Iterations, принуди-
тельно обновить изображение результата модификации и так далее. 

 Subdivide Selection (Подразделить выбранное)
инструмент, в принципе аналогичный Add Detail (Добавить детали) в составе Sandbox, 

но, в отличие от него, работает с абсолютно любыми поверхностями (что очень важно!), а не 
только с уже созданными «сеточными»». Принцип – «за шаг» делит каждый прямоугольный 
полигон на 8 треугольных и каждый труегольный – на 4. Понятно, что такая функция предо-
ставляет множество интересных возможностей для дальнейшего редактирования, в том чи-
сле и стандартными инструментами.

  Smooth all connected geometry (Сгладить всю смежную геометрию)
инструмент, сглаживающий четырехугольные и треугольные поверхности. если в на-

личии другие – выводится соответствующее сообщение и выставляются конструкционные 
точки для разбиения поверхности на несколько требуемой формы.

  Crease Tool (Инструмент края)
Опции подразделения и сглаживания действуют на все связанные поверхности и вер-

шины, однако иногда требуется выборочно «запретить» эти действия для некоторых их них. 
включив инструмент, помещаем его на ребра и вершины: окраска в красный цвет показы-
вает, какие из них будут сглажены. Соответственно, кликнув инструментом на ребре (вер-
шине), запрещаем их сглаживание (окрашиваются в зеленый цвет) – и наоборот... Опция 
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работает во всех режимах и в любой момент – на плоской фигуре и трехмерной форме до 
применения Subdivide and Smooth, при редактировании Subsurf Proxy и так далее.

  

  Knife Subdivide (Разрезать подразделение)
в соответствии с названием является «ножом» – делаем двойной клик на кнопке и в 

два клика (стартовая и конечная точки) рисуем линию реза. Опция работает аналогично пре-
дыдущей, однако может приводить к критическим для файла ошибкам и «вылетам» из про-
граммы (сохраняемся перед применением).

  Extrude selected face (Выдавить выбранную поверхность)
Опция, не имеющая напрямую отношения к плагину, – переключает в инструмент Push/

Pull и выдавливает дубль выбранной поверхности на некую величину – как бы готовит для 
дальнейшей работы с этим инструментом.

Освоение плагина, конечно, требует определенной практики, наработки приемов и 
навыков (включая умение «прогнозировать» сглаженную форму по исходной), но он того сто-
ит... достаточно посмотреть на модели, созданные профи с его помощью:
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Существует и дальнейшее развитие этого плагина – Artisan (http://artisan4SketchUp.
com/) того же автора (второе название – SDS2), с еще более мощными функциями «органи-
ческого» моделирования и текстурирования. в общем-то, такого рода плагины трудно на-
зывать просто скриптами – фактически это уже самостоятельные приложения, дополнитель-
ные программные модули под специфические задачи, намного более объемные... и слож-
ные в освоении. Можно даже сказать, что они превращают SketchUp  в другую программу... 

Как выдавить часть криволинейной поверхности инструментом Push/
Pull?.. 

в стандартном (штатном) варианте – ответ отрицательный, поскольку инструмент име-
ет ряд ограничений и работает, как мы знаем), только при соблюдении следующих условий:

– выдавливаемая поверхность должна быть плоской;
– поверхность выдавливается по вектору, «нормальному» к исходной, то есть новая 

поверхность всегда параллельна исходной;
– «за шаг» выдавливается только одна выбранная поверхность, то есть это нельзя 

сделать, предварительно выбрав несколько разных поверхностей.
Посмотрим на практическом примере, как все-таки решить эту задачу. Построим ку-

пол, затем «отсечем» его часть (например, показанным на рисунке ниже слева способом – 
через опцию Intersect). Подведем к выделенной поверхности курсор Push/Pull – видим, что 
применение инструмента к цельной криволинейной поверхности невозможно.

Остается единственный вариант – убрать сглаживание (или перейти в режим пока-
за скрытых построений) и по очереди выдавить (поднять) каждый из плоских полигонов на 
одинаковую дистанцию. и далее – вручную «затянуть» неизбежные промежутки рисованием 
новых линий и наконец сгладить или скрыть неровности (рис. справа).

Таким образом получаем, при весьма трудоемком процессе, зачастую не очень  
качественный результат... К тому же эта методика годится далеко не всегда – только при не-
высоком (неглубоком) выдавливании. 

  

и безусловно, оптимальное решение такого рода задач легко, быстро и качественно 
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обеспечивает плагин, которым вполне можно пользоваться вместо стандартного инструмен-
та Push/Pull, поскольку отсутствуют его ограничения и добавляются новые функции:

JointPushPul
ФУнКциЯ: модификация стандартной опции Push/Pull (Толкать/Тянуть). Управляется 

соответствующими кнопками новой панели инструментов, из контекстного меню выбранной 
поверхности и из меню Tools.

УСТАнОвКА: копируем содержимое папки JointPushPull в папку Plugins.
КАК РАБОТАеТ: 
независимо от того, плоская или криволинейная (сглаженная) поверхность выбра-

на для воздействия:

 JointPushPull  – выдавливает цельную сглаженную поверхность параллельно ис-
ходной:

– помещаем курсор на любое место предварительно выбранной (или на одну из не-
скольких выбранных!) поверхности;

– вводим дистанцию выдавливания (видим в Measurement);
– нажимаем Enter > получаем после отработки опции (см. бегущую сроку прогрес-

са) готовый результат. Те же действия доступны с помощью мышки: первый клик – исход-
ная позиция поверхности > вытягиваем дистанцию перемещением курсора (можно ввести с  
клавиатуры) > двойной клик (или  Enter) – завершение:

   

После выбора инструмента можно изменить параметры опции по умолчанию – кла-
вишей Tав вызываем окошко:

Finishing options:
– Erase original faces – удаляет исходную поверхность;
– Thickening – реверс исходной поверхности;



167 Тема 27. ЗАдАЧи и РеШениЯ. ПлАГинЫ. ПРОГРАММЫ-ПАРТнеРЫ

– Keep original faces – сохраняет исходную поверхность;
Create border faces:
– Borders on outer faces only – создает бортик только по внешней границе выдавли-

вания;
– Borders on ALL faces – создает бортики вокруг каждого из выдавленных полигонов; 
– NO borders – без бортиков;
Generate as a Group – создает (или нет) группу из выдавленных поверхностей (Yes/No)
Extend influense to non-selected neighbors – расширяет (или нет) влияние на сосед-

ние, невыбранные поверхности (Yes/No);
Angle of influense (degree) [0...75]: – угол влияния.

Заметим, что при этом в нашем примере выдавленная поверхность расширяется, по-
скольку инструмент работает по принципу штатного (каждый полигон выдавливается по нор-
мали параллельно своему исходному на одну и ту же дистанцию) и при этом автоматически 
заполняются новыми поверхностями промежутки между полигонами в конечном положении.

 Vector Push Pull  – выдавливает цельную сглаженную поверхность по любому на-
правлению указанного его вектором (рис. ниже слева). Отличается от предыдущего вариан-
та ручным указанием курсором начальной и конечной точек вектора выдавливания, а также 
набором параметров: только первые три строки.

 Normal Push Pull  – каждый полигон выдавливается раздельно и параллель-
но свое-му исходному по нормали на одну и ту же дистанцию. Фактически это стандартный 
Push/Pull с возможностью одновременного (!) выдавливания любого количества выбранных  
поверхностей (Рис. ниже справа). набор параметров аналогичен предыдущему.
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  Undo/ Redo – отмена текущего выдавливания; повтор параметров последне-
го выдавливания на любых других выбранных поверхностях.

Какие способы и плагины текстурирования объектов с поверхностями 
сложной кривизны могут облегчить эту задачу?

в первой книге нашего курса уже достаточно подробно рассматривались механиз-
мы текстурирования в SketchUp, но и здесь стоит вспомнить его основные принципы рабо-
ты и проблемные моменты. 

1. Текстуры в SketchUp – всегда бесконечно повторяющиеся «плитки» имиджа. 
2. доступны два варианта помещения текстуры на поверхность, условно «текстура-

проекция» и «текстура-обертка. Принципиальная разница этих двух типов: текстура-обертка 
всегда автоматически проецируется («ложится») своей плоскостью на поверхность, ориен-
тируясь в 3D-пространстве по ней, а текстура-проекция всегда остается в своей исходной 
ориентации, а потому на поверхностях, лежащих под углом к ней, при проецировании про-
исходят неизбежные искажения. 

3. для простых геометрических форм с небольшим количеством (и преобладанием) 
плоских поверхностей практически всегда и без особых проблем можно обойтись одним из 
этих двух вариантов (или их сочетанием). 

4. для поверхностей сложной кривизны задача осложняется тем, что те же механизмы 
приходится применять к несоизмеримо большему числу плоских поверхностей, формирую-
щих (в сглаженном виде) их «surfaces». Штатными инструментами и любыми приемами  ред-
ко удается получить удовлетворительный результат (без искажений рисунка текстур), поэто-
му можно рекомендовать воспользоваться плагинами под эти задачи.

надо заметить, что плагинов этого назначения не так много, и практически ни один из 
них полноценно проблемы не снимает, но тем не менее стоит обратить внимание на один, 
достаточно простой и доступный: 
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UVtools.rb
ФУнКциЯ: дополнительный инструмент текстурирования –  назначения принципа про-

ецирования текстуры c учетом 2 вариантов характерных объемов объекта.
УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
1. Подготавливаем подходящий по размерам (достаточный, чтобы полностью обер-

нуть объем объекта) или «бесшовный» плиточный имидж и «заливаем» его на сглаженную 
поверхность сложной кривизны.

2. Через контекстное меню на объекте UV Toools выбираем один из двух наиболее 
подходящих для характера данного объема вариантов: Spherical Map (Сферическая карта) 
или Cilidrical Map (Цилиндрическая карта). 

3.  При необходимости корректируем габаритные размеры и другие доступные пара-
метры текстуры в окне Materials > Edit. С некоторыми формами возможны ошибки на 4-сто-
ронних поверхностях – для снятия проблемы рекомендуется воспользоваться плагином 
Triangulatefaces.rb, которым предварительно разбиваем каждую такую поверхность на две 
треугольные.  

  

Конечно, возможности этого плагина очень упрощены и ограничены, и он не всегда 
работает корректно, поэтому автор добавил к нему функции в логичном направлении – «мос-
тика» между SketchUp и специализированными программами UV-маппинга в дальнейшем раз-
витии (версии). но поскольку это уже совершенно отдельная и очень объемная тема, адре-
сую интересующихся к первоисточнику: http://forums.sketchucation.com/viewtopic.php?f=3
23&t=23725&hilit=UVTools.

и завершая тему UV-маппинга, все-таки приходится признать, что если требуется по-
лучить для сложных форм объектов SketchUp (и не только в SketchUp, конечно) качествен-
ное текстурирование, невозможно обойтись без использования специализированных про-
грамм. в этой связке обмен данными между SketchUp и такой программой – вопрос совер-
шенно второстепенный, несоизмеримый по сложности с основной задачей и освоением про-
грамм UV-маппинга...

Можно ли окрасить в сцене разными цветами ребра разных объектов?
на первый взгляд, ответ – отрицательный. Однако на самом деле эту задачу можно 



170 Тема 27. ЗАдАЧи и РеШениЯ. ПлАГинЫ. ПРОГРАММЫ-ПАРТнеРЫ

решить, и это решение – хороший пример того, что глубоко владея  программой, можно 
получить даже «недокументированные» возможности применения инструментов и опций.

Как мы знаем, окраска (точнее, назначения материалов) воздействует только на  
поверхности, а цвет ребер напрямую от нее независим. Как правило, при работе в стандартной 
графике программы вполне устраивает установленный по умолчанию вариант – все ребра окра-
шиваются в одинаковый черный цвет. Тем не менее можно получить интересные результаты, от-
дельно поработав с цветами ребер: – для этого сначала откроем окно Window > Styles > Edit. 
Здесь в панели Color видим тот самый вариант по умолчанию – All same, то есть все линии всег-
да одного цвета, и рядом – индикатор текущего (пока черного) цвета. Кликнув на нем, входим в 
окошко выбора цвета и меняем на любой другой. Это первый, простейший вариант управления 
цветами всех ребер объектов в проекте, однако очевидно, что при многоцветной сцене, ско-
рее всего, придется пользоваться нейтральными тонами, и в любом случае все ребра всех объ-
ектов будут одного цвета. 

второй вариант – в панели Color включаем вариант By material, то есть теперь ребра будут 
иметь цвет (материал) поверхностей, граничащих с ними. недостаток такого решения заключа-
ется в том, что на затененных (более темных) поверхностях ребра того же цвета, что и на осве-
щенных, поскольку на них затенение не воздействует, и это смотрится неестественно (рис. слева).

Третий вариант – тот самый «недокументированный». во-первых, создаем новые, допол-
нительные цвета тех же, но более темных тонов, чем были использованы для окраски поверх-
ностей. для этого открываем окно Window > Material > In Model, выбираем один из уже ис-
пользованных для поверхностей цветов и кнопкой Create Material создаем его дубль, после 
чего редактируем – делаем более темным. и следующий этап – выбираем нужные ребра, вы-
зываем окно Entity Info и через индикатор цвета выбираем наш новый, затемненный вари-
ант цвета. Можно и просто выбирать их в списке использованных цветов In Model и «зали-
вать» на ребра! и, как видим, получили интересное и графически корректное цветовое ре-
шение (рис. справа). 

Как создать 2D-компонент (billboard) на основе фото?
При понятном назначении и принципе работы (см. тему 15 «Компоненты») здесь есть 

определенные затруднения, с которыми разберемся подробно на тестовом примере. 
Конечно, самым эффектным вариантом будет фото реальных объектов в качестве ма-
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териала (текстуры) такого компонента – например, людей, растительности и т. п. для наше-
го тестового примера как раз и используем такую «фотооснову».

1. выбираем подходящее фото (специальные коллекции такого типа можно найти в 
интернете) с прозрачным фоном (альфа-каналом). или готовим его сами  в растровом ре-
дакторе и сохраняем его в формате .png – наиболее подходящем формате такого типа, под-
держиваемом SketchUp.  

2. импортируем имидж в SketchUp (File > Import, в окне Options ставим галочку на Use 
as Image. Удобно перед этим перейти в вид Front (Спереди), чтобы сразу выставить в сце-
не имидж нужным образом. Получаем имидж-группу, как и требовалось – с прозрачным фо-
ном вокруг нужного изображения... и видим проблему с тенями. Первая – объект не отбра-
сывает тень. Разрываем опцией Explode группу – появились ребра прямоугольника габарита  
имиджа и… прямоугольная тень. Это и понятно, поскольку, несмотря на прозрачность части 
имиджа, растр – это всегда прямоугольник, заполненный пикселами. Конечно, очевидное ре-
шение – скрываем ребра габаритов этого прямоугольника опцией Hide, но с тенью ситуация 
не меняется. Однако наши усилия не напрасны – на данном этапе получили новый материал 
(Materials > In Model) – импортированную растровую текстуру. 

3. делаем вывод – нужную часть имиджа (собственно фото человека) нужно поме-
стить внутрь повторяющего и ограничивающего его очертания контура из ребер, а внеш-
ние реб-ра прямоугольного габарита просто удалить. Конечно, можно сделать это, нарисо-
вав данный контур по имиджу в SketchUp инструментом Line, однако это решение вряд ли 
можно назвать рациональным – очень трудоемко и неудобно...  второй вариант – использо-
вать опцию так называемой «трассировки» – конвертации растрового изображения в век-
торное. для этого используем, например, приложение Corel Trace (в составе пакета вектор-
ного редактора CorelDraw) или любое другое аналогичного назначения. Поскольку нас ин-
тересует только внешний контур, заливаем изображение однотонной краской, трассируем и 
сохраняем результат в векторный формат .dxf или .dwg, после чего импортируем в SketchUp.  

4. Замыкаем импортированный контур –  остается заменить появившийся материал по-
верхности по умолчанию на наш имидж. Берем его из списка In Model, «заливаем» и вырав-
ниваем (контекстное меню Texture > Position) таким образом, чтобы имидж точно лег в кон-
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тур. Остается для полной реалистичности скрыть ребра контура опцией Hide. 

5. и в завершение наших манипуляций, конечно, сохраняем результат как компонент 
для дальнейшего использования. вызываем контекстное меню, применяем опцию Make 
component, в открывшемся окошке даем ему имя и не забываем поставить галочку на Always 
face camera – теперь модель будет всегда «анфас», создавая иллюзию трехмерной фигу-
ры, и ее падающая тень будет совершенно достоверно повторять очертания компонента.

Как в сцене SketchUp показать отражение в зеркале?
Как мы знаем, материалы в SketchUp в принципе не могут иметь отражающих свойств – 

только цвет и текстуру. Однако для визуализации некоторых проектов этот эффект очень жела-
телен (зеркало в интерьере, водная гладь и т. п.). Здесь показано простое и остроумное реше-
ние имитации этого эффекта материала совершенно другими средствами и с вполне достовер-
ным результатом. 

например, требуется создать отражение в воде (рис. ниже слева). Создаем «отражаю-
щую» поверхность – в этом примере просто прямоугольник с «водной» текстурой. Задаем 
ей нужную степень прозрачности, ставим на «воду» объект, который должен отражаться, а 
с обратной стороны полупрозрачного «зеркала» – его зеркальную копию! в этом конкрет-
ном примере учитываем, что часть корпуса кораблика погружена в воду, – отрезаем ее. При 
необходимости уточняем настройки теней, прозрачности и т. п.

и «буквальный» случай зеркала – здесь по оптическим законам отражения оригинал 
и его зеркальную «копию» помещаем от плоскости зеркала по обе стороны на одном и том 
же расстоянии (рис. ниже справа).

Конечно, надо иметь в виду, что подобное решение задачи будет выглядеть досто-
верно только при определенных ракурсах камеры (взгляда на сцену).

Можно еще заметить, что, строя сцену для визуализации проекта (например, неко-
го изделия), вполне имеет смысл его «поставить перед зеркалом» и получить возможность 
сразу показать объект с двух ракурсов в одном имидже, что смотрится весьма эффектно.
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Как в последовательных сценах показать этапы «строительства» мо-
дели с постепенным «наращиваем» ее деталей? 

действительно, такая задача может быть востребована для разного рода презента-
ций, в том числе с последующим сохранением в эффектный анимационный ролик. и кстати, 
этот же прием может быть с успехом использован для создания учебных пособий (например, 
пошаговых уроков) в самом файле SketchUp. 

Такое пошаговое «строительство» основано на использовании механизма сцен, суть 
которого заключается в сохранении последовательности «снимков» моделируемого объекта 
(объектов). Однако на собственно геометрию объектов механизм сцен никак не влияет, по-
этому для подобногоо показа есть только одна возможность – скрывать или снимать скры-
тие с отдельных объектов (их частей) в каждой из сцен. С учетом этого имеет смысл как бы 
«начать с конца»: сначала построить конечный результат, затем создать планируемое коли-
чество «шагов» – сцен (пока одинаковых), а затем, двигаясь от последней сцены к первой, 
последовательно добавлять скрываемые объекты (их части) в каждой. естественно, при по-
строении удобней сразу разбивать построения на нужные части – группы (или распределять 
по слоям) для удобства последующего скрытия в сценах. Понятно, что процесс этот доста-
точно трудоемкий, требующий повышенного внимания и сосредоточенности, особенно при 
большом количестве сцен... Здесь главное – не забывать сохранять изменения (Update), про-
изведенные в текущей сцене  при переходе к другой.

еще один вариант решения задачи – применение плагина, в котором используется 
другой (можно сказать – обратный) подход к решению этой задачи. в нем производятся и 
сохраняются изменения последовательных копий предыдущих состояний собственно гео-
метрии объектов:

tutorial_helper.rb
ФУнКциЯ: как следует из названия – изначально предназначен для создания проек-

тов типа пошаговых уроков (в формате .skp) в виде последовательного ряда сцен. 
УСТАнОвКА: копируем файл в папку Plugins.
КАК РАБОТАеТ: 
1.  Создаем первую сцену (View > Animaton > Add Scene) или через диалоговое окно 

Scenes.
2.  выбираем все объекты сцены, или только некоторые нужные, или отдельные ча-
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сти объектов.
3.  Запускаем плагин через меню Plugins > Tutorial Helper – автоматически создается 

новая сцена (копия исходной) с одновременным перемещением копии (!) выбранных в п. 2 
построений по красной оси на некую дистанцию (зависит от размеров выбранного). Одно-
временно автоматически происходит соответствующее перемещение камеры.

4.  Редактируем при необходимости текущую сцену – объекты, ракурс камеры и дру-
гие доступные для сцен настройки > выбираем нужное для копирования в новую сцену > 
снова запускаем плагин > повторяются опции п. 3. и так далее...

надо иметь в виду, что здесь опция Zoom Extents (Показать все) покажет все содер-
жимое не текущей сцены, а всего проекта – то есть все его построенные на данный момент 
объекты. Также надо иметь в виду, что поскольку объекты проекта многократно копируют-
ся, «вес» проекта ощутимо нарастает с каждой сценой – это, пожалуй, единственный «ми-
нус» применяемого плагином механизма. 

Можно ли все-таки создать анимацию с перемещением, вращением и 
тому подобным «сценарием» именно объектов, а не камеры?

Мы уже подробно рассматривали основное ограничение механизма анимации в 
SketchUp – фактически может быть анимирована только смена видов на сцену, то есть по-
ложения, ракурсов и ряда других параметров камеры. Таким образом, без применения спе-
циальных «анимационных» плагинов – ответ отрицательный. О них чуть дальше, а для нача-
ла рассмотрим пример остроумного применения штатных возможностей программы для... 
имитации анимации объектов. Эта задача может, например, решаться простым и эффектным 
приемом использования уникальной опции компонентов – Always face camera (Всегда ли-
цом к камере), то есть автоматического поворота к камере стороной, лежащей в плоскости 
собственных красно-синих (или зелено-синих) осей компонента.

Посмотрим этот прием на примере, в котором требуется показать открывающие-
ся/закрывающиеся двери в помещении. Создаем компоненты-двери и назначаем им опцию 
Always face camera. Кроме того, контекстной опцией Change Axes (Изменить оси) при необ-
ходимости уточняем положение вертикальной (синей) оси вращения (стороны размещения 
«петель») каждой из дверей. и не забываем в окне редактирования свойств компонента 
Components выключить опцию Shadow Face Sun, иначе поведение его тени будет отличаться 
от теней окружающих объектов. 
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Создаем ряд сцен с разными ракурсами обзора (обхода) помещения. При этом, как 
видим на рисунках, каждая из дверей остается в своем начальном положении («лицом» к ка-
мере), независимо от перемещения камеры. Теперь, при проигрывании анимации, за счет 
сочетания движения (вращения) камеры вокруг помещения и между сценами, получаем ин-
тересный анимационный эффект плавного открывания и закрывания дверей. 

Перейдем теперь к теме «полноценной» 3D-анимации – что под этим понимается?  
в специализированных анимационных программах (или таких модулях в редакторах «полно-
го цикла») это – возможность управления поведением объектов в сцене «во времени» (как 
правило, на Timeline (Шкале времени). изменяемые параметры – ракурс показа, перемеще-
ния, вращения, искажения геометрии... возможен и ряд других. Кроме того, как правило, есть 
возможность управления траекторией движения объектов указанием траектории. Очевид-
но, что в SketchUp из этого набора доступна только анимация показа (то есть параметров 
камеры). Кроме того, есть еще несколько проблем, например нельзя назначить разное вре-
мя перехода между разными сценами (то есть количество промежуточных кадров). не ме-
нее ощутимая проблема – качество  «картинки» конвертируемых из сцен файлов в формате 
.avi оставляет желать лучшего. 

Теперь об анимационных плагинах. Базируясь на механизмах SketchUp (слоях, сценах 
и так далее), они предоставляют продвинутые возможности при создании «фильма». и при 
этом достаточно просты в освоении и удобны в работе. Здесь приведу ссылки только на два 
из них – всю необходмую информацию найдете на сайтах авторов: 

Proper Animation http://sites.Google.com/site/morisdov/.
Keyframe Animation http://regularpolygon.org/keyframe-animation/.
Принцип их работы примерно одинаков, однако Keyframe Animation, пожалуй, са-

мый удобный и «доведенный» на сегодняшний день плагин в этом жанре. 
ну и в завершение нельзя не упомянуть Sketchy Physics. По сути, это также плагин, 

хотя по объему и сложности он выходит уже на уровень самостоятельного программного 
модуля-приложения к SketchUp (примерно аналогично рассмотренным ранее Динамическим 
компонентам). в нем анимационные возможности реализуются уже на совершенно другом 
механизме – имитации реальной «физики» поведения объектов под действием гравитации, 
взаимодействия объектов между собой и так далее. Поскольку более подробное рассмотре-
ние Sketchy Physics не умещается в тематику книги по причине специфичности, сложности и 
объема, отсылаю к подробной информации на интернет-ресурсе: http://forums.sketchucation.
com/viewtopic.php?f=61&t=17914 (естественно, на английском языке).

и еще стоит обратить внимание на то, что анимация, созданная некоторыми плагина-
ми, работает (воспроизводится) только в программной среде собственно SketchUp, то есть 
«фильм» нельзя экспортировать обычным образом в видеоформат. 

в некоторых плагинах (например, – smoothStepAnim.rb) используется механизм эк-
спорта фильма в виде последовательности отдельных имиджей-кадров, которые затем «со-
бираются» в фильм (видеоформат) в любой из программ, поддерживающих эту функцию. 
Подобная процедура позволяет получить более высокое качество кадров, а также возмож-
ность их предварительного редактирования перед конвертацией в видеофайл.  

Как оптимально решить проблемы представления интерьера? Напри-
мер, небольшого по габаритам помещения... а еще и без окон (или в ночное вре-
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мя) – как его осветить?
действительно, в таких проектах моделер неизбежно сталкивается с этими двумя ти-

пами проблем – ракурсов камеры и «внутреннего» освещения... Разберемся с ними подроб-
ней, исходя из самого «тяжелого» случая – маленького помещения (например, несколько  
метров по длине и ширине). 

ракурсы камеры 
Здесь суть проблемы заключается в том, что возможности «объектива» камеры в ка-

ждом «взгляде» позволяют увидеть (показать) только ограниченную часть пространства по-
мещения. Заметим, кстати, что такого рода ограничение обзора не является проблемой толь-
ко SketchUp – в любом 3D-редакторе полноценная имитация механизма человеческого зре-
ния виртуальной камерой в принципе недостижима. впрочем, как и реальной фотокамерой... 

Речь здесь идет прежде всего о «ширине поля взгляда», а в применении к камере – 
ее параметре Field of View (FOV). Об этом мы говорили достаточно подробно в теме инстру-
ментов камеры, поэтому здесь отметим главное: – чем шире поле взгляда (или в примене-
нии к объективу – меньше фокусное расстояние), – тем сильнее неизбежные перспективные 
искажения «на периферии» кадра:

Таким образом, первое и очевидное решение показа (обзора) небольших про-
странств – увеличение FOV (максимально возможное значение – 120 градусов), приемлемо 
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только до определенного предела.  А вот для человеческого глаза этой проблемы просто 
не существует... Проверьте сами, посмотрев прямо перед собой и оценив «охват» взгля-
да и качество изображения «на периферии» взгляда... Можно, конечно, представить инте-
рьер, «нащелкав» ряд кадров с разных углов (от стен) помещения c FOV порядка 50 гра-
дусов – при больших значениях перспективные искажения будут слишком неестественны. 

но есть и более элегантное и эффектное решение... за счет использования свойств 
материалов и поверхностей в SketchUp:

возможно, вы уже и сами догадались, каким очень простым приемом получен такой 
результат... если изложить самую суть: для всех внешних (обращенных «на улицу») поверх-
ностей стен, потолка и пола назначаем один и тот же условный (любой) материал с парамет-
ром Opacity (Непрозрачность) = 0...69%, для разных внутренних – нужные разные материалы. 

Таким образом, при взгляде на наружные стороны поверхностей мы их вообще не 
увидим (только ребра), а при смене ракурса (без неестественных перспективных искажений 
FOV  = 30...40 град.) на ту же конструкцию изнутри – «нормальные» материалы поверхно-
стей. То есть при любой точке взгляда внешние прозрачные ограждающие конструкции не 
будут мешать рассматривать то, что находится за ними! А на самом деле, если проанализи-
ровать происходящее, понимаем, что в основе использования этого остроумного приема ле-
жит один из базовых механизмов SketchUp – двухсторонний  (face/backface) принцип устрой-
ства поверхностей, что дает возможность назначать им разные свойства... и еще раз оце-
нить важность знания, понимая базовые основы устройства SketchUp.

Внутреннее освещение
Очевидно, что поскольку в SketchUp есть только один источник освещения (и те-

ней) – естественное солнечное, ни о каких дополнительных (точечных, независимых) «све-
тильниках» не может быть (к сожалению) и речи... в этой ситуации остается одно – умело 
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использовать имеющиеся возможности. Рассмотрим простой тестовый пример – полно-
стью изолированное от Солнца (без проемов «наружу») помещение, в котором постара-
емся максимально достоверно показать освещение. Откроем диалоговые окна управле-
ния  тенями и материалами – именно их средствами и будем решать поставленную задачу. 
Сразу замечу, что здесь будем использовать тот же прием, что и в предыдущем вопросе-
ответе, – все поверхности стен снаружи окрашены в один цвет, которому далее будем на-
значать  разную степень непрозрачности (прозрачности).

начнем с непрозрачных стен (Opacity = 70...100) и включим общий показ теней, а фак-
тически стандартное солнечное освещение. видим совершенно «плоскую» невыразитель-
ную картинку с некой общей однородной подсветкой сцены – можно только порегулировать 
ее интенсивность движками слайдеров настроек теней. Результат объясним, поскольку сол-
нечное освещение есть, но в помещение оно не попадает... очевидно, что это не вариант.

Пробуем то же, но с полностью выключенными тенями. Результат также не годится, 
тем более что здесь изменения настроек теней слайдерами вообще не работают. 

Оставив выключенным общий показ теней, включаем опцию Use Sun for shading (Ис-
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пользовать затенение от Солнца). Этим фактически включаем только собственные тени  на 
поверхностях объектов. движками слайдеров (настройками положения Солнца и контраст-
ности теней) легко добиться вроде бы приемлемого результата... за исключением одного – 
нет падающих теней. на этом, собственно, возможности управления освещением (тенями) 
и исчерпаны.

Что же, пора подключать материалы – включаем общий показ теней и устанавлива-
ем для цвета «внешней» окраски стен Opacity = 0...69%. Как видим, есть и собственные, и 
падающие тени, и работают все настройки характера теней, то есть результат практически 
оптимальный:

Однако и в этом варианте могут потребоваться дополнительные действия, посколь-
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ку все-таки возможно появление некорректных падающих теней (с точки зрения «реально-
сти» их появления). для этого есть еще одна возможность – выборочного управления те-
нями по отдельным поверхностям. например, на поверхности с «неправильной» тенью от-
крываем диалог Entity Info и выключаем пункт Receive Shadows (Принимать тени), или наобо-
рот, на поверхности, появление падающей тени от которой нежелательно, выключаем оп-
цию Cast Shadows (Отбрасывать тени). ну и поскольку тени в интерьере не могут быть та-
кими контрастными, как на открытых пространствах от Солнца, – приглушаем их контраст-
ность движками Light/Dark.

Есть целый ряд задач, которые очень трудно или даже просто невоз-
можно решить средствами SketchUp, даже с использованием плагинов. Какие дру-
гие 3D-программы рационально использовать совместно со SketchUp? 

действительно, рано или поздно, на каком-то этапе освоения и работы в SketchUp 
пользователь сталкивается с существенными ограничениями при решении нехарактерных для 
него задач. Часть из них снимается умелым использованием имеющихся возможностей, «пра-
вильными» приемами и методами работы, а также подбором нужных плагинов. еще раз по-
вторюсь: – сам факт наличия подобных проблем нельзя рассматривать как недостатки про-
граммы, речь идет об ограничениях, обусловленных той «нишей» эскизного моделирования, 
под которую и создавался SketchUp. на протяжении нашего курса в разных темах эти огра-
ничения уже рассматривались, резюмируем самые существенные из них:

1. Отсутствие механизмов фотореалистичного рендеринга. 
2. Отсутствие управляемых точечных (то есть кроме Солнца) источников света. Это 

затрудняет (а иногда делает и просто невозможной) достоверную визуализацию освещения/
теней внутри закрытых объемов – даже в рамках того условного «иллюстративного» ренде-
ринга, который предоставляется программой. А это весьма актуально, например при моде-
лировании интерьеров.

3. Отсутствие инструментов «тонкого» управления растровыми текстурами (UV-мап-
пингом) поверхностей сложных форм.

4. Ограниченные возможности инструментов моделирования поверхностей слож-
ной кривизны. Причем неизбежная сложность, «тяжесть» геометрии такого рода объектов  
часто делает их просто «неподъемными» для редактирования в низкополигонном SketchUp.

5. Ограниченные возможности применения для дизайна инженерных объектов – про-
мышленных образцов, машин и т. п. SketchUp – полигональный, поверхностный моделер, а 
для задач инженерного, промышленного 3D-дизайна оптимально применение механизмов 
так называемого NURBS-моделирования. 

6. Отсутствие полноценных анимационных возможностей.
Прежде всего – о перспективах развития SketchUp в направлении дополнения его пере-

численными функциями. Анализируя  историю версий (с 6-й по текущую 8-ю), можно уверенно 
сказать, что  нереально рассчитывать на какие-либо «революционные» нововведения в буду-
щем. Очевидно, что фактически это потребует полной переделки программного ядра програм-
мы, неизбежно приведет к усложнению, «утяжелению», что в конечном счете означает смену са-
мой «идеологии» SketchUp как простого, доступного, удобного и быстрого 3D-редактора «для 
всех». вряд ли это входит в стратегические планы владельца и разработчика – Google, тем бо-
лее что и с нынешними возможностями программа прекрасно вписывается в многочисленные 
сервисы Google. ну и кроме того, налицо движение как бы с «обратной стороны» – разработчи-
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ки других 3D-программ разных жанров уделяют все большее внимание  взаимодействию своих 
продуктов со SketchUp, вплоть до создания специальных приложений «под SketchUp», дополня-
ющих его возможности новыми, дополнительными функциями.

Таким образом, для «скетчапера», достигшего уровня задач, которые невозможно 
решить доступными средствами программы, остается только принять решение – как рацио-
нальней получить доступ к этим дополнительным функциям? 

Первый, самый «прямолинейный» вариант – «уход» из SketchUp и освоение 3D-редак-
тора «полного цикла», не выходя из которого, можно было бы моделировать «с нуля» до ко-
нечного результата, от первой линии до финального фотореалистичного рендеринга,  ани-
мации и так далее. или (что, кстати, достаточно распространено среди уже владеющих дру-
гими редакторами) – начальное, концептуальное моделирование выполнять в SketchUp, а за-
тем передавать модель для окончательной доработки в такой «тяжелый» редактор. Одна-
ко оборотной стороной универсальности («все включено!») приложений уровня 3D- MAX, 
MAYA, Cinema 4D и т. п. неизбежно является их тяжеловесность, сложность для освоения и 
практической работы. и это при том, что пользователь по роду своих задач может так ни разу 
и не использовать значительную часть заложенных в них функциональных возможностей...

второй вариант: если SketchUp все-таки остается основным, повседневным рабочим 
инструментом, дополнить его до «полного боекомплекта» несколькими программами под уз-
кий круг специальных задач. единственный весомый недостаток такого решения – необхо-
димость осваивать не одну, а несколько разных программ. Хотя еще вопрос – какой из этих 
двух подходов «перевесит» по сложностям освоения…

в этом варианте для «скетчапера» наиболее существенны такие критерии подбора 
программ-партнеров:

1. Программы должны быть близкими SketchUp «по духу», то есть «дружественны» к 
пользователю, с максимально простым и наглядным интерфейсом. Желательно также, что-
бы они имели близкую логику элементов управления (особенно навигации!), что обеспечит 
быстроту и легкость освоения.

2. Программы должны «хорошо понимать друг друга» – корректно обмениваться (же-
лательно в обе стороны) необходимыми данными без искажений и потерь, в идеале – напря-
мую, «понимая» форматы друг друга или через плагины экспорта-импорта.

Безусловно, перечислить все возможные варианты «партнерства» нереально, выбор 
этот сугубо индивидуален и определяется взвешиванием всех «плюсов» и «минусов» конкрет-
ных программ и их сочетаний под конкретные 3D-задачи конкретного пользователя. Поэтому 
далее представлены в качестве возможных «кандидатов» только по одной программе каж-
дого направления (см. выше перечень «проблемных» пунктов), достойные хотя бы предва-
рительного знакомства.

фотореалистичный рендеринг
По большому счету, рендеринг – совершенно самостоятельный жанр компьютерной 

графики, в ряде случаев даже более сложный и трудоемкий, чем собственно 3D-моделиро-
вание. Пожалуй, можно по аналогии с изобразительным искусством сравнить моделирова-
ние с графической отрисовкой композиции, а рендеринг – с представлением ее в живопис-
ной манере. ну а поскольку графика и живопись – это все-таки очень разные жанры с со-
вершенно разными техническими средствами, то понятна и потребность даже в отдельной 
профессиональной специализации – «визуализатор». 

Большинство «тяжелых» универсальных 3D-редакторов имеют собственные встроен-
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ные модули для рендеринга, как финального этапа моделирования. Однако не менее попу-
лярны и самостоятельные, специализированные именно под эти задачи программы-ренде-
ры, в которые загружаются 3D-сцены, построенные до этого в любом 3D-редакторе. 

для начала разберемся с основными понятиями:
Рендеринг, визуализация (англ. Rendering) в широком смысле – программные механизмы 

отображения, показа трехмерной сцены, построенной в 3D-редакторе. 
Фотореалистичный рендеринг (англ. Photorealistic Rendering или PR) – решение задач 

рендеринга специальными программными механизмами, которые «умеют» визуально имитиро-
вать свойства поверхностей реальных материалов в реальных условиях – в сочетании с фактора-
ми освещения и окружающей среды. Упрощенно: – речь идет о возможности достижения уровня 
достоверности фотографии из «реального мира». Чаще всего под понятием «рендеринг» имеют в 
виду именно этот механизм (и средства) визуализации. 

Заметим, кстати, что программы-рендеры, как правило, решают и проблемы допол-
нительных управляемых источников света, а некоторые – и анимации. 

Нефотореалистичный рендеринг (англ. Non-Photorealistic Rendering или NPR) – реше-
ние задач рендеринга условными стилевыми средствами, имитирующими архитектурную графику, 
техническую иллюстрацию и так далее, вплоть до живописной или мультипликационной манеры. 

Таким образом очевидно, что возможности визуализации в SketchUp ограничены именно  
(и только) средствами нефотореалистичного рендеринга, а значит, для достижения «фотореалис-
тичности» есть только один способ – передача сцены (модели) в специализированные програм-
мы-рендеры и решение этих задач в них. выбрать самый подходящий под свои задачи рендер 
так же непросто, как и моделер, тем более что в последние несколько лет наблюдается оче-
видный «бум» все новых и новых приложений этой специализации, и практически каждый 
имеет свои уникальные достоинства (впрочем, как и недостатки). При этом большинство из 
них тем или другим образом поддерживают возможность работы с моделями SketchUp, так 
что на самом деле проблемы «SketchUp – рендеринг» фактически давно уже не существует!

По каким же параметрам подобрать «свой» рендер? Конечно, как и любые другие 
программы – под свои задачи, хотя, казалось бы, а что выбирать – конечно, тот, который вы-
дает самый качественный, самый реалистичный результат! Однако с этим не все так просто… 
Здесь, пожалуй, существует прямая зависимость: – чем выше уровень реалистичности ренде-
ра, тем сложнее он в освоении, работе, выше требования к компьютерному «железу», боль-
ше времени затрачивается на настройки, пробные рендеры и собственно просчет финаль-
ного результата – изображения. Причем это время, в зависимости от собственно программы, 
сложности сцены и ресурсов компьютера, может достигать десятков часов! 

Поэтому, пожалуй, оптимальный вариант (тем более если только начинаете осваивать 
этот жанр) – рендеры-плагины, например, этот:  

TwilightRender for Google SketchUp (http://www.twilightrender.com/) 
Это специально разработанный плагин-рендер к SketchUp. в полной мере отвечает 

требованиям «родного» (то есть действительно абсолютно полноценно интегрированного) 
и высококачественного дополнительного программного модуля, обладая при этом практи-
чески всеми возможностями «тяжелых» программ рендеринга. Кроме того, выбор вполне 
обоснован такими качествами, как простота и удобство интерфейса, а значит – обеспечена 
легкость освоения и работы.  Основные возможности:

– возможность продолжения работы в SketchUp (и других программах) во время процесса 
рендеринга, поддержка многопроцессорных систем (без ограничений количества);

– глобальное освещение сцены Солнцем и небом SketchUp и несколькими другими вариан-
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тами окружения, дополнительные управляемые точечные и направленные источники света, под-
держка HDR –миджей в качестве источников глобального освещения;

– поддержка материалов SketchUp c возможностью их модификации фотореалистичны-
ми шаблонами Twilight, библиотеки материалов с возможностью дополнения и редактирования;

– камеры, позволяющие получить, кроме обычного имиджа, цилиндрическую и сфе-
рическую панорамы;

– механизмы имитации Depth of Field (DOF) – глубины пространства;
– интерактивная экспозиция имиджей рендеринга в реальном времени; 
– рендеринг анимации SketchUp и объектов с использованием плагинов SketchyPhysics 

(пример можно посмотреть здесь: http://www.youtube.com/user/shareck#p/u/15/tY5iP0BzNew) и 
ProperAnimation... 

– ...и многое другое...

Можно заметить, кстати, что в настоящее время есть выбор из нескольких приложе-
ний, решенных в виде подобных рендеров-плагинов. Однако зачастую их привлекательная 
простота достигается или за счет «урезанных», упрощенных возможностей механизмов рен-
деринга, а значит, результат только с большой натяжкой можно назвать реалистичным, или 
слишком высоких аппаратных требований... Twilight этих недостатков лишен и является в 
большинстве случаев отличным выбором для пользователя SketchUp. 

Моделирование «органики»,  uV-маппинг
Очевидно, что для «лепки» высокополигонных органических форм, называемых еще  

High-poly sculpt – скульптурными, возможностей SketchUp явно недостаточно, что подтверж-
дается, например, наличием нескольких скриптов-плагинов под эти задачи. Однако это все-
таки зачастую недостаточно гибкие и удобные решения. Под задачи «скульптинга» можно 
найти целый ряд программ-моделеров именно для работы с полигонами сеточных оболочек 
сложной кривизны, что позволяет буквально «лепить» (как из пластилина) сложные объемы, 
легко и удобно управляя (самое главное!) многими тысячами полигонов. Кроме того, мно-
гие из них включают и продвинутые механизмы текстурирования, точнее UV-маппинга, по-
скольку без них передача «скульптурных» форм в программы рендеринга практически бес-
полезна. в ряду таких редакторов стоит обратить внимание на этот, отвечающий всем на-
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шим критериям выбора:
Nevercenter Silo (http://www.nevercenter.com/silo):
– мощный комплекс инструментов и опций механизма Subdivision – интерактивной управ-

ляемой детализации поверхностей, одновременно генерирующей сглаженную сетку полигонов;
– необходимый инструментарий для других задач, в том числе построения точных тех-

нических объектов с контролем размерных величин, что позволяет с успехом осуществлять в 
Silo самый широкий круг проектов – от персонажей компьютерных игр до архитектуры;

– предельно лаконичный интерфейс с минимальной загрузкой его элементами рабочего 
пространства и возможностью пользоваться несколькими альтернативными способами управ-
ления. впечатляют уникальные механизмы практически полной перестройки интерфейса «под 
себя» – от любой компоновки элементов управления в рабочем пространстве до возможно-
сти фактически создания своего дизайна интерфейса; 

– корректная передача данных (через промежуточные форматы) SketchUp > Silo > 
SketchUp;

– продвинутые инструменты UV-mapping – текстурирования сложных поверхностей с ис-
пользованием мощного алгоритма автоматического создания разверток текстурных карт. Осо-
бо отметим эту характеристику – Silo вполне может быть использован для задач текстурирова-
ния вместо отдельных специализированных программ.
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nurBs-моделирование
Как и в ситуации с «органикой», для дизайна инженерных объектов – промышлен-

ных образцов, машин и т. п., инструментарий SketchUp не очень подходит. для этих задач 
CAD-редакторы инженерного, промышленного 3D-дизайна чаще всего используют наибо-
лее подходящие механизмы так называемого NURBS-моделирования,  которое базируется 
на Splines (Сплайнах) – плавных, в общем случае кривых линиях. Это позволяет легко созда-
вать на их основе сложные, абсолютно гладкие и плавно искривленные поверхности, сопря-
жения и т. п. еще одно существенное достоинство такого механизма – параметричность, то 
есть возможность в любой момент перестроить объект редактированием ее формообразу-
ющих кривых и профилей.

Большой интерес в качестве «партнера» SU для использования под указанные зада-
чи представляет редактор MoI3D- (http://moi3D-.com):

– мощный инструментарий NURBS-моделирования, включая отличные чертежные фун-
кции, характерные для CAD-редакторов;

– прямая поддержка SketchUp – конвертация модели в сетки полигонов заданной де-
тализации и отличного качества простым сохранением модели в формат .skp; 

– высококачественное сглаженное отображение рабочего пространства даже на не-
дорогих видеокартах;

– специальная проработка интерфейса под возможность работы не только с мышкой 
и клавиатурой, но и на графическом планшете.

3D-анимация, 3D-презентация...
Фактически всегда есть возможность использования любых 3D-моделей, построенных в 

SketchUp (и экспортированных в нужный формат) в любой из программ 3D-анимации, презента-
ций и других мультимедиа-приложений. Здесь же хочу предложить обратить внимание на редак-
тор Swift 3D (http://www.erain.com/).

на самом деле он вряд ли может заинтересовать в качестве моделера (оставляющего же-
лать лучшего по удобству), но вот анимационные возможности Swift 3D уникальны. Это, во-пер-
вых, – механизм полноценной  анимации с управлением практически всеми возможными пара-
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мет-рами сцены и объектов, вплоть до изменения «во времени» материалов, формы и так далее. 
и главное достоинство программы – уникальная возможность сохранения анимации не толь-

ко в видеоформаты, но и в «легкий» векторный формат Adobe Flash, что делает ее легко встраи-
ваемой в любые интернет-технологии, базирующиеся на этом механизме, а значит – легко доступ-
ной для «зрителя». Поскольку тема эта весьма специфическая, объемная и многогранная, здесь не 
имеет смысла в нее углубляться – все необходимую информацию найдете на официальном сайте 
Swift 3D по указанной выше ссылке. 

ну и в завершение нельзя не сказать о появлении нового направления в программном 
обеспечении 3D-визуализации, которое условно можно назвать «игровым».  Здесь наиболее ин-
тересна презентационная программа Lumion (http://lumion3D-.com). 

Характерная черта Lumion – уникальные, можно даже сказать, революционные техни-
ческие возможности в области визуализации масштабных 3D-проектов, выходящие за при-
вычные рамки программ фотореалистичного рендеринга и анимации. При просмотре создан-
ных в нем имиджей и видеороликов поражает качество, эффектность «картинки», а при пер-
вом же открытии программы возникает впечатление, что находишься не в процессе работы, 
а в компьютерной игре. на самом деле так оно и есть – программные механизмы, принцип 
работы, построения 3D-сцены в Lumion ближе всего к редакторам игровых уровней, знако-
мых продвинутым геймерам... Фактически вы строите свой мир, управляя его ландшафтом, 
погодой, флорой и фауной, предметным наполнением... и конечно – имея возможность по-
мещать в этот мир свои объекты, построенные в SketchUp. 

На этом и завершаем наш учебный курс, который, надеюсь, поможет вам войти в 
удивительно интересный, увлекательный мир 3D-графики... и двигаться дальше – совер-
шенствуясь, повышая свой профессиональный уровень. 

И еще раз – творческих успехов, находок и удач!  


